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About This Manual

Introduction
Welcome to Lucent Technologies CPro-2000. CPro-2000 provides an intelligent user
interface that enables concurrent graphics and text-based interaction with members of Lucent
Technologies 2000 Synchronous Optical Network (SONET) product family. CPro-2000
mechanizes provisioning operations at the network element (NE) level, as well as at the

subnetwork level.

This manual describes the product features and offers detailed procedures for all CPro-2000
operations. The information is arranged to sequentially follow the CPro-2000 main menu bar

and associated menu items.

Intended Audience
This manual is intended for CPro-2000 users of all experience levels. CPro-2000 is applicable
for all operations personnel who administer Lucent Technologies SONET NEs, wherever they
currently use an American Standard Code for Information Interchange (ASCII) terminal or

craft interface terminal (CIT).

Engineering Planners, Craft Personnel, and Maintenance
Personnel
Engineering planners, craft personnel, and maintenance personnel typically use an ASCII
terminal that is directly connected to the CIT port or X.25 port (also known as the operation
system interface [OSI] port) of a SONET NE, through an RS-232 cable, to perform analysis
of the subnetwork. Now, the engineer can use a desktop or laptop personal computer (PC)

running Microsoft  Windows 95b™, Windows 98™, Windows 2000™, and Windows NT™
4.0 to access CPro-2000. The appropriate communications (COM) port of the PC running

CPro-2000 is connected to the NE's CIT port to operate and analyze the SONET subnetwork.

CPro-2000 provides the following benefits to engineering planners, craft personnel, and
maintenance personnel:

•  subnetwork view via connection to any NE in the subnetwork

•  simplification of most SONET NE commands through the use of a graphical user
interface (GUI)
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Centralized Work Center Personnel
Work center personnel typically use operations systems (OSs) to access the various
components of the network, including the NEs; to analyze, provision, and test the network;
and to dispatch the outside plant engineer for any necessary on-site repairs to the NEs. In this
case, CPro-2000 can serve as a mini-OS by utilizing the remote capability of the ASCII user

interfaces (AUIs) of all Lucent Technologies SONET NEs.

Conventions Used

General Conventions
Listed below are the general text conventions used throughout this manual.

•  The word “select” is used to indicate the activation of a menu command or a
command button in a dialog box or Help window.

•  The phrase “click OK” means that you can either click the OK button with the mouse
or, in most cases, you can press the Enter key on the keyboard to carry out the action.

•  Bold type indicates words, characters, keys, or items that you type, point to, click, or
press. Titles of chapters being referenced in this manual also appear in bold type.

•  Italic type indicates NE commands and important new terms. Titles of external
documentation that is referenced also appear in italic type.

•  Computer voice  type indicates system messages shown on your screen.

Mouse Conventions
At a minimum, a two-button mouse is required for operating CPro-2000.

If you have a multiple-button mouse, CPro-2000 assumes that you have configured the left
mouse button as the primary mouse button. Any procedure that requires you to click with the

mouse refers to the use of this left mouse button, unless otherwise specified.

•  “Point” means to position the mouse cursor so that the tip of the cursor rests on the
item you want to point to on the screen (for example, “Point to STS-1”).

•  “Click” means to press and immediately release the mouse button without moving the
mouse (for example, “Click VT1.5”).

•  “Double-click” means to click the left mouse button twice in quick succession (for
example, “Double-click on the CPro icon to start CPro-2000”).

•  “Drag” means to press the left mouse button and to continue pressing while moving
the mouse (for example, “Drag the cursor from the source slot of the cross connection
to the destination slot”).

•  “Drop” means to release the mouse button after dragging the cursor to the desired
location on the GUI (for example, “Drop the cursor on the destination slot”).
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Keyboard Conventions
•  The names of keys that appear on your keyboard are shown in bold type with an

initial capital letter (for example, the Shift key or the Escape key).

•  “Press the Enter key” means that you can press either Enter or Return. This initiates
an action in CPro-2000. On most PC keyboards, these two keys perform the same
operations. In CPro-2000, they can be used interchangeably unless specifically stated

otherwise.

•  All the keyboard shortcuts that are valid in any other Windows application are also
valid in CPro-2000, such as pressing the Tab key to move the cursor from field to

field in a window.
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Introduction

The Concept of CPro-2000
CPro-2000 is a Windows™ application that provides access to Lucent Technologies SONET
NEs from a PC or laptop via a command-based ASCII User Interface (AUI) and Graphical

User Interface (GUI).

For DDM-2000, FT-2000, SLC-2000®, and FiberReach NEs, the native AUI available within
the CPro-2000 environment is the same ASCII text-based user interface that these NEs provide
as an integral part of their generic software. Users have access via an industry-standard VT-100

  terminal (also known as an ASCII terminal). However, within the CPro-2000 environment,
the ASCII interface provides a number of useful features that may not be available on an
ASCII terminal such as user-developed scripts, cut-and-paste capability, and session capture to

a file.

The CPro-2000 GUI allows users to execute tasks on the subnetwork, or on specific NEs in
the subnetwork, by selecting commands from the menus and objects from the graphical
display. Tasks that may normally require typing several long ASCII interface commands can

be accomplished with a few mouse clicks in the GUI.

The GUI is developed to be common across several Lucent Technologies SONET products.
However, since the ASCII interfaces of each product are slightly different from one another,
the graphical layer also provides the important function of minimizing such differences. This
enables the users to focus more on the network operations and less on syntax differences

between different types of NEs.

CPro-2000 Customer Assistance
Customer assistance and troubleshooting for CPro-2000 are available by calling 1-800-225-
4672, Lucent Technologies toll-free hotline number. The hotline is staffed with technical
representatives and is operational 24 hours a day, seven days a week. Consult your Lucent
Technologies account representative for complete customer service and maintenance

information.

Also available for Network Element technical assistance is the Regional Technical Assistance
Center (RTAC) at 1-800-225-RTAC. RTAC personnel troubleshoot field problems 24 hours a

day over the phone, and if necessary, on site.
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Troubleshooting
To resolve any problems that may occur while working with CPro-2000, refer to the CPro-

2000 Software Release Description (SRD) that accompanies this manual or refer to the
Readme file in the CPro-2000 software. To access the Readme file, select CPro-2000 R11.0
from the Start Menu, then choose CPro-2000 R11.0 Readme from the submenu. The
Troubleshooting sections of both the SRD and Readme file contain specific information for
resolving issues. It is recommended, therefore, that you review these prior to requesting

customer assistance.

System Requirements

Hardware
CPro-2000 R11.0 requires the following minimum hardware requirements:

•  Intel Pentium processor at 133 MHz with 64 MB of Random Access Memory (RAM) and
one available buffered COM port

•  CD drive

•  hard disk drive with at least 40 MB of available space (after Windows is loaded)

•  two-button mouse

•  sound card (to enable Audible Alarm)

•  modem card (to enable Alarm Pager)

•  VGA monitor

•  LAN interface (if TCP/IP connection is desired)

NOTE: It is recommended that at least a 256-color mode be used. 128 MB RAM is
recommended for use with large networks.

Software
CPro-2000 Release 11.0 runs on the following platforms: Microsoft Windows 95b, Windows
98, Windows 2000, and Windows NT 4.0.

NOTE: CPro-2000 Release 11.0 does not support Microsoft Windows 3.1™ or Microsoft
Windows 95a™.

 



CPro-2000 User Manual Release 11.0 Introduction ••••  7

Supported Network Elements
CPro-2000 provides an intelligent common GUI for Lucent Technologies SONET NEs
including DDM-2000 OC-3, DDM-2000 OC-12, FiberReach, FT-2000 OC-48, and the

SONET functionality of SLC-2000.

CPro-2000 Release 11.0 provides an interface for the following NE Releases:

•  DDM-2000 OC-3   Releases 13.0, 13.5, 15.x

•  DDM-2000 OC-12   Release 7.x

•  FiberReach — Releases 3.0, 3.1, and 4.0

•  FT-2000 OC-48   Releases 8.1, 9.0, and 9.1

•  SLC-2000 (the SONET portion if installed with OC-3 R13.0) Releases 4.4 and 4.6

•  MegaStar  – support for the SONET portion only as DDM-2000 OC-3s

NOTE: CPro-2000 Release 11.0 fully supports only the NE Releases listed above.

New Features
Listed below are the significant new features in CPro-2000 Release 11.0:

•  ability to connect to an NE either through a serial port or over TCP/IP

•  ability to edit the INI file using the INI File Editor

•  support for password aging on NEs

•  support for DS1 provisioning for IMA/LAN

•  ability to recognize and graphically represent Lucent’s WaveStar products (as
“unsupported” NEs) in the Subnetwork View

•  support for audible alarms and alarm paging

•  support for network alarm polling in  MML on  a DDM-2000 shelf supporting
RNE  Status
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Installation

Overview
This chapter gives step-by-step details for installing CPro-2000 software. CPro-2000 Release
11.0 software media is available in CD or 3.5-inch high-density diskettes. This chapter also
explains how to customize CPro-2000 settings in accordance with your operating environment

and preferences.

CPro-2000 Installation

Procedure

1. Boot up your PC.

2. Start Windows 95, 98, or NT (if Windows is not already running).

3. If you are installing a CD, insert the CPro-2000 CD in the appropriate drive on
your PC.

If you are installing diskettes, insert the first of the six CPro-2000 installation
diskettes into the 3.5-inch drive.

4. Click on the Start button on the taskbar, then click Run. The Run dialog box

appears.

5. Type x:\setup in the command line box of the Run dialog box, where "x" is the
drive letter for your CD drive or floppy drive. For example, if you are installing

a CD, enter d:\setup if your CD drive is designated as drive d.

6. Click OK. The Setup dialog box appears.
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7. Read the text in the Setup dialog box and wait for the window to close. The
Welcome window appears.

8. Read the text in the Welcome dialog box, then click Next. The Software License
Agreement dialog box appears.

9. Read the text in the Software License Agreement dialog box, using the down
arrow to scroll down to the remaining text.

10. Click Yes if you accept the terms of the Agreement. 



CPro-2000 User Manual Release 11.0 Installation ••••  11

If you do not accept the terms of the Agreement, Click No. The Exit Setup box
appears.

Click Exit Setup to exit the installation or click Resume to accept the terms of
the Agreement and to continue the setup process.

If you accepted the terms of the Agreement, the User Information dialog box
appears.

11. Enter your name in the Name field, the company name in the Company field,
then press Next. The Choose Destination Location dialog box appears.
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12. Click Browse to change the directory from the one specified in the Choose a
Destination Location dialog box, then click Next. To accept the default directory

location, click Next.  The Setup Type dialog box appears.

NOTE: If the CPRO.INI file or the DEFAULT.SCR file already exists from a previous
installation in the directory where CPro-2000 is being installed, a message that the existing
versions of the files have been saved in different files appears. The earlier CPRO.INI file is

saved as cpro2.ini while the earlier DEFAULT.SCR file is saved as default2.scr.

For information on how to customize the CPRO.INI file or the DEFAULT.SCR file, see the
"Customizing CPro-2000 Settings" section of this chapter.

13. Select the preferred installation from the following Setup options:

Typical – installs all CPro-2000 Program Files

Compact – automatically excludes the Help files from the installation

Custom – brings up the Select Components dialog box. To exclude the Help
Files from the installation, leave the Help Files box unchecked.
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14. Click Next to proceed with the installation. The Select Program Folder dialog
box appears.

15. Read the information in the Select Program Folder box, follow the instructions,

then click Next to continue with setup.

16. If you are installing a CD, skip to Step 18.

If you are installing diskettes, the Setup Needs The Next Disk dialog box
appears.
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Follow the instructions provided in the Setup Needs The Next Disk dialog box.

17. Insert remaining CPro-2000 R.11.0 disks at the prompt, then click OK.

Note that if you selected the Compact or Custom options earlier on in the
installation process, the system invites you to insert disk #4 after you have
inserted disk #2. Disk #3 contains information on the Help files and are not

included with the Compact or Custom options.

18. For both installation types, click Finish in the Setup Complete dialog box to
complete the setup.

TIP: For easier access to CPro-2000, we suggest that you create a shortcut for the GUI. It is
not necessary to create one for the AUI as it automatically displays whenever the GUI is

opened.

Uninstalling CPro-2000 R11.0

Procedure

1. From the Start button, click CPro-2000 R11.0, then select CPro 11.0 Uninstall

from the submenu. The Confirm File Deletion message box appears.
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2. Click Yes to continue the uninstall, or click No to cancel the uninstall. The
Remove Programs From Your Computer window that appears tracks the

progress of the uninstall process.

3. Click OK to complete the uninstall and exit the Remove Programs From Your

Computer window.

 NOTE: Files created after installation such as Backup files may not be deleted
during the uninstall process. Manually delete these files and directory by using

the Explorer window.

4. Exit any dialog boxes.

NOTE: If you intend to reinstall CPro-2000, restart your PC at this point to

ensure successful reinstallation.
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Customizing CPro-2000 Settings

CPRO.INI File
The CPRO.INI file is created in the installation directory when CPro-2000 is installed. This
file contains selectable parameters for configuring the manner in which CPro-2000 will
operate during an active session. The CPRO.INI file can be customized for your computing

environment after installing the CPro-2000 software.

NOTE: Modifications to CPro-2000 will take effect only after a new CPro session is started
following changes to the CPRO.INI file.

Customizing the CPRO.INI File

The CPRO.INI file contains the CPro-2000 default settings. To access this file,
do the following:

From the Start button, select Programs. Click CPro-2000 R11.0 in the

submenu that appears, then click CPRO.INI in the next submenu.

The CPRO.INI file appears in a Windows Notepad editor window. Each of the
entries in this file can be customized for your environment. They include the

following:

•  FILENAME This section contains the default script file name.

    SCRIPT identifies the default data communications script file to be
used for login (for example, DEFAULT.SCR).

NOTE: Automatic updating of the SCRIPT field in the Login dialog box is a feature of the
CPRO.INI file. If a script name other than the one defined in the CPRO.INI file is entered in
the Login window, the CPRO.INI file is automatically updated to contain this new script file
name. If no script file name is used on the Login window, then the CPRO.INI file is updated

to not contain a default script file name.

•  CPRODRV This section contains entries that determine AUI parameters.

    TIMEOUT is the amount of time in milliseconds between CPro-2000
sending a command and the time it takes the NE to respond before
CPro-2000 times out. For example, 30000 equals 30 seconds, 100000
equals 100 seconds, and 1000 equals 1 second. (This parameter should
be increased when circumstances such as a very large network or slow
response of the NE are causing CPro-2000 to time out). The default

setting for this feature is 60000 (60 seconds).

    SETTINGS contains the PC settings in the following format:

“port name: baud rate, parity, data bits, stop bits, handshaking”

COM1:9600,e, 7, 1, none is an example of the PC settings, where COM1

is the name of the port connected to an NE for use with CPro-2000.

NOTE: The settings listed in your default data communications script (in most cases, it is
DEFAULT.SCR) supersede the setting information listed in the CPRO.INI file.

    LEFT, TOP, RIGHT, BOTTOM are the entries that determine the size
of the AUI screen. These entries are saved from the last use of the AUI.
The default settings are as follows: Left = 0, Top = 380, Right = 640,

Bottom = 480.
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•  CPROGUI This section contains entries that determine the size of the GUI
window.

    LEFT, TOP, WIDTH, and HEIGHT are the entries determining the size
of the GUI screen and are saved from the last use of the GUI. The
default settings are as follows: Left = 0, Top = 0, Width = 1200, Height

= 6500.

•  PREFERENCE This section contains entries that determine how cross
connections are viewed in a Network Element View and which
communications standard, Human-Machine Language (MML) or Transaction
Language One (TL1), is the default.

    SHOWCC can be either TRUE or FALSE. When the entry is FALSE,
the slots/ports containing cross connections are displayed in dark blue
and the cross-connection lines are not displayed. When the entry is
TRUE, the slots/ports containing cross connections are displayed in

purple and green. All of the cross-connection lines are displayed as well.

    NE_IF_DEFAULT can be either MML or TL1, depending on which
command response type you are using most of the time. MML is the current

default. This variable appears in the tabs at the top of the Login dialog box.

•  INVENTORY This section defines the number of NE inventories permitted
before CPro displays a warning messsage regarding system resources.

    NE_INVENTORY_LIMIT can be set to a value from 1 to 50. The
default is 40. When this limit is exceeded, a warning message is posted.
Once this limit is exceeded, more NEs can still be inventoried (the
warning message will reappear). However, depending on hardware,

performance might eventually be reduced.

•  TIDS—TID names are only applicable when using TL1 to connect to a
subnetwork. For TL1, you must supply a TID.

—   The entries in this section are a compilation of the TID names you use
during the login process, such as “NODE1” or “NODE-XYZ.” Each
time you type a new TID name into the login screen, the TID is added
to the TID list in your CPRO.INI file. The latest entry appears at the
top of the list. Each subsequent time you log in, these TID names

appear in a down-arrow list by the TID field.

NOTE: If you attempt to delete or renumber the TID list in the CPRO.INI file, ensure that the
list is kept in sequential order.

•  ALARM POLLING—This section contains entries that determine whether the
automatic alarm-polling feature is enabled or disabled and the specified time
interval between alarm-polling events. The default setting for this feature is
“disabled.”

—   AUTO identifies whether the alarm-polling feature is enabled or
disabled. When the entry is YES, the alarm-polling feature is enabled.
When this field is NO or blank, the alarm-polling feature is disabled

and the time interval is reset to three minutes.

—   INTERVAL is the amount of time in minutes between automatic
alarm-polling events. The default time interval is three minutes. The

minimum interval allowed is one minute.
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•  AUTONOMOUS MESSAGES—This section contains the entry to determine
whether or not autonomous messages generated by the NE are displayed in the
CPro-2000 AUI. These autonomous messages keep users up-to-date with any
changing NE conditions. However, they might interfere with an interactive
session through the AUI.

— DISPLAY can be set to a value of 1 or 0. When set to 1, autonomous
messages are displayed in the CPro AUI and any interactive session
messages are interspersed with the autonomous messages from the NE.
When set to 0, autonomous messages are not displayed and an interactive

session via the AUI is unaffected by autonomous messages.

The INI File Editor

Overview

The initialization file, CPro.ini, controls the default settings for the user configurable
parameters initialized by CPro-2000.

The INI File Editor feature provides a graphical means of editing this file thereby minimizing
the risk of  corruption to the file. Using the INI File Editor, you can edit parameters in the INI
file such as the communication interface, communication mode, and alarm polling, without
directly manipulating the contents of the file. Note that the INI File Editor is available only if

the Subnetwork View is closed.

The INI File Editor is made up of four tabs, each of which is discussed in the sections that
follow:

•  Interface Settings

•  Com Port Defaults

•  Transparency

•  Advanced

i.  The Interface Settings Tab
Use the Interface Settings tab to perform tasks such as setting the communication mode,
setting the communication interface, and setting alarm polling. For a detailed description of
the settings in this tab, refer to the “Customizing CPro-2000 Settings” section of this chapter.

The following sections explain the tasks you can perform from this tab.
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To change the interface settings

1. Bring up CPro-2000 R11.0

2. From the GUI, click the Access menu, and then select Edit CPro.ini. The
CPro.ini  Preferences dialog box appears with the Interface Settings tab

displayed.

3. Select your options.  An explanation of these options is provided in the
“Customizing CPro-2000 Setting” sections of this chapter. Note that with the

exception of the Com Interface option, changes in this tab take immediate effect.

The Com Interface option allows you to select the method of connection to the
NE. You can choose either a serial link or TCPIP connection. However, changes
to the Com Interface take effect only after you exit the current session and

restart CPro-2000.

4. Click OK to save the current settings and dismiss the CPro.ini dialog box, or
click Close dismiss the dialog box without saving any settings.

NOTE: Subsequent CPro-2000 sessions open with the last value selected.

ii.  The Com Port Defaults Tab
From the Com Port Defaults tab, you can specify your communications options.

To change the com port default settings:

1. Bring up CPro-2000 R11.0

2. From the GUI, click the Access menu , then select Edit CPro.ini. The CPro.ini
Preferences dialog box appears with the Interface Settings tab displayed.

3. Click the Com Ports Defaults tab.
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4. Select your options. For an explanation of these options, see the “Customizing
CPro-2000 Setting” sections of this chapter.

5. Click OK to save the current settings and dismiss the CPro.ini dialog box, or
click Close dismiss the dialog box without saving any settings.

NOTE: Subsequent CPro-2000 sessions open with the last value selected.

iii.  The Transparency Tab
CPro-2000 is version specific in terms of the NE releases it supports. The transparency feature
allows CPro-2000 to operate against NE features for which it was not specifically designed.
Typing the release number of the compatible NE in the Base Release field and the number for
the incompatible NE in the New Release field enables CPro-2000 to communicate with the

incompatible NE exactly as it would the compatible NE.

NOTE: Do not use this tab without consulting Customer Technical Support..

To get technical support for CPro-2000, call 1-800-225-4672, Lucent Technologies toll-free
hotline number. The hotline is staffed with technical representatives and is operational 24

hours a day, seven days a week.

To connect to an NE version that is unsupported by the current
CPro-2000 release:

1. From the GUI, click the Access menu , then select Edit CPro.ini. The CPro.ini
Preferences dialog box appears with the Interface Settings tab displayed.

2. Click the Transparency tab.
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3. Enter the current release in the first field, then enter the new release where
indicated, as shown in the example below:

4. Click OK to save the current settings to the INI file and dismiss the CPro.ini
dialog box, or click Close dismiss the dialog box without saving any settings.
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iv.  The Advanced Tab
NOTE: The Advanced tab is intended for troubleshooting and debugging purposes only. Do
not change its settings unless directed to do so by  Customer Technical Support.

To get technical support for CPro-2000, call 1-800-225-4672, Lucent Technologies toll-free
hotline number. The hotline is staffed with technical representatives and is operational 24

hours a day, seven days a week.

To view the Advanced tab options:

1. From the GUI, click the Access menu , then select Edit CPro.ini. The CPro.ini
Preferences dialog box appears with the Interface Settings tab displayed.

2. Click the Advanced tab.

WARNING: Do not change the setting in this tab without consulting Customer Technical
Support.

3. Click OK to save the current settings to the INI file and dismiss the CPro.ini
dialog box or click Close dismiss the dialog box without saving any settings.
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CPro-2000 Startup

Overview
CPro-2000 is a user-friendly tool for craft provisioning of SONET subnetworks. This is
accomplished by establishing a connection to an NE (known as the local node) in a SONET
subnetwork, and communicating to the rest of the subnetwork through this NE, over the data

communications channel (DCC) between all NEs in the subnetwork.

NOTE: To access the NE connected to CPro-2000, you must have a user login on the NE. If
you do not have a user login on the NE, see your network administrator.

Physical Connections
OC-3, OC-12, and FT NEs have three ports to which CPro can connect.

•  The DCE (CIT1) is used for a direct connection.

•  The DTE (CIT2) is used for modem access or a direct connection through a null
modem (not available on a Fiber Reach shelf).

•  The X.25 port is used for X.25 access [an X.25 protocol device such as a packet
assembler/disassembler (PAD) or packet-switched network is required]. FiberReach
NEs do not support an X.25 port.

•  A TCP/IP network connection is used to connect to an NE by initializing a gateway
device such as Lucent’s NCC™ or a generic terminal server capable of supporting
TCP/IP interconnect such as Annex.

TL1 is allowed on the front CIT of DDM-2000 and FiberReach beginning with DDM-2000

Release 15.0 and FiberReach Release 4.0.

For OC-12, the DCE and DTE ports use MML and the X.25 ports use TL1.
CPro-2000 supports both of these.

For FT, the DCE and DTE ports can be set to CIT or TL1. CPro-2000 supports only TL1.

DDM-2000 OC-3, OC-12 and FiberReach Access via CIT
Port
For DDM-2000 OC-3 and OC-12 users, establishing a connection to your SONET subnetwork
for operations with CPro-2000 is similar to accessing your SONET subnetwork for operations
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with an ASCII terminal. Like an ASCII terminal, the COM port of the PC running CPro-2000

can be connected to the craft interface terminal (CIT) port of a node in your subnetwork.

FT-2000 OC-48 Access via CIT Port
FT-2000 users must have their CIT port (either DCE located in front, or DTE located in back)
provisioned to be a TL1 interface to use CPro-2000. Use the FT-2000 PC-CIT command

security-set-security-port-DCE/DTE to provision the CIT port as a TL1 interface.

Use one of the following methods to provision the port back to a PC-CIT (non-TL1) port
when you have completed your CPro-2000 session:

•  Using CPro-2000, select Set CID Secu from the Provision pull-down menu and
follow the procedure detailed in The Provision Menu chapter of this document.

•  From the FT-2000 OC-48 PC-CIT, use the FT-2000 PC-CIT command security-set-
security-port to change the port protocol provisioning from a TL1 port to CIT port.
This command must be completed from an NE in the subnetwork other than the one

to which CPro-2000 is connected.

DDM-2000 OC-3 and OC-12 Access via X.25 Port
For DDM-2000 OC-3 and OC-12, the X.25 port is always active, and once the cable is
hooked up, communication can be established. This provides TL1 commands and responses
for all the supported TL1 commands. If you are not using a packet-switched network, then a

PAD must be used to connect CPro-2000 directly to an X.25 port.

FT-2000 OC-48 Access via X.25 Port
An FT-2000 OC-48 X.25 port is always provisioned for TL1 and cannot be changed. If you
are not using a packet-switched network, then a PAD must be used to connect CPro-2000

directly to an X.25 port.

FiberReach Access via X.25 Port
FiberReach NEs do not support an X.25 port. TL1 FiberReach access is provided through its
DDM-2000 OC-3 host over the DCC.

NOTE:  TL1 over CIT is available starting with FiberReach R4.0.

Partitioning
CPro-2000 utilizes a concept known as partitioning. As the size and complexity of SONET
subnetworks continue to grow, working with an entire subnetwork can be cumbersome.
Therefore, CPro-2000 partitions the subnetwork into logically divided areas that are easier

and faster to work with.

A partition is a logical grouping of NEs all interoperating on the same high-speed SONET
media. For example, each group below contains NEs of the same partition:

—   each discreet ring within a multi-ring environment

— all linear NEs directly connected to each other including chains, hubs,
point to point, or linear extensions
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— each open ring subtending from other SONET media of higher
bandwidth

Open ring is discussed in greater detail in the section "Ring Transport Service" in the End-to-

End Path Menu chapter.

The Partition Inventory
Lucent Technologies SONET NEs are designed to possess the intelligence necessary for each
NE in the subnetwork to be aware of itself and of the other NEs in the same subnetwork. This
SONET NE capability, which is used by CPro-2000 to derive the Partition Inventory, is

accomplished simply by querying the NEs.

CPro-2000 does not require interfaces to OSs that have a network database, and it does not
require the user to manually create a database. CPro-2000 derives its necessary information
by querying the NEs and using this data for subnetwork-level operations. The Partition
Inventory is updated for all operations performed from the GUI. If you need to perform
subnetwork-level tasks such as creating or deleting an end-to-end path, then taking an
inventory of each partition in the subnetwork is essential. If, on the other hand, you need to
perform operations on a single node, taking a single NE inventory is sufficient. See the

“Inventory (NE View)” section in The Update Menu chapter for more information.

If you do not check Partition Map or Partition Inventory, CPro-2000 does the following:

•  logs into the local node

•  inventories the local node and displays its Network Element View

NOTE: Only one user should operate on a subnetwork at one time. Once the Partition
Inventory is performed by that one user, the best way to ensure that the inventory stays

accurate is to have only one user logged into the subnetwork at the same time.

WARNING: The Subnetwork View may change if multiple users are logged onto the

subnetwork at the same time.

Contents of the Partition Inventory

During a Partition Inventory, CPro-2000 retrieves information about all of the nodes in the
partition including topology, equipage, cross connections, and alarms.

Partition Topology  The Lucent Technologies SONET NEs provide a capability for each
NE in a partition to list all other NEs in the partition and point out from that list those NEs
that are directly connected to it (neighbors) and the local interfaces used for those
connections. When such information from all NEs in the partition is put together and
analyzed, the layout or the topology of the entire partition can be derived. This information is

essential for all subnetwork-level operations such as end-to-end provisioning of paths.

Equipage  The Partition Inventory queries the NEs to determine how each slot is equipped.
CPro-2000 displays this information graphically and uses it for commands related to port

provisioning and cross connections.

Cross Connections The Partition Inventory also determines what cross connections exist
within the NEs at STS-1, STS-3, and VT1.5 levels, including DS1, DS3, EC-1, OC-1, and

OC-3 termination points. These cross connections display graphically.

Alarms The Partition Inventory also retrieves the current alarm status of all the nodes in the
partition on the GUI window.
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How to Get a Partition Inventory

To inventory an partition, do one of the following:

•  Check Partition Inventory in the Login dialog box.  The Partition Inventory is taken
during the login. Note that only the partition you logged into is inventoried. For more
information, see the "Accessing the Subnetwork" section later in this chapter,

OR

•  Select Partition Inventory from the Node Manager window if you did not select
Partition Inventory at login or to inventory other partitions in the subnetwork. See

the "Node Manager" section in The Access Menu chapter for more information.

When you choose Partition Inventory, CPro-2000 automatically discovers a partition. A
discovered partition is when CPro-2000 recognizes it as part of the subnetwork and knows its
configuration. For MML, the first partition that CPro-2000 discovers contains the local node
to which you are logged in. For TL1, any node can be selected by entering its TID in the
Login dialog box.  As each partition is discovered, it is numbered by CPro-2000 (for example,

P-1, P-2).

NOTE: For details on how to customize partition names, see the “Rename Partition” section

in the Edit Menu chapter.

When partitions are initially discovered and therefore displayed in the Subnetwork View, they
are in an unexpanded format. The unexpanded partition shows only the partition name and the
type of NE contained in the partition. The following is an example of a DDM-2000 OC-3 ring

partition icon.

If the partition contains an unsupported NE, the partition icon displays with “Unsupported
Partition.” The following is an example of an unsupported partition icon.

CPro shows two partitions (displays both icons shown above) if it discovers one or more
unsupported NEs in a ring. In this case, the user should inventory any closed ring (containing no

unsupported NEs) first before others.

NOTE: Although CPro can discover unsupported NEs, their presence restricts CPro functionality.
For example, the End-to End Path pull-down menu is disabled when the Subnetwork View
contains an unsupported partition. End-to-end paths cannot be created in a partition containing an

unsupported NE.

You can display the expanded version of a supported partition by double-clicking on the
partition icon or by using the right-mouse-button pop-up menu in the Subnetwork View. The
expanded version shows each NE in the partition, including its Target Identifier (TID) and
connectivity to its neighbor nodes, as shown in the example below. The node that is currently

selected is highlighted in magenta.
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If an unsupported partition is opened, the NE icon displays with “Unsupported Type” and the
TID appears beneath. The following is an example:

The Partition Map
Taking a Partition Map is less comprehensive than taking a Partition Inventory. The Partition
Map operation allows the user to retrieve the partition topology from all nodes in the current

partition and display this information in the Subnetwork View.

Performing a Partition Map operation is sufficient for displaying connectivity information of
the NE nodes in a discovered ring. However, for performing subnetwork-level tasks such as

creating or deleting an end-to-end path, performing a Partition Inventory is essential.

To map a partition, do one of the following:

•  check Partition Map in the Login dialog box.  The Partition Map is taken during the
login. See the "Accessing the Subnetwork" section later in this chapter for more

information,

OR

•  select Partition Map from the Node Manager window if you did not select Partition

Map at login or to map other partitions in the subnetwork. See the "Node Manager"
section in The Access Menu chapter for more information.

Level 2 Nodes
NOTE: In CPro-2000, an L2 node is an NE provisioned as a Level 2 router. For further
information, see the appropriate NE User Service Manual.

CPro-2000 can be deployed in a subnetwork that is divided into multiple “areas” where the
NEs are configured as Level 1 (L1) nodes or Level 2 (L2) nodes. In comparison to L1 nodes,

L2 nodes have the additional capability of “seeing” L2 nodes from areas other than their own.

CPro-2000 is able to distinguish between L1 nodes and L2 nodes upon login to a subnetwork.
CPro-2000 differentiates any discovered L2 nodes by displaying the following icons/labels in

the Subnetwork View and Node Manager:
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From left to right, the above icons are representative of an OC-3 or FiberReach L2 node, an
L2 unexplored NE, and an L2 unsupported NE.

Starting CPro-2000

Procedure

To start CPro-2000, do one of the following:

•  From the Start button, click CPro-2000 then select the GUI, or

•  Double-click the CPro-2000 R11.0 GUI shortcut on the desktop (if you created one)

Note that the AUI automatically displays when you open the GUI.

Accessing the Subnetwork
With CPro-2000, configuring data communications to access the subnetwork is very flexible
since it is limited only by the facilities available to the user. It is a two-stage process that requires
you to select your communications options first before connecting to an NE. You can select your

communications options from either the GUI or the AUI.

Selecting Communications Options from the GUI

Procedure

1. Start CPro-2000 and from the GUI Access menu, choose New Subnetwork.
The Login dialog box displays.

2. In the Login dialog box, highlight DEFAULT.SCR at the bottom and delete it if
“DEFAULT.SCR” displays in the script field. The Options button then becomes

enabled.

NOTE: The communication settings specified in the default script file will overwrite the
current communication settings. To ensure that the settings chosen manually either through
the AUI or GUI are not overwritten, remove the file named DEFAULT.SCR from the Script

field of the Login dialog box.

3. Click Options. The following screen appears.
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4. Direct Connect is the default setting. Choose Dial to Connect if a modem is

being used. Click OK.

5. Click the Port Settings tab in the Communications Options window. The
following screen appears:

6. Verify that the settings are correct for your PC environment. If not, using the
down-arrow lists beside each option, choose the correct settings, such as

Communications Port and Baud Rate. Click OK.

If a modem is being used to connect, click the Modem Commands tab in the
Communications Options window. The following screen appears:
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•  Enter the Phone Number to be dialed and select the appropriate
Modem Type from the down-arrow list.

7. Click OK to exit the Communications Options dialog box.

Selecting Communications Options from the AUI

Procedure

1. Start CPro-2000 and click anywhere in the AUI window to highlight it (give it
the focus).

2. From the AUI Communications menu, access/modify the communications
settings described in the previous section “Selecting Communications Options

from the GUI.”

NOTE: There are two options in the AUI Communications>Settings menu: Modify and From

File. If you choose the Modify option, the default communications settings will appear and you
can view or configure the settings for your environment. These settings can then be saved to a
file using the Save command in the AUI File menu. If you choose the From File option, a list of
all previously saved settings files is displayed. Note, however, that only files saved to the CPro-

2000 R11.0 folder are displayed.  Select the desired file.

Connecting to an NE via Serial Link
CPro-2000 offers three ways to connect to an NE using a serial link.

i.   Connecting to an NE Manually
This procedure details how to access the subnetwork using the AUI without a data
communications script. Similar to accessing CPro-2000 via a data communications script, this
access method is also used when the PC running CPro-2000 is directly connected to the CIT port

of the NE (or the X.25 port of a DDM-2000 or an FT-2000 OC-48, if connected with a PAD).
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Procedure

1. Make sure that all the communications settings are correct for the type of
communications connection being made (see the “Selecting Communications

Options” section earlier in this chapter).

2. From the Communications pull-down menu of the AUI, select Connect. (If the
menu choice says Disconnect, you are already connected.)

You may also connect by clicking on the Connect/Disconnect button

in the AUI.

3. From the Access menu, choose either Open Subnetwork or New Subnetwork.
If you select New Subnetwork, the Login dialog box immediately displays. If
you select Open Subnetwork, choose the appropriate file from which the

subnetwork is to be opened. The Login dialog box displays.

NOTE: It is important to delete any script file name that appears in the Script: field. This
ensures that CPro-2000 uses any new settings you specified at login.

4. In the Login dialog box, enter the user ID, password and, if using TL1, the TID

of the NE.

5. Check Partition Map or Partition Inventory if you want a graphical display of
the  topology of the subnetwork you are logged into. Leave both unchecked if
you only intend to make provisioning changes to the local node (see the

“Partitioning” section earlier in this chapter).

6. If you selected Partition Map or Partition Inventory from the Login window,
CPro-2000 automatically attempts to logs into each of the NEs in the

subnetwork.

The following window appears during CPro-2000’s the first login attempt into one of the NEs
in the subnetwork. Type in the correct user ID and password and then click OK.
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Note: For convenience, you can preset the user ID and password for each node in a mixed
ring using the Set Access feature in the Node Manager. For instructions on how to use this

feature, see the “Node Manager” section in The Access Menu chapter.

7. Click OK. After the login process, the CPro-2000 GUI window that appears
displays the appropriate NE View.

ii.   Connecting to an NE Using a Login Script
Use this type of connection when the PC running CPro-2000 is directly connected to the CIT
port of an NE. Each NE has two CIT ports, one for data communications equipment (DCE
port in front) and one for data terminal equipment (DTE port in back). If you are using the
DCE CIT port for access, the PC can be directly connected. If you are using the DTE CIT port
for access, a null modem must be used to directly connect to the PC COM port. See the
appropriate NE User Service Manual for instructions on selecting the modem and settings for

your COM port.

Procedure

The following procedure explains how to access the subnetwork using the CPro-2000 GUI

and a data communications script file.

1. From the Access menu, choose either New Subnetwork or Open Subnetwork.

NOTE: If you select New Subnetwork, the Login dialog box is immediately displayed. If
you select Open Subnetwork, a list of previously saved files is displayed. Note, however,
that only files saved to the CPro-2000 R11.0 folder are displayed. Choose the appropriate file

for opening the subnetwork.

2. The Login dialog box is displayed and automatically populated with the
following defaults:

•  the tabs at the top of the screen indicate the MML interface is the default

•  the script being used for communication. The Script field may display the
DEFAULT.SCR. The DEFAULT.SCR contains default communication
settings. You can select another script file using the Browse button or change
the communication settings using the AUI. However, you must delete the
default script file to ensure that CPro-2000 uses the new settings/file at login.

If you have chosen New Subnetwork, you can select Partition Map, Partition
Inventory, or leave both unchecked. Selecting either Partition Map or Partition
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Inventory tells CPro-2000 to graphically display the topology of the subnetwork

into which you are logged (see the “Partitioning” section earlier in this chapter).

NOTE: If the NE interface is TL1, you must either input a TID or select the TID of the initial
login node from the down-arrow list.

3. For all NE types, enter your user ID and press the Tab key. Enter your

password.

4. If you want to use a script other than the default, click the Browse button to
display the Select a Script File dialog box. The following screen appears.

5. Navigate to the CPro-2000 installation directory to access the Script Files. If you
accepted the default during installation, CPro-2000 will be in

C:\progra~1\cpror11.0.

6. Select one of the existing data-communications scripts, depending on your
application. Click OK to select the script.

NOTE: Although certain default script files are provided with the CPro-2000 software, you
can also create scripts (see Appendix D. Script and Batch Files for information on writing
script files). Settings should be the same in both the CPRO.INI File and the script file being

used. Any new script files should be thoroughly tested.

7. The Login dialog box redisplays with the selected script file. Click OK.

8. If you selected Partition Map or Partition Inventory from the Login window,
CPro-2000 automatically attempts to logs into each of the NEs in the

subnetwork.

The following window appears during CPro-2000’s the first login attempt into one of the NEs
in the subnetwork. Type in the correct user ID and password and then click OK.

Note: For convenience, you can preset the user ID and password for each node in a mixed
ring using the Set Access feature in the Node Manager. For instructions on how to use this

feature, see the “Node Manager” section in The Access Menu chapter.
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To connect to an NE from this point, you must either select Connect from the
Communications menu in the AUI or click the Connect/Disconnect             button in the

AUI.

NOTE: To view examples of typical subnetwork and NE representations, see the “GUI
Representations” section in The User Interfaces chapter.

iii.  Connecting to an NE via a Modem
This access application is used where the PC running CPro-2000 employs a modem or a data
communications network to access the CIT port of an NE.

CPro-2000 supports three types of modems:

•  Hayes -compatible

•  MultiTech -compatible

•  TrailBlazer -compatible

If you use a modem that is unsupported by CPro-2000, you can still use the AUI to directly
send commands to the modem or you can use a script to send commands to your modem.

For modem-to-modem connections, asynchronous modems are used at the SONET
subnetwork access point and at the PC running CPro-2000. Both are connected to the tele-
phone network. The subnetwork access point is the CIT or X.25 port of a DDM-2000, the CIT
port of a FiberReach, or for an FT-2000, the DCE CIT port, the DTE CIT port, or the X.25

port. A PAD is required for all X.25 connections.

For modem-to-modem connections, the default settings are normally acceptable for the
modem at the PC end. However, the NE modem (modem at the NE end) must be set as

follows (see the NE User Service Manual for further details):

•  connect at 9600 baud

•  set to answer

•  flow control off

NOTE: If you use a modem script to connect to CPro-2000, then you must hang up the
modem manually at the end of your CPro-2000 session. If you have used the AUI Dial-to-
Connect modem command to connect to CPro-2000, you do not have to hang up the modem
manually. CPro-2000 recognizes that you have used a modem for connection and

automatically hangs up the modem.

Procedure

This procedure describes how to connect to the subnetwork using a modem.

1. Make sure that all the communications settings are correct for the type of
communications connection being made (see the “Selecting Communications

Options from the GUI” section earlier in this chapter).

2. From the Communications pull-down menu of the AUI, select Connect. (If the
menu choice says Disconnect, you are already connected.)

3. The modem dials the number and after the other modem at the dialed number
has answered, you hear the two modems handshake to determine the baud rate at
which to communicate with one another. If you have successfully accessed the
subnetwork, the modem should display CONNECT 9600, where 9600  is the

baud rate used for the two modems.
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4. From the Access menu in the GUI, select Open or New Subnetwork. The
Login dialog box displays immediately if you have selected New Subnetwork. If
you selected Open Subnetwork, choose the appropriate file from which to open

this subnetwork. The Login dialog box displays.

NOTE: It is important to delete any script file name that appears in the Script: field. This
ensures that CPro-2000 uses any new settings you specified at login.

5. Enter your user ID, password, and for TL1 access, the node TID.

NOTE: There is a 1.5 second delay for dial up connections to TL1 ports.

6. Check Partition Map or Partition Inventory if you want a graphical display of
the  topology of the subnetwork you are logged into. Leave both unchecked if
you only intend to make provisioning changes to the local node (see the

“Partitioning” section earlier in this chapter).

NOTE: Before selecting Partition Inventory, we recommend that you initially connect to the
NE and then use the Node Manager to preset the User ID and Passwords for other nodes in
the ring.  See the “Node Manager” section of The Access Menu chapter for instructions on

how to use this feature.

7. Click OK. After the login process, the CPro-2000 GUI window appears
containing the appropriate Network Element View or Subnetwork View,

depending on the view you selected.

Connecting to an NE over TCP/IP
CPro-2000 can connect to an NE over TCP/IP only by initializing a gateway device such as
Lucent’s NCC, which provides a TL1 TCP/IP/OSI gateway or a generic terminal server,

which provides a TCP/IP/serial IO gateway.

NOTE: Before using this feature, make sure your PC is connected to a LAN.

1. From the AUI window, click the Connect button . The Dialog window

appears.

2. Enter the appropriate information the fields provided:

•  Address: Enter the IP address or name of your NCC or Telnet server.

•  Protocol: Select the appropriate protocol.

•  Remote Port: Enter the listening port number of your NCC or Telnet server.
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NOTE: The NCC port number is permanently set to 3082.

3. Click OK save your current settings, establish the connection, and dismiss the
window, or click Cancel to dismiss the window the window without saving the

settings or establishing the connection.

NOTE: If using a terminal server, you may need to specify the gateway port number in the

AUI window before accessing the local node.

4. From the GUI, select the Access menu, and then choose either New

Subnetwork or Open Subnetwork. If you select Open Subnetwork, choose the
appropriate file from which the subnetwork is to be opened. If you select New

Subnetwork, the Login dialog box immediately displays.

NOTE: It is important to delete any script file name that appears in the Script: field. This
ensures that CPro-2000 uses any new settings you specified at login.

5. In the Login dialog box, enter the user ID, password and, if using TL1, the TID

of the NE.

NOTE: NCC does not support MML. Therefore, when connecting through the NCC make
sure you select the TL1 tab.

6. Check Partition Map or Partition Inventory if you want a graphical display of
the topology of the subnetwork you are logged into. Leave both unchecked if
you only intend to make provisioning changes to the local node (see the

“Partitioning” section earlier in this chapter).

7. Click OK. When login is complete, the CPro-2000 GUI window that appears
displays the appropriate NE View.

Password Aging (introduced in DDM-2000
OC3 R15.x and FiberReach R4.0)

The password aging feature enhances security by allowing administrators with privileges to
set or edit logins that specify the length of time for which the general user’s password is valid.
At the end of the specified period, the password expires, and the user must change the

password to gain access to the networks.
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Procedure

1. Log on to CPro-2000 in the usual manner.

2. If you attempt to log on to an NE when your general-user login has expired, the

message in the AUI alerts you. The following dialog box also appears:

3. Type the new password in the appropriate field then retype the password where
indicated.

4. Press OK for the new password to take effect.

Troubleshooting
To resolve any problems that occur while working with CPro-2000, refer to the CPro-2000

Software Release Description (SRD) that accompanies this manual or refer to the Readme
file in the CPro-2000 software. To access the Readme file, select CPro-2000 R11.0 from the
Start Menu, then choose CPro-2000 R11.0 Readme from the submenu. The Troubleshooting
sections of both the SRD and Readme file contain specific information for resolving issues. It

is recommended, therefore, that you review these prior to requesting customer assistance.
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The User Interfaces

Overview
This chapter contains a detailed explanation of CPro-2000’s GUI (Graphical User Interface)
and AUI (ASCII User Interface). It explains the menus, color conventions, and how to
navigate the user interfaces. The GUI section defines the various components it contains, such

as the following:

•  toolbar icons

•  Subnetwork View

•  Network Element View

•  the status bar and alarm representations

Also provided in this chapter is a section on how to print reports and windows from the user
interfaces.

Introduction to the User Interfaces
CPro-2000 provides both a GUI and an AUI to access Lucent Technologies NEs. When you
start CPro-2000 by selecting CPro 11.0 Graphical User Interface from the Start button, the
GUI forms a relationship with the AUI. The AUI receives information from the NE and
transfers this information to the GUI. The GUI then presents the information in a graphical

display.

The CPro-2000 GUI allows you to execute tasks on the subnetwork, or on specific NEs in the
subnetwork, by selecting commands from the menus and objects from the graphical display.
Tasks that normally require typing several long ASCII interface commands can be

accomplished with a few mouse clicks in the GUI.

You can use the AUI for commands that are unsupported by the GUI. Although the AUI can be
used to talk directly to the subnetwork by typing commands, do this with caution. Changes
made to the subnetwork via the AUI are not reflected in the GUI unless the CPro-2000 Update
Inventory command or Update X-Conn command (for cross connections) is performed. Your
GUI and AUI can become unsynchronized or the data in your subnetwork can become
inconsistent with the data in CPro-2000. See the “Using the Interfaces Together” section in this

chapter for more information on keeping the user interfaces synchronized and consistent.
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Using the Interfaces Together
The GUI and AUI work together in CPro-2000. Both are necessary for successful operation of
the system. The AUI accepts commands from the GUI and forwards them to the NE. The AUI
then accepts the response from the NE and passes that information onto the GUI for storage or

presentation.

Communication with the subnetwork is the backbone of CPro-2000. Once communication is
established with the local node, CPro-2000 is able to communicate with the other NEs in the
subnetwork. All of the information that CPro-2000 provides through the GUI is obtained
directly from the NEs themselves. Whenever an action is taken through the GUI, CPro-2000

automatically updates the information that it has stored about the subnetwork.

The CPro-2000 GUI provides information to users based on data that it stores; therefore, it is
possible for CPro-2000 to open a Network Element View or to provide reports without ever
accessing the NE itself. When CPro-2000 needs to retrieve information from or send
information to the NE, CPro-2000 logs into the NE that must be accessed. CPro-2000
automatically accesses the appropriate NE because it keeps track of which NE it is currently

logged into and compares that information to the NE that must be accessed.

When communication to a remote NE is lost or when the user accesses NEs via the AUI, the
GUI and AUI might indicate that they are logged into different NEs. This can cause CPro-2000
to be unable to complete a specified task. CPro-2000 is designed to correct this situation
automatically and access the appropriate NE. However, if a problem occurs and CPro-2000
cannot correct this situation, use the AUI to access the local node. CPro-2000 will then be able
to complete the specified task. Note that for MML, if you are logged out of the local node or
off the subnetwork entirely, you should also use the AUI to log back into the local node, prior

to continuing with your current CPro-2000 session.

The Graphical User Interface
The Graphical User Interface (GUI) consists of a multiple document interface (MDI), which
can accommodate a Subnetwork View and several Network Element Views. An MDI consists
of one main window that contains multiple subwindows. In this case, the CPro-2000 GUI
window is the main MDI window. The Subnetwork View and Network Element Views are

the subwindows.

•  The Subnetwork View is a graphical representation of the subnetwork topology,
including partitions. A partition is a logical grouping of NEs interoperating on the
same high-speed SONET line.

NOTE: For more information on partitioning, see the “Partitioning” section in the CPro-2000

Startup chapter.

•  A Network Element View is a graphical representation of the cross connections, ports,
slots, and tributaries associated with an NE. Several Network Element Views can be
displayed at once. Note that a Network Element View must be active to execute

NE-level tasks, such as establishing cross connections.

See the “Subnetwork View” and “The Network Element View” sections later in this chapter
for further details on the components of these windows and how they are used.
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Navigating the GUI
You can switch the focus of the GUI, and toggle between the Subnetwork View and the
Network Element Views in any of the following ways:  Note that menu items change

depending on which part of the GUI has the focus.

•  The Node Manager is available from the Access menu and the toolbar. Use the Open,
Close, and Switch To commands to switch the focus between the Network Element
Views and the Subnetwork View. The Node Manager contains other commands, such
as Login, Logout, Partition Inventory, Partition Map and Set Access. See the

“Node Manager” section in the The Access Menu chapter, for further details.

NOTE: The command button functionality in the Node Manager varies according to the type
of icon highlighted. Therefore, the buttons will become enabled or disabled accordingly.

•  Clicking on the title bar of an open window, either a Network Element View or the
Subnetwork View, changes the focus of the GUI to that window.

•  While in the Subnetwork View, double-clicking on an NE node opens its Network
Element View. The focus of the GUI is then switched from the Subnetwork View to

the open Network Element View.

•  While in a Subnetwork View, you can rearrange the NE and partition icons by
dragging them with the cursor. The NE icons that appear in the Enter End-to-End

Path dialog box can be moved in the same way.

•  Clicking the right mouse button on a partition icon in the Subnetwork View brings up
a pop-up menu containing the following commands: Open Partition, Update Map,
Update Inventory, End To End Path, Reports, and Rename.

•  Clicking the right mouse button on an NE icon while in the Subnetwork View brings
up a pop-up menu containing the following commands: Open NE View, Close

Partition, Update Map, Update Inventory, End To End Path, and Reports.

The Toolbar
Use the toolbar for quick access to tasks. The toolbar icons are shown below, although not all
of the icons display at the same time. The icons that display at any given time depend on

which GUI window has the focus.

The icons (from left to right) represent the following commands: New Subnetwork, Open

Subnetwork, Save Subnetwork, Print, Backup Network Element, Restore Network

Element, Node Manager, Open Subnetwork and Partition Map, and Help.

                       

The Status Bar
CPro-2000 displays a status bar at the bottom of the GUI screen, as shown in the following
illustration:

The status bar is made up of three areas:

•  Alarm Status (left section)—Indicates the most severe alarm present in the current
node using the color conventions listed in the following table.
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Color FT-2000 Representation DDM-2000 Representation

Red CR (critical) and MJ (major)
alarms

CR (critical) and MJ (major)
alarms

Yellow MN (minor) alarms MN (minor) alarms, NEA
(near-end activity), and ABN
(abnormal) conditions

Green No alarms

or

NA (conditions not reported via
CR, MJ, and MN LEDs, office
alarms, or parallel telemetry)

or

NR (conditions not reported via
CR, MJ, and MN alarms, office
alarms, parallel telemetry, or TL1)

NA (no alarm) or FEA (far-end
activity) condition

•  Information Status (center section)— information that is displayed depends on the
task you are performing in the GUI. Information on cross connections (type, address,
and signal rate) and slot addresses change dynamically as your cursor moves to
different locations in the GUI. The information window also displays messages about
in-progress tasks.

•  Trash can Icon (right section)—is a receptacle for deleted cross connections. You
can select and drag a cross-connection line, source, or destination to the trash can
icon. A cross-connection deletion box appears confirming that you want to delete the
cross connection. See the “Cross-Connection Deletion,” section in the Cross

Connections chapter for further details.

The Cancel Dialog Box
To cancel an operation while in progress, use the Cancel button. While each command is
being sent from CPro-2000 to the NEs, a dialog box appears containing the Cancel button.

The text in the dialog box changes dynamically as the command progresses.

For example, a CPro-2000 operation can consist of several NE commands (which are sent
through the AUI to the NE), such as creating an end-to-end path. The CPro-2000 end-to-end
path command consists of the ENT-CRS commands for each cross connection that is part of

the path.

The Cancel dialog box shows each of these commands as they are issued to the NEs. You can
press Cancel at any time during this process to cancel the CPro-2000 command. This is
particularly useful when you are in the middle of a lengthy operation, such as a Partition

Inventory, and you want to halt the command process.

CAUTION: Depending on how quickly you cancel a command, some or all of the command
might be completed anyway. Check the AUI to see which commands, if any, have been
completed. For example, in the case of creating or deleting an end-to-end path, a partial set of

cross connections might have been created or deleted. Use the Cancel button with care.



CPro-2000 User Manual Release 11.0 The User Interfaces ••••  43

GUI Representations

The following screens show examples of the Network Element View and the Subnetwork View

in the CPro-2000 GUI. The menu bar and toolbar are included in the displays.

The following is an example of the CPro-2000 GUI when the local node is a DDM-2000 OC-3:

The following is an example of the CPro-2000 GUI when the local node is a DDM-2000 OC-3

with 29G Optical Line Interface Unit (OLIU) circuit pack in the main tributaries:
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The following is an example of the CPro-2000 GUI when the local node is a DDM-2000 OC-3

with 24G Optical Line Interface Unit (OLIU) circuit pack in the main tributaries:

The following is an example of the CPro-2000 GUI when the local node is a DDM-2000 OC-12:
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The following is an example of the CPro-2000 GUI when the local node is a FiberReach with

26G2-U OLIU circuit pack in the main tributaries:

The following is an example of the CPro-2000 GUI when the local node is a FiberReach with
28G-U OLIU (OC-3) circuit pack in the main tributaries and 22-type circuit pack in the

function slots:
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The following is an example of the CPro-2000 GUI when the local node is an FT-2000 OC-48:

The Subnetwork View
The CPro-2000 GUI contains a Subnetwork View representing the subnetwork topology of
the NEs, also known as nodes. The Subnetwork View displays any discovered partitions in

the subnetwork and the connectivity between them.

The partition icons can be expanded by clicking on them. An expanded partition shows the
individual NEs in the partition. A Network Element View can be opened by double-clicking

on the box representing the individual NE in an expanded partition.

Subnetwork-level tasks, such as retrieving path reports and bandwidth usage, obtaining the
Partition Inventory, and creating/deleting end-to-end paths, can be executed from the

Subnetwork View.

NOTE: For details on how to display the Bandwidth Usage report, see The Report Menu

chapter.
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The Network Element View
Each Network Element View window contains a graphical representation of termination
points and cross-connection provisioning. The following list details the Network Element

View for each type of NE:

•  The Network Element View for DDM-2000 OC-3 contains termination points for
individual STS-1 or DS3 signals, or up to 28 VT1.5 or DS1 signals per STS-1 signal.

•  The Network Element View for DDM-2000 OC-3 equipped with 24G OLIU circuit
pack contains termination points for individual STS-3, STS-1, or DS3 signals, or up
to 28 VT1.5 or DS1 signals per STS-1 signal.

•  The Network Element View for DDM-2000 OC-12 contains termination points for
individual STS-1, DS3, or STS-3C signals.

•  The Network Element View for FiberReach contains termination points for up to 28
DS1 signals for 1x7 protection, or 16 DS1 signals for 1x1 protection.

•  The Network Element View for FiberReach equipped with 28G-U OLIU circuit pack
in the mains and 22-type circuit pack in the function slots contains termination points
for DS1 signals, as well as termination points for STS-3 signals to function slots f-1

and f-2.

•  The Network Element View for an FT-2000 OC-48 contains termination points for up
to three STS-1 signals per STS-3 signal.

The arrangement of objects in the Network Element View follows these general guidelines:

•  For DDM-2000 OC-3, DDM-2000 OC-12, and FiberReach NEs:

    The vertically stacked boxes on the left side correspond to the transmit fiber
from and receive fiber to Main-1 (m1 for DDM-2000 OC-3 and FiberReach,

mb-1 for DDM-2000 OC-12).

    The vertically stacked boxes on the right side correspond to the transmit fiber
from and receive fiber to Main-2 (m2 for DDM-2000 OC-3 and FiberReach,

mb-2 for DDM-2000 OC-12) in ring configurations.

    The horizontally arranged boxes at the bottom of the screen correspond to the
function units used for add/drop cross connections.

NOTE: If a DDM-2000 OC-3 or SLC-2000 contains 27-type OLIU circuit packs in main
slots, CPro-2000 only displays two available STS-1s in the mains, instead of the usual three.
These are labeled m1 and m2. If a DDM-2000 OC-3 contains a 21-type OLIU circuit pack in

either the mains or the function units, there is no access to the VT1.5s.
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NE View for DDM-2000 OC-3 R15.x and FiberReach R4.x Shelves
Equipped with 29G or 24G OLIUs

The following section describes the NE view for DDM-2000 0C-3 R15.x and
FiberReach R4.x shelves with 29G OLIUs in the main slots.

Green Line

Boxes above the Green Line:

STS-1s STS-3s
STS-3s STS-1s

As the above graphic shows, the left and right boxes above the green line represent
STS-3/STS-1 signal interfaces. Each consists of 16 cells in four rows and four
columns. Each box consists of 12 STS-1s and 4 STS-3s. In the left box, each of the
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12 boxes in the three columns from left to right represent STS-1s. The last column
(the fourth column from the left) represents the STS-3s. The two boxes are mirror
images of each other. Therefore, in the right box, the STS-1s occupy the first three
columns from right to left.

The STS-1s are sequentially numbered from the bottom row up. In the left box, the
numbering starts from the bottom left row (m-1) across to the first box in the third
column of the bottom row (m-3). The fourth column represents STS-3s. The
numbering then continues from the first column in the second row (m-4) and across
the other two rows (m-5 and m-6), and so on.  STS-1s in the right box are similarly
numbered but in this case, the numbering starts from the bottom box in the right
column and goes from right to left. Here again, the fourth column represents the
STS-3s.

The address of the four STS-3’s in the fourth column correspond to that of the
STS-1s in the first column. Therefore, the address of the first STS-3 (bottom right) is
m-1. Similarly, the fourth STS-3 (top right) is m-4.

To check the address of a box, hold the cursor over the desired box. The address
appears in the status bar.

Boxes below the Green Line:

The vertically stacked boxes below the green line are placeholders for STS-1s that
have been selected and dragged down from their position above the line for either
VT1.5 cross connections or STS-1 add/drop cross connections. Dragging STS-1s
down below the green line allows access to 28 VT1.5 signals per STS-1.

For 24G OLIUs a maximum of 3 STS-1s may have VT granularity (any three the
user wishes to choose).

For 29G OLIUs, VT granularity is supported across all 12 STS-1s.

To drag and drop an STS-1 to a box below the green line:

•  Click on a desired STS-1 box above the green line. An “X” appears. Notice the
address displayed in the status bar.
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•  While still holding down the left mouse button, drag the “X” to one of the three
boxes.

•  Release the mouse button. The grid that appears in the box displays the 28
VT1.5 equivalent of the STS-1.
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You can drag and drop any of the STS-1s from above the line to any vertically
stacked box below the line. The grid that appears displays the VT1.5 equivalent of
the newly-inserted STS-1. Blue shading in any cell indicates the existence of cross
connections.

Note that unlike the boxes above the green line, the left and right vertically stacked
boxes below the green line (m1 and m2) are “clones” of each other. Therefore, the
address for the last row of the left column of the left m-6 box, for example,
corresponds to the last row of the first column in the right m-6 column.

The horizontally arranged boxes at the bottom of the screen correspond to the
function units used for add/drop cross connections.

To remove an existing STS-1 view from the VT box, double-click the heading of that
box. Note that removing the view does not delete any associated cross connections.

For DDM-2000 OC-3 NEs equipped with 29G or 24G
OLIU circuit pack in the mains:

    The top box on each side represents the STS-1/STS-3 interface. Each of these
boxes has four rows and four columns. The four entries in each row represent the

STS-3 termination points and the three associated STS-1 termination points.

    The vertically stacked boxes on each side represent the STS-1s that have been
selected for either VT1.5 cross connections or STS-1 add/drop cross connections.

    The horizontally arranged boxes at the bottom of the screen correspond to the function
units used for add/drop cross connections.

For FT-2000 OC-48 NEs:

    The West side (displayed on the left side) represents interfaces to the west STS-3
high-speed tributaries with three STS-1 tributaries contained in each STS-3.

    The East side (displayed on the right side) represents interfaces to the east STS-3
high-speed tributaries with three STS-1 tributaries contained in each STS-3.
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    The horizontally arranged boxes at the bottom of the screen  display four groups
of low-speed slots (DS3, EC1, or OC3). Each contains four slots. Every low-
speed slot contains three STS-1 time slots that represent the DS3 ports on DS3

slot, EC1 ports on EC1 slot, or STS-1 tributaries on OC3 slot.

The Menu Bar

You can access CPro-2000 functions with the menu bar in the GUI window. In addition, you
can access some of these commands can be accessed with the right-mouse-button pop-up

menu. Listed below are the menu names and the types of commands they contain:

•  Items that pertain to logging into or out of the NEs are in the Access Menu. This
menu also allows the user to run batch command files, print windows, save the
current subnetwork's information to a file, open the Node Manager, and to exit the
CPro-2000 application.

•  Operations for backing up, restoring, and changing TIDs or passwords are in the Edit
Menu.

•  Use the View Menu to show or hide cross connections and to change the way the
toolbar and status bar in the GUI are viewed. You can also access the Subnetwork
View, Report Viewer, and toggle the Auto-Alarm-Polling feature from the View
menu.

•  Use the Report Menu to retrieve path information, equipment information, alarm
status, NE history (MML only), provisioning, and performance-monitoring reports.

All of the reports are available in the Report Viewer.

•  Use the Provision Menu to modify port/line provisioning and NE options.

•  Use the Update Menu to requery the NEs about the current cross connections,
Partition or Network Element Inventory, and alarm information.

•  Use the Window Menu to arrange the GUI windows to fit viewing needs.

•  The End-to-End Path Menu is only available from the Subnetwork View. Use this
menu to enter and delete end-to-end paths. Also available in this menu is the
capability of modifying the LocA and LocZ values for an FT-2000 OC-48 STS-3 or

STS-1 end-to-end path.

•  The X-Conns Menu contains instructions on how to enter and delete cross
connections, individually or in a range. It does not contain the actual commands.
Cross connections are created or deleted by using drag-and-drop functionality. This
menu is only available while you are in a Network Element View window.

For information on how to create cross connections on shelves equipped with 29G
OLIU circuit packs in the mains, see the appropriate section in the Cross

Connections chapter of this User Manual.

•  The Help Menu provides the user with help options.

Some menu items are displayed with an arrow ( ) after them. Selection of these menu items
displays another level of menus. For example, selecting Port/Slot Options  from the Reports

pull-down menu displays a submenu.

Some menu items have three bullets (••• ) after them. Selection of these menu items displays

a dialog box requesting further input from the user. For example, selecting Backup•••
invokes the Backup Parameter dialog box, which requests further user input.

Non-Preemptible Protection Access

Non-Preemptible Protection Access (NPPA) is a feature in FT-2000 OC-48 that allows the
protection tributaries to serve as non-preemptible unprotected service tributaries while the
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corresponding service tributaries become unprotected. FT-2000 is capable of handling NPPA

at the STS-1 tributaries level.

The NE views for FT-2000 OC-48 are designed to display the NPPA status of the high-speed
tributaries. The following color conventions are used to display the NPPA status:

•  Yellow on the lower half of the high-speed tributaries (the normal service tributaries)
indicates that the tributary is unprotected.

•  Yellow on the upper half of the high-speed tributaries (the normal protection
tributaries) indicates that the tributary is in service without any protection and is non-
preemptible.

This scheme applies to both STS-1 level and STS-3 level NPPA statuses. In the case of
STS-3, all four slots pertaining to an STS-3 level tributary, which includes an STS-3 slot as
well as three corresponding STS-1 slots, will turn yellow at the same time. There will not be
NPPA status at levels lower than STS-3. In the case of STS-1, individual STS-1 slots have
their own NPPA status. If any one of the STS-1 slots is not NPPA enabled, the corresponding
STS-3 slot is shown as NPPA disabled. Only if all three of the STS-1 slots that correspond to
an STS-3 tributary are NPPA enabled will the corresponding STS-3 slot be shown as NPPA

enabled.

Color Conventions for the Network Element View

Listed in the following table are the color conventions displayed in the Network Element
View and what they represent. If you are using a monochrome monitor, these colors display in

varying degrees of gray tones.

Color Representation

Gray Slots that are not equipped or ports/slots
that are not a valid selection.

Black Lines that indicate cross connections;
they can be solid or dashed depending on
the cross-connection type.

Sky Blue Port/slots available for cross connections.

Purple Port/slot that is an endpoint for a
displayed cross connection or port/slot
that is selected.

Dark Blue All ports/slots where STS-1 cross
connections exist, when the lines
representing the cross connections are not
being displayed.

Yellow Signifies NPPA status (FT-2000).

Shelves equipped with 29G or 24G OLIUs

Dark Blue An STS-1 cross connection exists on the
time slot (DDM-2000 OC-3 or
FiberReach).

Dark Grey One or more VT cross connection exists
on the STS-1 time slot (DDM-2000 OC-3
or FiberReach) .
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Red STS-1 Grid cell that is selected and
opened at the VT level (DDM-2000
OC-3 with 29G or 24G OLIU).

ASCII User Interface
The ASCII User Interface (AUI) provides access to an NE in the same way that an ASCII
terminal provides access. You can type commands into the AUI and receive an immediate
response from the NE. This section concentrates on how to use the AUI in conjunction with

the GUI, although the AUI can be used as a stand-alone terminal emulator as well.

NOTE: An NE cannot talk to the AUI unless the AUI initiates contact. No autonomous
messages from an NE are acted upon by CPro-2000.

CPro-2000 uses the AUI to establish communications with the NEs. All commands initiated
through the GUI cause information to be sent to and received from the NE. This information

is always visible in the AUI.

Multiple communication sessions can be running within a single instance of the AUI program.
This is called a Multiple Document Interface (MDI) and is similar to how other Windows

programs operate.

For CPro-2000, this means that two sessions can use only one AUI program, but have two
open window sessions. Sessions are differentiated by names in the title bar of the child
window in the AUI; they are named Default1, Default 2, and so on. If you open an AUI

session from a settings file, the AUI title bar reflects the name of that settings file.

The following sample AUI screen shows MML output from a DDM-2000 NE when
connection is via serial link:
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The following sample AUI screen shows MML output from a DDM-2000 NE when
connection is over TCP/IP:

The following sample AUI screen shows TL1 output from a DDM-2000 NE when connection
is over TCP/IP through an NCC:



56 ••••  The User Interfaces CPro-2000 User Manual Release 11.0

The following sample AUI screen shows TL1 output from an FT-2000 NE when connection
is via serial link:

The user can benefit from the AUI by using it as a “dumb” terminal connected to an NE. Any
functionality that is not yet available in CPro-2000 can be accessed through expert mode,

which consists of clicking in the AUI window and typing the appropriate commands.

NOTE: You must click inside the AUI window or click one of the AUI menu items to
activate the AUI cursor. The cursor does not automatically appear when you change focus to

the AUI.

The AUI also provides the user with a powerful terminal emulator that can be used for many
tasks other than connecting to a subnetwork.

NOTE: Commands that affect the state of equipment or cross connections in the NE can
cause the GUI and the AUI to become unsynchronized. After working in the AUI, it is always
advisable to update the GUI by reissuing the Partition Inventory or the NE Inventory

command (see the “Using the Interfaces Together” section earlier in this chapter).

The AUI can also be used to set up and save modem specifications through the use of the
Communications menu. The user can enter the modem type and dial string in the Modem
Commands dialog box. For details, see the “Selecting Communications Options from the

AUI” section in the CPro-2000 Startup chapter.

SLC-2000 Access

Use the CPro-2000 AUI to control the low-speed side of an SLC-2000. After logging into the
SLC-2000, type dlc in the AUI (dlc stands for digital loop carrier). You can now issue
commands to the low-speed side of the SLC-2000. (See the SLC-2000 documentation for

further information.) To exit the low-speed side of the SLC-2000, type sonet.

The Menu Bar and Toolbar

The types of menu items displayed  in the menu bar depend on whether you are connected to
the NE through a serial link or over TCP/IP.  Some of these commands are also in the AUI
toolbar. The following lists the menu bar options available with both methods of connection.
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Serial Link Options

Toolbar options (from left to right):

•  Send Delete Character, Capture, Direct or Modem, Modify Communications, Modem
Specifications, Connect/Disconnect, and Run Script File.

Menu bar options (from left to right)

•  The File Menu offers the Exit command for terminating the AUI and all other
currently connected sessions, including the GUI.

•  When MML connected, the Edit Menu provides the Send Break and Del Char
commands that can be used to abort a command. This menu also contains the Modify
Script File command, which allows the user to open the Notepad editor and make
changes to a user-specified script file. This menu also allows the user to copy and

paste text that is displayed in the AUI.

•  The View Menu allows you to change the AUI window according to viewing needs.
The options that can be changed include hiding or displaying the status bar, the font
size and type, and whether the window is displayed in color, black and white, or gray
tones.

•  The Capture Menu gives you the ability to capture and save commands sent to and
received from the NEs as they appear in the AUI. These commands are saved to a file.

•  The Communications Menu contains commands for choosing connection
preferences, terminal emulation type, port settings from an already created file, or
modifying the default values (such as stop and data bits), modem settings, and
connect/disconnect. See the “Accessing the Subnetwork” section in the CPro-2000

Startup chapter for further information on how to use these commands.

•  The Run Script File  Menu enables you to run script files without accessing the
CPro-2000 GUI. This menu also provides scripts for system and shelf turnups. The
system and shelf turnup scripts must be ordered directly from Lucent Technologies
and can be customized for your location. For ordering information, please call 1-800
WE2-CARE.

•  The Help Menu provides information about the currently-running CPro-2000 release.

TCP/IP Connection Options

Toolbar (from left to right):

•  Connect/Disconnect and Capture

Menu bar (from left to right in the toolbar):

•  The Network Menu allows you to connect to or disconnect from the NE.

•  The Edit Menu allows you to edit the contents of the AUI window using the Clear
command to erase all text from the AUI window, the Copy command to copy a
selection to the clipboard, or the Paste command to insert the contents of the

clipboard into the AUI or another application.

•  The Capture Menu is not available in CPro-2000 Release R11.0.

•  The Help Menu provides information about the currently-running CPro-2000 release.
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NOTE: Any settings found in a login script or a batch file override settings provided in the
AUI, whether by user entry or a settings file.

Printing Reports and Windows
CPro-2000 can print reports and some windows directly from the GUI. All reports that can be
viewed through the Report Viewer, such as the reports created using the Reports menu, can be
printed to your local printer. See the “Report Viewer” section in The View Menu chapter for

additional details.

You can print the Subnetwork View using the Print command in the Access menu or the Print
toolbar icon. See the “Print Window” section in The Access Menu chapter for additional

details.

You can also print other GUI windows and AUI information, such as a Network Element
View or a captured AUI screen using Microsoft Paint™ or the Notepad editor. See the
following section, “Printing AUI Screens” for instructions on how to capture information in
the AUI and print it to your local printer. See the “Printing Windows” section later in this
chapter, for instructions on how to print windows from the GUI that are not supported by the

Print Window command.

Printing AUI Screens
To print information that appears in the AUI screen, use the following procedure:

Procedure

For connection via serial link
1. In the AUI, from the Capture pull-down menu, select Visible or Standard and

then select Start. The following screen appears.

2. Enter a file name as requested.

Any information displayed in the AUI after Capture Start is chosen is saved to
the file, until Capture Stop is chosen.

3. In the AUI, select Stop from the Capture pull-down menu.



CPro-2000 User Manual Release 11.0 The User Interfaces ••••  59

4. Access the file created with Notepad or some other Windows word-processing
package that accepts text as input.

5. Select Print Setup and choose landscape or portrait depending on the page
orientation of the report.

6. Select Print and click OK

For connection over TCP/IP
1. In the AUI, select the desired text.

2. Press Ctrl+C to copy the text to the clipboard.

3. Open a text editor such as Notepad, then press Ctrl+V to copy the text from the
clipboard.

4. Select Print Setup and choose landscape or portrait depending on the page
orientation of the report.

5. Select Print and click OK

Printing Windows
To print a window that appears in the GUI, such as a Network Element View, use the following
procedure:

NOTE: To print the Subnetwork View, see the “Print Window” section in The Access Menu

chapter.

Procedure

1. In the GUI, click the window you wish to print.

2. Press the Print Screen key on your keyboard to place a copy of the entire screen
in the Windows clipboard. To place only the selected window in the clipboard,

press Alt + Print Screen.

3. Open Microsoft Paint, located in the Accessories Program Group. (You can use
any Windows-based graphics package that accepts input from the Windows

clipboard.)

4. From the Edit pull-down menu, select Paste. A copy of the window appears.

5. From the File pull-down menu, select Print and the window is printed.
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Task Mapping

How to Accomplish a Task
The best way to accomplish a task that you are unfamiliar with in CPro-2000 is to find the
task in the table below and determine which menu contains the commands you need. Each
task listed in the table below is described in detail in the next few chapters of this guide. The
table here and the detailed descriptions in the subsequent chapters are all organized by menus,

accessible from the menu bar at the top of the GUI window.

NOTE: Creating and deleting cross connections is not performed through a menu. These
commands are performed using drag-and-drop technology. (The X-Conns menu contains
instructions for how to create and delete cross connections; it does not contain a menu of
commands.) For the purposes of this Task Map, cross-connection activities are listed under

X-Conns.

Task Map
The menu bar at the top of the GUI window contains all of the functionality of CPro-2000.
The menus can be accessed by clicking on the appropriate word in the menu bar using the
mouse. Each menu contains a grouping of similar tasks. The tasks that can be accomplished
via the GUI and its corresponding menus are listed in the following table. Keyboard shortcuts
that can also be used to accomplish certain tasks are shown in parentheses with their

respective menu items.

Menu Item

(Keyboard shortcut)

Task

Access/New Subnetwork Accesses a subnetwork that has not previously
been accessed or has no subnetwork information
saved for it.

Access/Open Subnetwork Accesses a subnetwork that has subnetwork
information that has been saved to a file in a
previous CPro-2000 session.
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Menu Item

(Keyboard shortcut)

Task

Access/Close Subnetwork

(Ctrl + C)

Disconnects from a subnetwork that is currently
being accessed.

Access/Save Subnetwork

(Shift + Ins)

Saves a subnetwork's information to a file, so you
can restart your next session with this subnetwork
without having to requery the NEs.

Access/Save Subnetwork As

(Ctrl + U)

Saves a subnetwork's information to a file, when
you are saving a subnetwork's information for the
first time or when you are saving it to a different
file name.

Access/Print Window Prints out your Subnetwork view to a printer
(Subnetwork view only).

Access/Close Window

(Ctrl + D)

Closes the window that currently has the focus in
the GUI. Does not log you out of an NE or
subnetwork.

Access/Close All Windows

(Ctrl + A)

Closes all windows that are currently open. Does
not log you out of an NE or subnetwork.

Access/Login

(Ctrl + L)

Logs into a remote node in the local node's
subnetwork (NE View only).

Access/Logout

(Ctrl + O)

Logs out of the current node (NE View Only).

Access/Node Manager

(Ctrl + N)

Opens, closes, logs in, logs out, or switches to each
Network Element View. Can also be used for a
partition inventory, partition map, or renaming a
partition.

Access/Run Batch Commands

(Ctrl + B)

Executes a series of commands using a batch file.

Access/Open (Partition) Opens the selected partition (Subnetwork View
only).

Access/Close (Partition) Closes the selected open partition (Subnetwork
View only).

Access/Open (NE) Opens the selected NE (Subnetwork View only).

Access/Edit CPro.ini

(Ctrl + E)

Allows editing of the INI file from the GUI.
Available only if the Subnetwork View is closed.

Access/Exit

(Ctrl + X)

Exits the CPro-2000 application.

Edit/Backup

(F8)

Backs up equipage, cross connections, and
provisionable parameters of the current node to a
file.

Edit/Restore

(F9)

Restores equipage, cross connections, and/or
provisionable parameters from a file to the current
node.

Edit/Change TID Changes the TID of the current NE.
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Menu Item

(Keyboard shortcut)

Task

Edit/Change Password Changes the password of the current NE

Edit/Switch DRI Operates or releases the manual dual-ring
interworking (DRI) switch for an FT-2000 OC-48.

Edit/Rename Partition Changes the default partition name to a
customized name of your choice.

View/Status Bar

(Ctrl + R)

Hides or shows the status bar at the bottom of the
GUI showing the alarm status.

View/Toolbar

(Ctrl + T)

Hides or shows the toolbar at the top of the GUI.

View/Show X-conn

(Shift +F8)

Displays specified cross connections in the current
Network Element View.

View/Hide X-conn Hides all cross connections in the current Network
Element View.

View/Subnetwork View Opens a window displaying the Subnetwork View.

View/Report Viewer

(F12)

Enables a previously saved report to be viewed or
printed.

Report/Path Creates a report in the Report Viewer that contains
information about the complete and incomplete
paths in the subnetwork (Subnetwork View only).

Report/Timeslot Usage Creates a report in the Report Viewer that shows
which time slots are being used in all NEs in the
subnetwork (Subnetwork View only).

Report/Cross Connections Creates a report in the Report Viewer that shows
the cross connections in a single NE (from a
Network Element View) or for all inventoried NEs
in a subnetwork (from the Subnetwork View).

Report/Map Displays a report in the Report Viewer that
contains connectivity information in relation to the
current node (Network Element View only).

Report/Alarms Displays an alarm summary in the Report Viewer
for the current node in the Network Element
View.

Report/History Displays a history of events in the Report Viewer
for the current node in the Network Element View
(MML only).

Report/Equipment Displays a report in the Report Viewer that shows
the equipage for the current node (Network
Element View only).
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Menu Item

(Keyboard shortcut)

Task

Report/Protection State Displays a report that shows the NPPA protection-
switching state for the current node in FT-2000
OC-48 (Network Element View only).

Report/Port/Slot Options Provides a list in the Report Viewer of the current
DS1, DS3, EC1, NCT/2, OC-1, OC-3, OC-12, and
LS port/line/slot options for the current node in the
Network Element View. Not all of these options
are available for every NE type or release.

X-Conns/Enter/Individual

                        /Range

Provides steps for creating individual or ranges of
cross connections.

X-Conns/Delete/Individual

                          /Range

Provides steps for deleting individual or ranges of
cross connections.

Provision/DS1 Ports

Provision/T1 Ports

Provision/DS3 Ports

Provision/EC1 Ports

Provision NCT/2 Lines

Provision/OC-1 Lines

Provision/OC-3 Lines

Provision/OC-12 Lines

Provision/OC-48 Lines

Retrieves current or sets new Port/Line Options for
DS1, DS3 T1, EC1, NCT/2 OC-1, OC-3, OC-12,
OC-48 and LS. Not all of these options are
available for every NE type or release.

Provision/Set NPPA Displays or sets the value for the Protection Access
State for FT-2000 OC-48 NEs.

Provision/Set Date Displays or modifies the current date or time of the
NE.

Provision/Set NE Sets options for the current NE including some or
all of the following: access identifier (AID), TID,
Node ID, Directory Services, assignment of
gateway network element (GNE) (DDM-2000
only), alarm GNE (AGNE), alarm group
(ALMGRP), X.25 packet size (X25ps), type of
cross-connection protocol, and data
communications channel (DCC).

Provision/Set Feat Displays or modifies performance-monitoring
parameters for DDM-2000 NEs

Provision/Set CID Secu/
DCE/DTE

Displays or modifies the current settings for
Set CID DCE and Set CID DTE parameters for
FT-2000 OC-48 NEs.
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Menu Item

(Keyboard shortcut)

Task

Provision/Update NE Updates the system database on the NE to reflect
the existing hardware configuration and incoming
signals.

Provision/OSI Stack/
Layer 3/Layer 4

Retrieves current or sets new values for the OSI
Stack.

Update/Inventory (Network
Element View)

(Ctrl + I)

Retrieves the equipage and cross connections of
the current NE and updates the Network Element
View database.

Update/X-Conn

(Ctrl + S)

Retrieves the cross connections of the current NE
and updates the Network Element View database.

Update/Alarm Updates and displays the alarm status on the GUI
status bar for the current NE.

Update/Active Users Retrieves and displays information about users
who are logged into an NE via MML.

Update/Map Retrieves the partition topology from all nodes in
the current partition (Subnetwork View only).

Update/Inventory (Subnetwork
View)

Retrieves the partition topology, equipage, and
cross connections from the current partition
(Subnetwork View only).

Window/Cascade

(Shift + F4)

Arranges Network Element Views and
Subnetwork View in a cascade format.

Window/Tile Horizontal

(Shift + F5)

Arranges Network Element Views and
Subnetwork View in a horizontal format.

Window/Tile Vertical

(Shift + F6)

Arranges Network Element Views and
Subnetwork View in a vertical format.

Window/Arrange Icons

(Shift + F7)

Arranges iconified windows in an orderly fashion
at the bottom of the GUI window.

End-to-End Path/Enter Establishes an end-to-end path (Subnetwork View
only).

End-to-End Path/Delete Deletes an end-to-end path of any type
(Subnetwork View only).

End-to-End Path/Modify
LocA/LocZ

Modifies the LocA and LocZ values for an
FT-2000 OC-48 STS-3 or STS-1 end-to-end path.

End-to-End Path/Tag Red Line Displays/modifies paths in FT-2000 OC-48 R8.1
and tag cross connections for Red Line services.

Alarms
(Alt + A)

Displays the Alarms menu options.

Alarms/Auto Alarm Polling
(Ctrl + A)

Changes existing state of Auto Alarm Polling.
Turns feature off if it is on, and vice versa. Check
mark is displayed if feature is on.
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Menu Item

(Keyboard shortcut)

Task

Alarms/Audible Alarm
(Ctrl + l)

Sets the audible alarm state. Check mark is displayed if
feature is on.

Alarms/Pager
(Ctrl + P)

Turns the pager feature on or off. Checkmark is
displayed if feature is on.

Alarms/Preferences
(Ctrl + r)

Brings up a dialog box from which to: define call
list criteria, set audible alarm, auto alarm polling,
and modem parameters; and test pager setup.

Alarms/Preferences/Alarm
Tab/Audible Repeat Seconds
(R)

Controls the frequency or repeat rate of the alarm
sound.

Alarms/Preferences/Alarm
Tab/Auto Poll Minutes
(P)

Controls the frequency with which alarm status is
updated.

Alarms/Preferences/Alarm
Tab/Modem Comm Port
(C)

Specifies communication port that corresponds to
the available modem.

Alarms/Preferences/Alarm
Tab/Alarm Tab/To access Outside
Line, first dial
(O)

Displays the prefix required to dial an outside
pager number.

Alarms/Preferences/Alarm
Tab/View
(V)

Displays existing log file.

Alarms/Preferences/Alarm
Tab/Delete
(D)

Deletes the log file.

Alarms/Preferences/Call List
Tab/Name
(N)

Displays the name associated with a specific pager
number and alarm level.

Alarms/Preferences/Call List
Tab/Phone (PIN)
(P)

Displays the pager number that corresponds to the
name specified in the Name field.

Alarms/Preferences/Call List
Tab/Address Type
(T)

Specifies the pager type.

Alarms/Preferences/Call List
Tab/Add
(A)

Adds a new entry to the data file.

Alarms/Preferences/Call List
Tab/Edit
(E)

Modifies the entries in the Call List window.
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Menu Item

(Keyboard shortcut)

Task

Alarms/Preferences/Call List
Tab/Delete
(D)

Removes entries from the Call List window.

Alarms/Preferences/Call List
Tab/OK
(O)

Confirms a command to edit, add, or delete an
entry in the Call List window.

Alarms/Preferences/Call List
Tab/Cancel
(C)

Cancels a command to edit, add, or an delete entry
in the Call List window.

Alarms/Preferences/Pager Test
Tab/Message to PIN
(P)

Accepts test messages entered by the user.

Alarms/Preferences/Pager Test
Tab/Message Text
(M)

Dynamically displays progress of the test.

Alarms/Preferences/Pager Test
Tab/Send
(S)

Transmits the test message.

Alarms/Preferences/Pager Test
Tab/Clear
(C)

Removes entries from the Message to PIN field
and the Message Text field.

Alarms/Preferences/Pager Test
Tab/Address Type
(T)

Specifies the pager type.

Help/CPro-2000 Help Provides an on-line version of the CPro-2000 User
Manual.
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The Access Menu

Overview
The Access Menu contains commands that can open, close, and save subnetworks; open and
close Network Element Views; log into and out of network elements; execute batch files; and

exit CPro-2000. The Access pull-down menu contains the following command options:

•  New Subnetwork

•  Open Subnetwork

•  Close Subnetwork

•  Save Subnetwork

•  Save Subnetwork As

•  Print Window

•  Close Window

•  Close All Windows

•  Login

•  Logout

•  Node Manager

•  Run Batch Commands

•  Open (Partition)

•  Close (Partition)

•  Open (NE)

•  Exit
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New Subnetwork

Purpose

To access a subnetwork that has not previously been accessed or that has no subnetwork
information saved for it. This command is  available only when no connection to a

subnetwork is currently active.

Procedure

1. From the Access pull-down menu, select New Subnetwork. The following
Login dialog box appears.

2. Optionally, check Partition Map or Partition Inventory. See the
“Partitioning’’ section in the Startup chapter for more information on partitions.

If you do not check Partition Map or Partition Inventory, CPro-2000 does the

following:

•  logs into the local node

•  inventories the local node and displays its Network Element View

If you select Partition Inventory, CPro-2000 gathers information about all the
nodes in the partition, including cross connections, equipage, alarms, and
topology. If you are going to be doing any type of subnetwork-level task, such

as creating an end-to-end path, it is necessary to take a Partition Inventory.

CPro-2000 users also have the option of choosing whether or not to retrieve a
list of L2 nodes when logging into the subnetwork. To exercise this option, click
the Retrieve L2 Nodes box to place a check mark. See the “Retrieve L2 Nodes”

section in the CPro-2000 Startup chapter for further details.

3. If the NE Interface is TL1, click the TL1 tab and either input a TID or select the
TID of the initial login node from the down-arrow list.

4. For all NE types, enter your user ID and press the Tab key then enter your
password.
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NOTE: See the appropriate NE documentation for procedures on how to change your user
ID. See The Edit Menu chapter for the procedure on how to change a password or TID.

5. To use the default script file, do not delete the contents of the Script field. But
you may specify the communications settings or select a script file. (See the
“Accessing the Subnetwork” section in the Startup chapter for information on

how to select communication options.)

6. OR

To choose a script other than the default:

•  Click the Browse button to display the Select A Script File dialog box. The
following screen appears.

•  Navigate to the CPro-2000 installation directory to access the Script Files. If
you accepted the default during installation, CPro-2000 will be in
C:\progra~1\cpror1~11.0.

•  Select one of the existing data communications scripts, depending on your
application. Click OK to select this script

NOTE: Although certain default script files are provided with the CPro-2000 software,  the
user can also create script files (see Appendix D, Script and Batch Files for information on

writing script files). Check any created script files thoroughly before use.

7. The Login dialog box redisplays with the appropriate script file. Click OK.

NOTE: If you receive an error message at this point, such as Invalid Port Response ,
see the CPro-2000 Software Release Description that accompanies this user manual for

details.

8. If you selected Partition Map or Partition Inventory from the Login window,
CPro-2000 automatically logs into each of the NEs in the subnetwork using the

user ID and password entered into the Login window.

NOTE: The following Login window appears if one of the NEs in the subnetwork uses a
different user ID or password other than the local node or if you have not preset the user ID

and password for the nodes in the ring.
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9. If this window appears, type in the correct user ID and password. Click OK.

The GUI window appears containing the appropriate Subnetwork View or
Network Element Views for the type of NEs in the subnetwork.

NOTE: To view examples of typical subnetwork and NE representations, see the “GUI
Representations” section in The User Interfaces chapter.

Open Subnetwork

Purpose

To access a subnetwork that has had its subnetwork information saved to a file during a
previous CPro-2000 session. All the information that CPro-2000 queries during a session,
such as NE equipage, cross connections, and neighbor information, can be saved to a file.
When you access the subnetwork using the file, CPro-2000 does not have to requery the NEs
in the subnetwork. It uses the information saved in the file. This command is only available

when no connection to a subnetwork is currently active.

Procedure

1. From the Access pull-down menu, select Open Subnetwork. The following
screen appears and prompts you to select the file that contains the previously

saved information for this subnetwork.

Navigate to the CPro-2000 installation directory to access the Subnetwork Files.
If you accepted the default during installation, CPro-2000 will be in

C:\progra~1\cpror1~ 11.0.
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2. Click OK to open the subnetwork using the information saved in this file. At
any time, you can click Cancel to dismiss the window and not open the

subnetwork.

NOTE: If CPro-2000 determines that there is a conflict between your saved subnetwork and
the current subnetwork due to changes in the subnetwork, a warning message will appear.
You then have the option of choosing Re-Start to reestablish the subnetwork, Continue to
keep your saved version (CPro-2000 may not work correctly), or Cancel to disconnect from

the subnetwork.

3. The following Login dialog box displays. The Partition Map and Partition

Inventory options are not available for selection. Since you are opening a
subnetwork using previously saved information, CPro-2000 will not gather new

data during login.

NOTE: If you are connecting via TL1, you cannot type a new TID into the dialog box. You
must choose from the known TIDs from the saved subnetwork information.

4. Continue with Step 2 in the “New Subnetwork” section earlier in this chapter to
complete the login process.

Close Subnetwork

Purpose

To disconnect from a subnetwork that is currently being accessed.

Procedure

1. From the Access pull-down menu, select Close Subnetwork. The following

screen appears:
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2. Click No if you do not want to close the subnetwork. Click Yes if you want to
close the current subnetwork. Note that this command does not completely exit
you out of CPro-2000 (see the “Exit” section later in this chapter). The

following screen displays:

3. Click No if you do not want to save information about this subnetwork to a file.
Click Yes if you want to save this subnetwork's information to a file. The

following screen displays:

4. Click NO to keep the Com Port open to facilitate further connections. Click Yes

if you want to disconnect the Com Port.

Save Subnetwork

Purpose

To save a subnetwork's information to a file, so that you can restart your next CPro-2000
session using the current subnetwork's information. Use this command when you already have

a file for this subnetwork's information and you want to update the file.

Procedure

1. From the Access pull-down menu, select Save Subnetwork. The current
subnetwork information is saved to the existing subnetwork file.
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Save Subnetwork As

Purpose

To save a subnetwork's information to a file, so that you can restart your next CPro-2000
session using the current subnetwork's information. Use this command when you are saving a
subnetwork's information for the first time or if you want to save the subnetwork's

information to a file name that is different from an existing file name.

Procedure

1. From the Access pull-down menu, select Save Subnetwork As. The following
screen appears:

2. Navigate to the CPro-2000 installation directory to access the Subnetwork Files.
If you accepted the default during installation, CPro-2000 will be in

C:\progra~1\cpror1~ 11.0.

3. Type in a new file name or choose one of the other existing file names.

If you choose a name that is already in use, a warning appears.

•  If you want to replace the existing file with a new one, click Yes.

•  If you do not want to replace the existing file, click No, then rename the new
file.

4. Click OK, or click Cancel if you do not want to save this subnetwork's
information to a file. You are returned to the Subnetwork View.
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Print Window

Purpose

To print out your current Subnetwork View window.

Procedure

1. From the Access pull-down window, or from the toolbar icon, select Print

Window. The following window appears:

2. You can perform the following functions on this map capture:

•  The View function allows you to make the size of the map capture larger or
smaller by selecting a value from the View down-arrow list.

•  The Print function brings up an abbreviated Print menu so your map capture
can be printed.
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•  The Save function allows you to save your Subnetwork View to a file name, so
it can be accessed at a later time through the Report Viewer command in the
View menu.

•  The Close function enables you to close the Subnetwork using the Save
function.

•  The Settings function offers a full selection of print commands. Use the Close

Settings command to return to the basic functions of the screen, but not close
the map capture.

Close Window

Purpose

To close the window that currently has the focus in the GUI. Note that this command does not

log a user out of an NE or subnetwork.

Procedure

1. From the Access pull-down menu, select Close Window.

2. The window that currently has the focus in the GUI is closed.

Close All Windows

Purpose

To close all the windows, including any Network Element Views and the Subnetwork View
that are currently displayed. This command does not log you out of an NE, disconnect you

from the subnetwork, or exit you from CPro-2000.

Procedure

1. From the Access pull-down menu, select Close All Windows.

2. All open windows are closed.

Login

Purpose

To log into remote nodes in the local node's subnetwork and is only available from an open
Network Element View.

Procedure

In the Access pull-down menu, the Login command is enabled if the desired
node has been inventoried at least once and you are not already logged into it.
Select Login. CPro-2000 logs into the node using the user ID and password

provided during initial login to the subnetwork.
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NOTE: Since the DDM-2000 MML systems require that any remote login session currently in
progress must be terminated before another remote login session can be established, CPro-2000

automatically logs out of one remote session and then performs the user-requested remote login.

If you receive an error while logging in, remember to check the information given in the AUI.
Sometimes this explains exactly why the login attempt (or any other command) has failed.

Logout

Purpose

To log out of the current node. For a DDM-2000, it may be either a remote node or a local
node. This command is only available from the Network Element View.

Procedure

1. From the Access pull-down menu, select Logout.

2. If the NE that you want to logout of is TL1-connected or not a local node (it is
not the node to which you logged into when you connected to the subnetwork),
you are logged out of the node and the Network Element View is closed if it is

the local node.

3. If the NE is MML-connected and is the local node (the node to which you
logged into when connecting to the subnetwork), the following dialog box

appears:

4. Click Yes to log out of the local node and any other open Network Element
Views, including the Subnetwork View. Click No if you do not want to logout

of the local node and close any open windows.

Node Manager

Purpose

To provide easy access to the subnetwork you are logged into and its components, such as
partitions and individual NEs. The Node Manager allows you to open and close the
Subnetwork View and Network Elements Views. You can expand a partition to show all of its
individual NEs, perform a partition map or partition inventory, rename a partition, or
open/close a partition. You can also log into NEs, log out of NEs, and preset user IDs and

passwords from this window.

NOTE: The command button functionality in the Node Manager varies according to the type
of icon highlighted. Therefore, the buttons will become enabled or disabled accordingly.
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Procedure

1. From the Access pull-down menu, or by clicking the toolbar icon , select
Node Manager. The following screen is displayed:

2. There are several different tasks you can accomplish from this point. For
example, scroll down and click an NE to select it; OC3-13 in the following
example. The Map Partition, Inventory Partition, and Login buttons become

available, as shown in the following screen:

3. 
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4. To discover a partition containing this NE, click either Map Partition or
Inventory Partition. The Login window appears.

5. Enter your UserID and Password, then click OK. A new partition is created
and displayed on the Subnetwork View. The next time you access the Node

Manager, it also shows the second discovered partition (P2) in the subnetwork.

6. From this screen, you can select several tasks, as described in the following list.
Note that the notation (L) next to an NE means that you are currently logged

into it.

•  Click Open or Close to open or close a Network Element View or the
Subnetwork View. (The Open option is only available when Network Element
Views or the Subnetwork View are not open.)

•  Click Switch To to change the focus of the CPro-2000 GUI to the Subnetwork
View or to an NE that is open. The SNW-View icon or an opened NE icon
must be selected for Switch To to be available.

•  Click Login to log into an NE.

•  Click Logout to log out of the chosen node. (The Logout option is only
available when you are logged into a node.)

•  Click Close NodeMan to close the Node Manager. The Node Manager also
closes each time you complete a task.
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•  Click one of the partition icons. The Set Access, Update Map, Update

Inventory, and Rename buttons are activated.

— Click Set Access to specify user IDs and passwords for CPro-2000 to
use when inventorying or mapping a partition. See the section that

follows for more information about this feature.

— Click Update Map to get an updated view of that partition in the
Subnetwork View.

— Click Update Inventory to update the information for that partition,
such as cross connections and port provisioning.

— Click Rename to give the partition a new name. The following screen
displays:

— Enter the new partition name and click OK. For example, you may
want to give the partition a name that reflects the makeup of the

partition. Click Cancel if you do not want to rename the partition.

Set Access
You set access when you predefine user IDs and passwords that CPro-2000 uses during a
session to inventory or map a partition. There are three ways to set access in CPro-2000. You

can set access from:

•  the Login window at login

•  the Node Manager

•  a saved subnetwork

The following sections provide instructions on how to use each method.

Setting access from the Login window

1. Bring up CPro-2000 R11.0.

2. From the Access Menu, click New Subnetwork. The Login window appears.
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3. Select the desired Login Script, then check off either Inventory Partition or
Partition Map. (See the Startup chapter for more information about the login

scripts and partitions).

4. Click OK.

5. Enter the UserID and Password for each node.

6. Click OK after entering the login information for each node. The login window
appears for each node in the ring. When you click Map Partition or Inventory
Partition later in the session, CPro-2000 will use the login information provided

to map or inventories the partitions in the network.

Setting Access from the Node Manager

1. Log onto a network in the usual manner.

2. Click the Node Manager button. The Node Manager screen displays.
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3. Click a node other than the local node (the node you are logged into). In this
example, the local node is OC3-12, so OC3-13 is the selected node as shown
below. Notice that the Login, Open, Map Partition, Inventory Partition, Set

Access, and the Close NodeMan buttons are activated. The selected node is

outlined in blue.

4. Click Set Access. The expanded Node Manager window has an attached panel
(the Set Access Panel).
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5. Enter the UserID and Password in the appropriate fields, then Click OK.

OR

Click Cancel to return to the unexpanded Node Manager screen without

establishing the user ID and password.

TIP: If the user IDs and passwords are the same for all the nodes in the network, you can
preset access for each of nodes in the ring from this point. To do so:

•  Click back on the node for which you just established the user ID and
password  (OC3-13 in the above axample).

•  Click the Set Access button. The expanded window redisplays with the last
entered userID and password .
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•  With the Set Access Panel still open, click the next node in the ring; FR2-B in
the above example.
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•  Click OK. The Node Manager window contracts again and CPro-2000 applies
the information in the expanded section to the selected node.

•  Repeat the steps from the TIP to preset the ID and password for all the nodes
in the ring. When you press Map Partition or Inventory Partition later in the
session, CPro-2000 will use the predefined information to log into each node
without prompting for the user ID and password.

Setting access from a saved subnetwork file

1. Bring up CPro-2000.

2. From the Access Menu, click Open Subnetwork.
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3. Navigate to the desired saved file, and then click OK. The Login window
appears.

4. Enter the UserID and Password, and then click OK. The unexpanded
subnetwork view displays.

5. Double-click the subnetwork view to expand the display.

6. Double-click a node to display the NE view for the desired node.

If the userID and password for the selected node is the same as that used in the
Login window, CPro-2000 uses that information to log into the desired node and

display the NE view.

If the userID and password for the selected node differs from that used in the
Login window, the following Login window appears.

•  Enter the UserID and Password for the selected node, and then click OK. The
NE view for the selected node displays.

•  You may use the Set Access to preset login information for other nodes if they
differ from that used in the Login window. To do so, follow the instructions
provided earlier this section.

Run Batch Commands

Purpose

To allow the CPro-2000 user to execute batch files containing groups of commands, such as
NE initialization commands or NE options not currently supported in the CPro-2000 menu.
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This feature may be used for rapid turnup of new installations, using preestablished local

standards.

NOTE: See Appendix D, Script and Batch Files, for information on writing script or batch
files.

Procedure

1. From the Access pull-down menu, select Run Batch Commands. The
following screen appears:

Navigate to the CPro-2000 installation directory to access the Script Files. If you
accepted the default during installation, CPro-2000 will be in

C:\progra~1\cpror1~11.0.

2.  Choose the script file that you want to execute, and click OK.

NOTE: The script or batch files are customized files set up by the CPro-2000 system

administrator. Any newly created files should be tested prior to use.

Open (Partition)

Purpose

To expand a selected partition in the Subnetwork View and displays the individual NEs in the

partition.

Procedure

1. In the Subnetwork View, click the desired partition icon to be expanded.

2. From the Access pull-down menu, select Open (Partition).

3. The selected partition is expanded and the individual NEs for the partition are

displayed.
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Close (Partition)

Purpose

To close an expanded partition in the Subnetwork View.

Procedure

1. In the Subnetwork View, click the desired partition icon to be closed.

2. From the Access pull-down menu, select Close (Partition).

3. The selected partition is closed and the individual NEs for the partition are no
longer displayed.

Open (NE)

Purpose

To displays the Network Element View for a selected NE.

Procedure

1. In the Subnetwork View, click the box representing the individual NE to be
displayed. (A partition must be expanded to see the individual NEs).

2. From the Access pull-down menu, select Open (NE).

3. The Network Element View is displayed for the NE.

Exit

Purpose

To exit the CPro-2000 session.

Procedure

1. Choose this command when you want to terminate a CPro-2000 session. You
are prompted to confirm the command with the following dialog box:

2. If you click Cancel, you are returned to where you were previously focused in
the GUI, and you are not exited from CPro-2000.

If you choose OK and you are not in an active CPro-2000 session, CPro-2000
closes.
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If you choose OK and you are currently in an active CPro-2000 session, the
following screen appears:

3. Choosing No closes any open GUI windows, closes the AUI window, and
terminates CPro-2000.

If you choose Yes, your subnetwork information is saved, the GUI and AUI
close, and CPro-2000 is terminated.
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The Edit Menu

Overview
The Edit Menu contains commands that back up and restore information about NEs, change
target identifiers (TIDs) and passwords, and execute the dual-ring interworking (DRI) switch

for FT-2000 OC-48.

The following commands are available from a Network Element View:

•  Backup

•  Restore

•  Change TID

•  Change Password

•  Switch DRI (FT-2000 OC-48 only)

The following command is available from a Subnetwork View:

•  Rename Partition

Backup

Purpose

To create a backup copy of the current equipage, cross connections, and provisionable
parameters of a node to a file. Files created during a backup are used during the Restore

command.

In addition to other parameters, CPro-2000 R11.0 supports the following new parameters in
files that are backed up using the Backup command:

•  The PDIPSW parameter – dictates system reaction to a payload defect. If PDIPSW is
disabled, no switching occurs in the event of a payload effect. If PDISW is enabled,

switching occurs, with a minor alarm, when a payload defect is detected.

•  The EQPDEPRPT parameter – sets the scope of the Equipage Dependent Reports.
Parameter can be set so the reports contain either all pre-provisioning information or

information based on equipage.

•  The PJC threshold parameter - the count of the STS-n pointer adjustments created or
absorbed by an NE. This happens when there is a difference in frame rates of the
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incoming and outgoing SONET signals. Excessive PJCs indicate network
synchronization problems.

See Appendix E, Backup/Restore Parameters, for more details.

NOTE: Only CPro-2000 R7.0, R8.0, R9.0, R10.0, R11.0 backup files can be restored in
CPro-2000 R11.0.

The Restore feature for FT-2000 R8.1 supports only files that have been created using CPro-
2000 Releases 9.0, 10.0, and 11.0. See Appendix F, Table of NE releases per CPro

releases, for more information about the compatibility between NEs and CPro-2000 releases.

Procedure

1. After choosing Backup from the Edit pull-down menu, the following screen
displays.

Navigate to the CPro-2000 installation directory to access the Backup Files. If
you accepted the default during installation, CPro-2000 will be in

C:\progra~1\cpror11.0.

2. Specify a file name for your backup file.

If you choose a name that is already in use, a warning appears.

•  If you want to overwrite the existing file with a new one, click Yes.

•  If you do not want to replace the existing file, click No, then rename the new
file.

3. Click Cancel to cancel the entire operation. Click OK to perform the backup.

NOTE: If you are connected to the NE being backed up via MML, the extension appended to
the backup file is .brm (which stands for backup/restore/MML). If you are connected to the
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NE being backed up via TL1, the extension appended to the backup file is .brt (which stands

for back/restore/TL1).

The following screen displays:

4. Click Yes to perform the backup. Click No to cancel the backup.

The following summary report appears when the backup has been successfully
completed:

5. Click Close. The following screen displays.
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6. Click OK. Your backup file is now created. A typical backup file contains
information similar to the following:

NOTE: The content of a backup file varies with the type and release of NE and its equipage.
This following is just a sample of what a backup file may contain.

•  The first line of a backup file contains information about the NE. The format is
the following:

—   internal ID for NE type

—   ring (1) or linear (0)

—   release number

—   TID of NE at time of backup

—   user ID of user who created file

—   date of file creation (as per the NE)

—   time of file creation (as per the NE)

A sample first line might look like the following:

1,1,7.2,NODE-AA, LUC01, 1/4/70, 21:6:32

•  The remainder of the backup file consists of lines containing a Data ID and
associated data fields, all separated by a comma (,). The following is an
example:

CMD_RTRV_SECU,cit-1,disabled,0,

The number of fields and their values vary depending on the command.

CAUTION: It is strongly recommended that you do not try to access or modify your backup
files. CPro-2000 cannot support backup files that have been manipulated in any way.

NOTE: For a DDM-2000, provisionable parameters can be backed up from one node and
restored to a different node as long as the equipage of the nodes and the NE software is

compatible. Equipage does not affect the restoration of an FT-2000 node.

The current node must be inventoried prior to using the Backup command.  You can
inventory the current node during startup, from the Update menu, or from the Node Manager.

Restore

Purpose

To restore provisionable options previously saved into a file via the Backup command. See
Appendix E, Backup/Restore Parameters, for more details.

NOTE: Only users with a privileged login can restore an NE. An error message appears if a

nonprivileged user attempts this command.

 Only CPro-2000 R7.0, R8.0, R9.0 and R10.0 backup files can be restored in CPro-2000
R11.0.

The Restore feature is intended to restore files that have been backed up with the same NE
release and the same software release.
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•  If you attempt to restore files that have been backed up using a different NE, the
following message window will be displayed:

•  If you attempt to restore files that have been backed up using a different release of the
same NE, the following message window will be displayed:

NOTE: Although a backup file may be created remotely, CPro-2000 Release 11.0 does not
support a remote restore.

All TARP NE releases automatically restore commands. However, in DDM-2000 OC-3
Releases 13.0, 13.5 and 15.x, DDM-2000 OC-12 Release 7.x, and FiberReach Releases 3.0,
3.1 and 4.0, commands that cause a reset and/or result in the loss of DCC connectivity are
displayed in a separate Notepad window and must be manually entered in the AUI to

complete the restore process. These commands are listed in the table below:

DDM-2000 MML DDM-2000 TL1 FT-2000 TL1

set-ne ent-sys ent-sys

ent-ulsdcc ent-ulsdcc

ent-osacmap ent-osacmap

set-x25 ent-x25

set-security ent-cid-secu

Instructions for manually entering these commands are included in the section that
follows.
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Procedure

1. After choosing Restore from the Edit pull-down menu, the following screen
appears.

2. Select the appropriate file with which to restore the current NE. Click OK.

NOTE: For restoring Network Elements, CPro-2000 R11.0 allows the following choices in
the message window:

•  Select "full restore" for CPro-2000 R11.0 to completely restore the backed up
file

•  Select "restore without threshold" for the system to restore only non-
provisionable threshold parameters.

•  Select "restore only thresholds" for the system to restore only provisionable
threshold parameters.

3. Select the desired option then click OK to perform the restore. Click No to

cancel the restore.

If you choose to continue, the following screen displays:
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4. Click Yes to continue the process. The following report displays:

NOTE: CPro-2000 sends commands to discover the current equipage and hardware switch
settings in the selected NE and compares this information with the corresponding information
in the existing backup file. The above report is generated to display any differences that are

found.

5. Click the Close button to close the report. The following screen appears:

NOTE: To ensure the success of the restore operation, CPro-2000 to removes existing cross
connections and feature data as they might conflict with the restore commands. After

removing these, CPro-2000 sends the restore commands one by one.

6. Click Yes to continue.

NOTE: If any differences have been discovered and reported, the restore operation may be
canceled by clicking No. The user can then correct any differences before proceeding. Note
that if the restore is continued in spite of reported differences, some restore commands may

fail.
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7. For earlier releases of DDM-2000 and FiberReach, the following window
displays if the system detects any commands that would cause a reset and/or
result in the loss of DCC connectivity. You must manually copy and paste these

commands into the AUI. Instructions are given below.

To complete the restore process, manually enter commands that appear in the

Notepad window by doing the following:

•   Select the entire command line including the semicolon.

•  Copy the command by either pressing Ctrl+C or selecting Copy from the Edit
menu.

•  In  the AUI window, place the insertion point next to the final prompt. Then
press Ctrl+V or select Paste from the Edit menu to paste the command.

•  Follow the prompts in the AUI to execute the command, then press Enter.

•  Repeat the above procedure for other commands in the Notepad window,
copying the commands into the AUI one at a time. When you have entered all
the commands into the AUI, close out of CPro-2000, then restart after the last
command is executed.

NOTES:

If  the command to change the TID ("Tid=") is listed in the Notepad window, place it last in

the AUI. Restart CPro-2000 for the process to take effect.

For FT-2000s, if the restore requires the ent-ulsdcc-13 command to be executed, enter this
command last in the AUI then restart CPro-2000 for the process to take effect.

For DDM-2000 R15.0 and FiberReach R4.0, CPro-2000 automatically restores all commands.
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The following Restore Summary report displays:

8. Click the Close button to close the report. The following screen appears.

Change TID

Purpose

To change the current network element's TID.

Procedure

1. From the Edit pull-down menu, select Change TID. The following Change TID

dialog box appears:
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2. Type in the new TID. The OK button is enabled.

3.  Click OK.

NOTE: A TID consists of a string of alphanumeric characters. See the NE documentation for
a list of the restrictions on the TID character set.

 

Change Password

Purpose

To change a CPro-2000 user's NE password. This screen also appears when an FT-2000
OC-48 NE password expires.

Procedure

1. From the Edit pull-down menu, select Change Password. The following

Change Password Dialog box appears:

2. Type in your current password in the Old Password field and press the Tab

key. Note that asterisks appear instead of the actual password. Type in the new
password in the New Password field and press the Tab key. Reenter the new

password in the Reenter Password field. The OK button is enabled.

3. Click OK.

NOTE: The password consists of a string of alphanumeric or symbolic characters. See your
NE documentation for a list of the restrictions on the password character set.

4. If any errors were made while typing in the old and new passwords, an error
message appears. Reenter the passwords and click OK.



CPro-2000 User Manual Release 11.0 The Edit Menu ••••  101

Switch DRI

Purpose

To execute the Dual-Ring Interworking (DRI) manual switch in an FT-2000 OC-48.

Procedure

1. From the Edit pull-down menu, select Switch DRI.

The following screen appears:

2. Select the STS3 Tributary address for the DRI switch. (This is the STS-3
tributary that has the solid line connected to it in the Network Element View of

the node.)

3. Click Operate to enable the DRI switch. Click Release to reset the DRI switch.
At any time you may click Close, and your selection is not executed or saved.

Rename Partition

Purpose

Instead of using the default sequential numbering scheme that CPro-2000 automatically
assigns to your partitions, you may decide to rename the partitions. For example, you may
decide to give your partition a name that identifies its contents. This command is only

available from the Subnetwork View and when a partition has the focus.



102 ••••  The Edit Menu CPro-2000 User Manual Release 11.0

Procedure

1. From the Edit pull-down menu, select Rename Partition. The following screen
appears:

2. Type in the new name for the partition and click OK.
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The View Menu

Overview
The View Menu contains the following command options:

•  Status Bar

•  Toolbar

•  Show X-Conn

•  Hide X-Conn

•  Subnetwork View

•  Report Viewer

The Status Bar and Toolbar commands are used to show or hide the status bar and the toolbar
on the CPro-2000 GUI.

The Show and Hide X-Conn commands enable a CPro-2000 user to either display or hide
cross connections in the Network Element View.

The Subnetwork View opens a window to display the Subnetwork View.

The Report Viewer provides the ability to read and print previously saved reports. (See The

Report Menu chapter for information on how to save a report to a file.)
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Status Bar

Purpose

To display or hide (for more room on the screen) the status bar that contains the alarm status,
an information window, and trash can icon, at the bottom of the CPro-2000 GUI window.

Procedure

1. From the View pull-down menu, select Status Bar. If Status Bar is shown with
a check mark, then the status bar is displayed on the GUI. If no check mark is

shown with the Status Bar command, the status bar is not displayed.

Toolbar

Purpose

To display or hide (for more room on the screen) the toolbar, which contains shortcut icons
for several CPro-2000 menu items, at the top of the CPro-2000 GUI window.

Procedure

1. From the View pull-down menu, select Toolbar. If Toolbar is shown with a
check mark, then the toolbar is displayed on the GUI. If no check mark is shown

with the Toolbar command, the toolbar is not displayed.

Show X-Conn

Purpose

To display cross connections in a Network Element View.

Procedure

1. In the View pull-down menu, click Show X-Conn. A drop-down menu appears.
Depending on the NE type, the following choices are displayed:

•  Select All—displays all existing cross connections

•  STS-1—displays all STS-1 cross connections (DDM-2000 only)

•  VT1.5—displays all VT1.5 cross connections (DDM-2000 OC-3 and
FiberReach only)

•  STS-3C—displays all STS-3C cross connections (DDM-2000 OC-12)

•  STS-3—displays all STS-3 cross connections (FT-2000 only)

The cross connections are then displayed in the current Network Element View.
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Hide X-Conn

Purpose

To hide all cross connections while in a Network Element View.

Procedure

1. In the View pull-down menu, click Hide X-Conn. On the current Network
Element View all cross connections are hidden.

Subnetwork View

Purpose

To display the Subnetwork View.

Procedure

1. In the View pull-down menu, click Subnetwork View. A window is opened and
the Subnetwork View is displayed.

Report Viewer

Purpose

To enable a user to perform functions such as viewing or printing a previously saved report or
end-to-end path graphic. (See The Report Menu chapter for details on how to save a report

to a file.)

NOTE: Do not use the Report Viewer to open files that are not report viewer files or end-to-
end path graphics. It is recommended that you use the .rpt  and .eep  suffixes when saving
these types of files to avoid confusion with ordinary text files, such as those with a .txt
suffix. If you do try to open a non-report file with the Report Viewer, an error message

displays and you are prompted to select another file name.
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Procedure

1. In the View pull-down menu, click Report Viewer. The following screen
appears:

2. In the File Name field, type in the name of the report you wish to view and click
OK. You can click Cancel at any time to dismiss this screen and return to the

CPro-2000 GUI.

3. The report is displayed in a window similar to the following:
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You can perform the following functions on the report:

•  The View function allows you to make the size of the report larger or smaller by
selecting a value from the View down-arrow list.

•  The Page function can be accessed two ways. By using the arrows (<<, <, >>, >), you
can go through the report page by page, either backward or forward. You can also

click the Page box and edit the current page number to the page number you want.

NOTE: The Page Up and Page Down keys on your PC keyboard do not work in the Report
Viewer. Also, the scroll bar appearing on the right side of the Report Viewer does not take
you to the next page of the report; the scroll bar only takes you from top to bottom of an
individual page. Use the arrows, as described above, to access the next or previous page of the

report.

•  The Print function brings up an abbreviated Print menu so that your report can be
printed.

•  The Save function allows you to save your report to a file name so that it can be
accessed at a later time through the Report Viewer command in the View menu.

•  The Close function enables you to close the report without saving it to a file (unless
you have already done so using the Save function).

•  The Settings function offers a full selection of print settings. Use the Close Settings

command to return to the basic report functions, but not to close the report.
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The Report Menu

Overview
The Report Menu contains commands that display information about end-to-end paths, cross
connections, equipment, alarms, port options, and history. Any reports may be saved to a file

and accessed at a later time by using the Report Viewer command in the View menu.

There are two ways of accessing report options while in a Subnetwork View. You can use the
Report menu on the menu bar, which is the method described in the following procedures. The
other method is to select a closed, or unexpanded partition (with a single left-mouse-button click),

and click the right mouse button to display a pop-up menu containing a Reports submenu.

From a Subnetwork View, the following report options are available:

•  Path

•  Cross Connections

•  Timeslot Usage

•  Bandwidth Usage

NOTE: Reports generated while in the Subnetwork View contain data for the current or
selected partition only. To gather data for the entire subnetwork, a report must be created for

each partition in the subnetwork.

From a Network Element View, the following report options are available:

•  Cross Connections

•  Map

•  Alarms

•  History

•  Equipment

•  Protection State (FT-2000 only)

•  Port/Slot Options
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Report Screen Functions
All CPro-2000 reports are displayed in a window similar to the following:

All report windows contain the following useful functions:

•  Use the View function to make the size of the report larger or smaller by selecting a
value from the View down-arrow list.

•  Access the Page function by using the arrows (<<, <, >>, >) to go through the report
page by page, either backward or forward or by clicking the Page box and editing the

page number.

NOTE: The Page Up and Page Down keys on your PC keyboard do not work in the Report
Viewer. Also, the scroll bar appearing on the right side of the Report Viewer does not take
you to the next page of the report; the scroll bar only takes you from top to bottom of an
individual page. Use the arrows, as described above, to access the next or previous page of the

report.

•  Use the Print function to display an abbreviated Print menu from which to select a
print option.

•  Use the Save function to save your report to a file name so it can be accessed at a
later time through the Report Viewer command in the View menu.

•  Use the Close function to close the report without saving it to a file (unless you have
already done so using the Save function).

•  Use the Settings function to access full selection of print settings. Use the Close

Settings command to return to the basic report functions, but not to close the report.
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Path

Purpose

To view a report that contains information about the complete and/or incomplete end-to-end
paths in the partition. This command option is only available from the Subnetwork View. The
Path report only analyzes paths within an individual ring. The Partition Inventory command

must be completed before creating a Path report.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

NOTE: All hairpin cross connections will be listed as paths.

Procedure

1. From the Report pull-down menu, select Path. A report similar to the following

appears:
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Cross Connections

Purpose

When chosen from the Subnetwork View, the cross-connections report shows the cross
connections for all NEs in the partition that have been inventoried. When chosen from a

Network Element View, this report shows the cross connections for that NE only.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

Procedure

1. From the Report pull-down menu, select Cross Connections. A report similar to
the following appears:
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Timeslot Usage

Purpose

To display a report that indicates where cross connections currently exist and where time slots
are available for paths to be created. This command option is only available from the

Subnetwork View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

NOTE: A Partition Inventory must be taken before the Timeslot Usage report can be generated.

Procedure

1. From the Report pull-down menu, select Timeslot Usage. A report similar to the
following appears:



114 ••••  The Report Menu CPro-2000 User Manual Release 11.0

The following designations appear in the Timeslot Usage report:

•  X equals a cross connection that does not form a path, also known as a dangling cross
connection.

•  P equals a complete, valid path.

•  L equals a locked cross connection (DDM-2000 OC-3, R13.0, and FiberReach R3.0
only).

Bandwidth Usage

Purpose

To display a report that details the bandwidth usage between two NEs. As described in the
“Report Screen Functions” section earlier in this chapter, a variety of tasks can be performed

on the report, such as saving the report to a file or printing out the report.

NOTE: The Bandwidth Usage report is displayed by clicking the right mouse button on the
optical link between NEs in the expanded partition of the Subnetwork View. It is not available

through the Report pull-down menu.

Procedure

1. In the Subnetwork View, click the right mouse button on the optical link

between the desired NEs. The Bandwidth Usage option appears.

NOTE: The Bandwidth Usage option is enabled only when the entire ring has been

inventoried. Otherwise, it will appear grayed out and cannot be selected.

2. Click Bandwidth Usage.

A report similar to the following appears:
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Map

Purpose

To display the connectivity in relation to the current node. The map report option is only
available from a Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

Procedure

1. From the Report pull-down menu, select Map. A report similar to the following
appears:
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Alarms

Purpose

To display an alarm summary for the current node. The alarms report option is only available
from a Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

Procedure

1. Click the Alarm Status area in the Status Bar, or from the Report pull-down
menu, select Alarms. A report similar to the following appears:
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History

Purpose

To display a history of events for the current node. The history report option is only available
from a Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

Procedure

1. From the Report pull-down menu, select History. The following screen appears:

2. Choose Entire Report if you want to view the entire report or choose
By Date/Time and then enter the desired Start/Stop Dates and Start/Stop Times.

Click OK. You may click Cancel to close the window and no report is generated.

A report similar to the following appears:
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Equipment

Purpose

To view a report that shows the equipage for the current node. The equipment report option is
only available from a Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

NOTE: CPro-2000 obtains network equipment information from the RTRV-EQPT command.
If the equipage for the NE has changed, run an update on the NE using the Update Menu to

re-inventory the NE in CPro-2000 prior to obtaining a report.

Procedure

1. From the Report pull-down menu, select Equipment. A report similar to the
following appears:
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The circuit pack, Hardware ID LAA10B, is listed in this sample Report.

Protection State

Purpose

To view a report that shows the non-preemptible protection access (NPPA) protection-
switching state for the current node. Note that the protection state report is only available

from an FT-2000 OC-48 Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

Procedure

1. From the Report pull-down menu, select Protection State. A report similar to
the following appears:
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Port/Slot Options

Purpose

To provide a list of port and/or line options for the current node. The port/slot options report
is only available from a Network Element View.

As described in the “Report Screen Functions” section earlier in this chapter, a variety of
tasks can be performed on the report, such as saving the report to a file or printing out the

report.

The following port and line options are supported:

•  All DS1 Ports (DDM-2000 OC-3 and FiberReach only)

•  All T1 Ports (FiberReach only)

•  All DS3 Ports (Not applicable to FiberReach)

•  All EC1 Ports (Not applicable to FiberReach)

•  All NCT/2 Ports (DDM-2000 OC-3)

•  All LS Ports (FT-2000 only)

•  All OC-1 Lines (DDM-2000 OC-3 and FiberReach only)

•  All OC-3 Lines

•  All OC-12 Lines (DDM-2000 OC-12 and FT-2000 only)

•  All OC-48 Lines (FT-2000 only)
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Procedure

1. From the Report pull-down menu, select Port/Slot Options. The Port/Slot
Options pull-down menu displays. This menu contains different options,

depending on the current node’s NE type, as shown in the list below.

•  DDM-2000 OC-3: DS1, DS3, EC1, NCT/2, OC1, OC-3, OC-12

•  DDM-2000 OC-12: DS3, EC1, OC-3, OC-12, OC-48

•  FiberReach: DS1, T1, OC1, and OC3

•  FT-2000 OC-48: DS3, EC1, OC-3, OC-12, OC-48, LS

2. Select the appropriate port option. A report similar to the following appears:
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Cross Connections

Overview
CPro-2000 provides the ability to create cross connections from the Network Element View
using the “drag-and-drop” technology. This chapter contains instructions for creating and

deleting individual or ranges of cross connections.

Creating Cross Connections
Drag-and-drop cross-connection creation consists of selecting an available address for a cross
connection, observing an “X” cursor (indicating that you are currently in cross-connection
mode), and dragging the X cursor to the destination address of the cross connection.
Individual, as well as ranges of cross connections, may be entered and deleted using drag-and-

drop methods.

NOTE: If you attempt to enter a cross connection (by selecting a source and dragging the
cross connection to a destination) and no cross connection is established, your destination is
probably incorrect. Check the validity of your cross-connection addresses. In this situation,

CPro-2000 generates an error message in the status bar.

For more specific details on creating cross connections, see the individual procedures in this
chapter associated with each of the following cross-connection types:

•  One-way (FT-2000)

•  Two-way

•  Drop and Continue (DDM-2000
OC-3 and OC-12 supported ring releases)

•  One-way DRI (FT-2000)

•  Two-way DRI (FT-2000)

•  Two-way DRI-PRI (FT-2000)

•  Two-way DRI-SEC (FT-2000)

•  Multi-drop (FT-2000)

•  Locked (DDM-2000 OC-3 and FiberReach)

•  Dual 0x1 (DDM-2000 OC-3, OC-12, and FiberReach)

•  Single 0x1 (DDM-2000 OC-3 and OC-12)
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•  Video Source (DDM-2000 OC-12)

•  Video Sink (DDM-2000 OC-12)

•  Hairpin (DDM-2000 OC-3)

Creating Ranges of Cross Connections

In CPro-2000, you can create a range of VT1.5 cross connections in DDM-2000 OC-3 and
FiberReach NEs. The range of allowable cross-connections can consist of a contiguous group

of addresses, or a noncontiguous group of addresses.

•  To create a  contiguous range of cross connections, select the starting address from
the source addresses then press the Shift  key. While still holding down the Shift key,
click an address at end of the range then release the Shift key. Click the corresponding
starting address in the destinations box  to complete the process. (The source
addresses should be an unbroken group of addresses, such as m-1-1-1, m-1-1-2, m-1-
1-3, and so on.)

•  To create a noncontiguous range of cross connections select the starting address from
the source addresses then press the Ctrl key. While still holding down the Ctrl key,
click the desired addresses. Selected addresses must be in ascending or descending
order, for example, as m-1-1-1, m-1-1-3, m-1-2-1 or as m-1-2-1, m-1-1-3, m-1-1-1.
Click the corresponding starting address in the destinations box  to complete the

process.

NOTE: CPro-2000 R11.0 does not support the creation of ranges of cross connections
(contiguous or noncontiguous) for DDM-2000 OC-12 or FT-2000 OC-48.

For details on allowable cross connections, consult the User Manual for the relevant NE.

Creating Cross Connections on shelves equipped with 29G OLIUs

When the main slots of the DDM-2000 OC-3 R15.x shelf or the FiberReach R4.0 shelf are
equipped with 29G OLIUs CPro-2000 supports cross connections of full STS-3C, STS-1, and

VT granularity.

•  STS-3Cs through cross connections are allowable only when created above the green
line in the GUI.

•  Only Two-Way and Drop and Continue cross connections are allowed.

•  To drop an STS-3C signal on a DDM-2000 OC-3 or FiberReach shelf, the Function
Unit C (fn-c) slot must be equipped with a 22-type OLIU.

•  To drop an STS-3C signal on a DDM-2000 OC-3 shelf, the timeslot must also be
configured in 0x1 mode using the Set OC-3 command in the Provisioning Menu.

For details on allowable cross connections, consult the User Manual for the relevant NE.

The “Network Element View” section of The User Interface chapter provides a detailed
description of the NE view for DDM-2000 OC-3 R15.x and FiberReach R4.0 shelves with

29G OLIU circuit packs in the main slots.

IMA LAN Packs and T1 Repeater Packs

IMA LAN packs have the Apparatus Code BBF9 or BBF10. They occupy two adjacent low-
speed slots on a DDM-2000 OC-3 R15 shelf and are made up of 8 DS1s.  CPro-2000 supports
the same cross connections on an IMA LAN pack as on a DS1 pack, namely end-to-end

locked arc, 2-way, 3 node interworking and 4 node interworking VT cross connections.
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T1 Repeater packs have the Apparatus Code BBF6. For DDM-2000 OC-3 R15.0 and
FiberReach R4.0, CPro-2000 supports the same cross connects on a T1 Repeater pack as on a
DS1 pack, namely end-to-end locked arc, 2-way, 3 node interworking and 4 node

interworking VT cross connections.

Change LocA/LocZ and Roll STS-3 and STS-1 Cross Connections

CPro-2000 can change the source of a cross connection without affecting service by using the
Change LocA/LocZ feature.

In addition, CPro-2000 allows the source of an existing STS-3 or STS-1 cross connection to
be moved, or rolled, to another source without interruption in service.

For more information regarding these features, see the “Change LocA and LocZ Values for an
Existing STS-3 or STS-1 Cross Connection” and “Roll an Existing STS-3 or STS-1 Cross

Connection to a New Source” sections in this chapter.

Audit On and Redline On Options (FT-2000 only)

As you create a cross connection, the Cross-Connection Properties box appears with the Audit

On and Redline On options. When Audit On is chosen, the alarm feature that notifies the user
of any signal problem is activated. When Redline On is chosen, the cross connection is tagged

as “Redlined,” thus prohibiting any modification to it until it is untagged.

To change either setting, double-click on the cross connection in the NE view to display the
Change Loca & Locz dialog box. Either feature can be toggled on/off by clicking on its box to

insert/remove the check mark prior to clicking on OK.

Deleting Cross Connections
To delete a cross connection using the drag-and-drop technology, simply select the cross-
connection line you wish to delete by clicking on it (the X cursor appears), and drag the cross
connection to the trash can icon appearing at the bottom of the Network Element View. You may
also click on the cross-connection line to select it and then press Delete on your keyboard. Any

cross connection that can be entered via the GUI can be deleted via the GUI.

NOTE: While creating and deleting cross connections, you may see that the arrowheads on
the end of a cross connection appear to be lying on their side. The arrowheads are shown like

this when there is not enough space to accommodate the arrowhead pointing straight.

Entering Cross Connections

The following pages show the procedures and screen displays for entering the various types of

cross connections in CPro-2000.
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Enter Two-way STS-1 Cross Connection
(DDM-2000 OC-3 and OC-12)
or

Enter Two-way VT1.5 Cross Connection
(DDM-2000 OC-3 and FiberReach)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The following screen appears when you release the mouse

button:

2. You can click Cancel if the addresses shown in the screen are incorrect,
or click OK and the following screen appears:

3. Click Yes to create the cross connection. You can click No if you do not want to
establish this cross connection or Cancel if you want to cancel the entire

operation.

4. When created, the cross connection appears in the Network Element View as in
the following example:
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Enter Hairpin Cross Connection
(DDM-2000 OC-3)
CPro-2000 supports hairpin cross connections for DDM-2000 OC-3 NEs, where both the
source and the destination of the cross connection are in low-speed slots. Hairpin cross
connections are entered using the same procedure as two-way VT1.5 cross connections

previously described.

Types of hairpin cross connections that are now supported by CPro-2000 include

•  0x1 Intra-Slot Hairpin Cross Connection—between any addresses except different
slots (for example, C-1-1-1 to C-2-1-1, C-1-1-1 to C-2-1-2)

•  0x1 Inter-FN Hairpin Cross Connection—address 1 and address 2 are on different
function units

•  pass through in FN Slot Pair Cross Connection—address 1 and address 2 are the same

NOTE: For information regarding necessary equipage and restrictions for entering hairpin cross

connections, see the Lucent Technologies DDM-2000 OC-3 Multiplexer User/Service Manual.

The following screen depicts the types of hairpin cross connections supported by CPro-2000:
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Enter Single 0x1 STS-1 Cross Connection
(DDM-2000 OC-3 and OC-12)
or

Enter Single 0x1 VT1.5 Cross Connection
(DDM-2000 OC-3)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of

the cross connection.

NOTE: The following restrictions must be followed to create a single 0x1 cross connection:

•  One address in the cross connection must be a main and one address must be a
low-speed slot.

For DDM-2000 OC-3:

—   The low-speed slots must contain a single 27-type OLIU or BBG19

circuit pack.

—   If both slot pairs are equipped, one must be set to in service (IS) and
one must be set to NMON.

For DDM-2000 OC-12:

—   The low-speed slot must contain only one 21-type OLIU circuit pack.

—   The OC-3 line application parameter for the function unit used in the
cross connection must be set to 0x1 for TL1 and MML.

2. The following screen appears when you release the mouse button:

3. You can click Cancel if the addresses shown in the screen are incorrect,
or click OK and the following screen appears:
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4. Click Yes if you want to create the cross connection. Click No if you do not want to
establish this cross connection or Cancel if you want to cancel the entire operation.

5. When created, the cross connection appears in the Network Element View as in
the following example:

NOTE: A single 0x1 cross connection is displayed as a dashed line to differentiate it from the
solid line of a 1+1 two-way cross connection.

Enter Dual 0x1 STS-1 Cross Connection
(DDM-2000 OC-3 and OC-12)
or

Enter Dual 0x1 VT1.5 Cross Connection
(DDM-2000 OC-3)
or

Enter Dual 0x1 STS-3 Cross Connection
(FiberReach equipped with 22-type circuit pack)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of

the cross connection.
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NOTE: The following restrictions must be followed to create a dual 0x1 cross connection:

•  One address in the cross connection must be a main and one address must
be a low-speed slot.

For DDM-2000 OC-3:

—   The low-speed slot must contain two 27-type OLIU or two BBG19

circuit packs in both service and protection slots.

—   The service and protection lines must be set to in service (IS).

For DDM-2000 OC-12:

—   The low-speed slot must contain two 21-type OLIU circuit packs.

— The OC-3 line application parameter for the function unit used in the
cross connection must be set to 0x1 for TL1 and MML.

For FiberReach:

— Must be equipped with 28G-U OLIU circuit pack in the mains and
22-type circuit pack in the function slots.

— The OC-3 line application parameter for the function unit used in the

cross connection must be set to 0x1.

2. The following screen appears when you release the mouse button:

3. You can click Cancel if the addresses shown in the screen are incorrect,
or click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.



CPro-2000 User Manual Release 11.0 Cross Connections ••••  131

5. When created, the cross connection appears in the Network Element View as in
the following example:

NOTE: A dual 0x1 cross connection is displayed as a dashed line to differentiate it from the
solid line of a 1+1 two-way cross connection.

Enter VT1.5 Locked Cross Connections
(DDM-2000 OC-3 and FiberReach)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination low-

speed slot of the cross connection. The following screen appears when you release

the mouse button:

NOTE: The following restrictions must be followed to create a locked cross connection:

•  One address in the cross connection must be a main and one address must be a
low-speed slot.

•  For DDM-2000 OC-3, the low-speed slot must contain a BBF2B MXRVO
circuit pack, a BBG19 circuit pack, or a 26G2-U circuit pack. For DDM-2000
OC-1, the low-speed slot must contain a DS1 circuit pack.
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2. You can click Cancel if the addresses shown in the screen are incorrect.
Otherwise, select the locked cross connection icon from toolbar (icon with

single arrow pointing to the left).

NOTE: The ring direction for the cross connection is specified according to which high-speed
side is involved when establishing the cross connection (m1 side versus m2 side).

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example:

NOTE: A locked cross connection takes up an entire time slot in the NE, although the cross
connection does not actually pass through the time slot in both mains. As shown in the sample
above, the time slot m2-7-2 is grayed out even though it does not contain a cross connection,

indicating it is not available for cross connection.

Enter a Range of Two-way VT1.5 Cross Connections
(DDM-2000 OC-3 and FiberReach)
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NOTE: CPro-2000 R8.0 does not support the creation of ranges of cross connections
(contiguous or noncontiguous) for DDM-2000 OC12, FT-2000 OC-48, or DDM-2000 OC-3

equipped with a 24G-U OLIU circuit pack.

Procedure

1. From the Network Element View, click the source slot of the cross connection.

•  To create a contiguous range (such as m-1-1-1, m-1-1-2, m-1-1-3, and so on)
of cross connections, hold the Shift key on your keyboard, and click on each of
the additional slots, or click on the last slot (the slots in between are
automatically chosen) in your range.

•  To create a noncontiguous range (such as m1-1-1, m-1-1-3, m-1-2-1, and so
on) of cross connections, hold down the Control key and click on each of the
additional slots in the range.

2. Release the Shift or Control key and, while holding down the mouse button,
drag the cursor to the last destination slot of the range of cross connections.

The following screen appears when you release the mouse button:

3. You can click Cancel if the addresses shown in the screen are incorrect,
or click OK and the following screen appears:

4. Click Yes if you want to create the cross connections individually. Click Yes to

All if you want to create the entire range of cross connections in one step. Click
No if you do not want to establish this cross connection or Cancel if you want to

cancel the entire operation.

5. When created, the cross connections appears in the Network Element View as in
the following example:
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Enter Video Source (COV) STS-3C Cross Connection
(DDM-2000 OC-12)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of

the cross connection.

NOTE: The following restrictions must be followed to create a video source cross
connection:

•  One address in the cross connection must be a main and one address must be a
low-speed slot.

•  The low-speed slot must contain a 21-type OLIU circuit pack.

•  The STS-3C feature must be enabled. (This feature is enabled in MML using
the SET-FEAT command (supported by CPro) and in TL1 using the
ENT-FEAT command. See your DDM-2000 OC-12 User Service Manual for
complete details.)

•  The OC-3 Lines application parameter, in the Provision menu, must be set to
video.

NOTE: When choosing the source and destination slots for the cross connection, be sure to
use the STS-3 slots (that is, click and drag to the larger boxes, rather than the smaller STS-1

slots contained within them).

2. The following screen appears when you release the mouse button:
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3. You can click Cancel if the addresses shown in the screen are incorrect.
Otherwise, select the video source cross-connection icon (left icon) from the

toolbar.

4. Click OK and the following screen appears:

5. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

6. When created, the cross connection appears in the Network Element View as in
the following example:
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Enter Video Sink (RTV) STS-3C Cross Connections
(DDM-2000 OC-12)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of

the cross connection.

NOTE: The following restrictions must be followed to create a video source cross

connection:

•  One address in the cross connection must be a main and one address must be a
low-speed slot.

•  The low-speed slot must contain a 21-type OLIU circuit pack.

•  The STS-3C feature must be enabled. (This feature is enabled in MML using
the SET-FEAT command (supported by CPro) and in TL1 using the
ENT-FEAT command. See your DDM-2000 OC-12 User Service Manual for
complete details.)

•  The OC-3 Lines application, in the Provision menu, must be set to video.

NOTE: When choosing the source and destination slots for the cross connection, be sure to
use the STS-3 slots (that is, click and drag to the larger boxes, rather than the smaller STS-1

slots contained within them).

2. The following screen appears when you release the mouse button:

3. You can click Cancel if the addresses shown in the screen are incorrect.
Otherwise, select the Video Sink cross-connection icon (right icon) from the

toolbar.

4. Click OK and the following screen appears:
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5. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

6. When created, the cross connection appears in the Network Element View as in
the following example:

Enter One-way STS-3 or STS-1 Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The following screen appears when you release the mouse

button:
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NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the one-way cross connection icon from the toolbar. If available, you can

also select Source and Destination TIDs from the down-arrow lists.

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for a one-way STS-3 cross connection:
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The following example represents a one-way STS-1 cross connection created by using the same
procedure described above for a one-way STS-3 cross connection:

Enter One-way STS-3 or STS-1 1+1 Protected OC-3 Cross
Connection (FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The following screen appears when you release the mouse

button:
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NOTE: The following screens illustrate the process for establishing an STS-3 one-way 1+1
protected OC-3 cross connection for slot pair 2a/2b. Whichever pair of slots you use must be
provisioned to be OC-3 1+1 protected, through the Provisioning menu, before creating this

type of cross connection.

NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the oneway cross connection icon from the toolbar (single arrow). If
available, you can also select Source and Destination TIDs from the down-arrow

lists.

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for an OC-3 slot pair, 2a and 2b, for 1+1 protection.
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The following example represents a one-way STS-1 1+1 protected OC-3 cross connection created by
using the same procedure described above for a one-way STS-3 1+1 protected OC-3 cross connection:

NOTE: The protection X-Conns are entered automatically by the NE if the 1+1 provisioning
already exists. If the 1+1 provisioning is entered after the cross connection is created, the NE
automatically enters the protection cross connection. CPro-2000 displays the protection cross

connection the next time the cross connections are updated.
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Enter STS-1 Drop-and-Continue Cross Connection
(DDM-2000 OC-3 and OC-12)
or

Enter VT1.5 Drop-and-Continue Cross Connection
(DDM-2000 OC-3)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The following screen appears when you release the mouse

button:

NOTE: The following restrictions must be followed to create a drop-and-continue cross
connection:

•  One address in the cross connection must be a main and one address must be a
low-speed slot.

•  For DDM-2000 OC-3 and OC-12, the low-speed slot being used in the cross
connection must contain an STS-1E or an OLIU circuit pack.

2. You can click Cancel if the addresses shown in the screen are incorrect.
Otherwise, select the drop and continue icon from the toolbar.

3. Click OK and the following screen appears:

NOTE: The ring direction for the cross connection is specified according to which high-speed

side is involved when establishing the cross connection (m1, mb1 side versus m2, mb2 side).
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4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example:

NOTE: The solid portion of the cross connection points in the direction of the ring ID.

Enter a Range of VT1.5 Drop-and-Continue Cross Connections
(DDM-2000 OC-3)

Procedure

1. From the Network Element View, click the source slot of the cross connection.

•  To create a contiguous range (such as m-1-1-1, m-1-1-2, m-1-1-3, and so on)
of cross connections, hold the Shift key on your keyboard, and click on each of
the additional slots, or click on the last slot (the slots in between are
automatically chosen) in your range.

•  To create a noncontiguous range (such as m1-1-1, m-1-1-3, m-1-2-1, and so
on) of cross connections, hold down the Control key and click on each of the
additional slots in the range.

2. Release the Shift or Control key and, while holding down the mouse button,
drag the cursor to the first destination slot of the range of cross connections.

The following screen appears when you release the mouse button:
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NOTE: The following restrictions must be followed to create a range of drop-and-continue

cross connections:

•  One address range in the cross connection must be in a main and one address
range must be in low-speed slots.

3. You can click Cancel if the addresses shown in the screen are incorrect.

Otherwise, select the drop and continue icon from the toolbar.

4. Click OK and the following screen appears:

5. Click Yes if you want to create the cross connections individually. Click Yes to

All if you want to establish the entire range of cross connections in one step.
Click No if you do not want to establish this cross connection or Cancel if you

want to cancel the entire operation.

6. When created, the cross connections appear in the Network Element View as in
the following example:
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Enter One-way STS-3 or STS-1 DRI Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The cross connection must be established in the Add
direction. In other words, the source must be a low-speed slot and the
destination must be a tributary. The following screen appears when you release

the mouse button:

NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.
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2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the DRI icon (third from left-hand side of toolbar). You can also select

the Source and Destination TIDs from the down-arrow lists.

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for a one-way STS-3 DRI cross connection:

NOTE: The primary cross connection is shown with a solid black line, and the secondary
cross connection is shown with a dashed line.
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The following example represents a one-way STS-1 DRI cross connection created by using the same
procedure described earlier for a one-way STS-3 DRI cross connection:

Enter Two-way STS-3 or STS-1 DRI Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The cross connection must be established in the Add
direction. In other words, the source must be a low-speed slot and the
destination must be a tributary. The following screen appears when you release

the mouse button:
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NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the DRI twoway icon (fourth from left-hand side of toolbar). You can

also select the Source and Destination TIDs from the down-arrow lists.

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for a two-way STS-1 DRI cross connection:
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Enter Two-way STS-3 or STS-1 DRI-PRI Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The cross connection must be established in the Add
direction. In other words, the source must be a low-speed slot and the
destination must be a tributary. The following screen appears when you release

the mouse button:

NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the DRI-PRI twoway icon (fifth from left-hand side of toolbar). You can

also select the Source and Destination TIDs from the down-arrow lists.

3. Click OK and the following screen appears:
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4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for a two-way STS-3 DRI-PRI cross connection:

Enter Two-way STS-3 or STS-1 DRI-SEC Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of
the cross connection. The cross connection must be established in the Add
direction. In other words, the source must be a low-speed slot and the
destination must be a tributary. The following screen appears when you release

the mouse button:
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NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the DRI-SEC twoway icon (fifth from left-hand side of toolbar). You can

also select the Source and Destination TIDs from the down-arrow lists.

3. Click OK and the following screen appears:

4. Click Yes if you want to create the cross connection. Click No if you do not
want to establish this cross connection or Cancel if you want to cancel the entire

operation.

5. When created, the cross connection appears in the Network Element View as in
the following example for a two-way STS-3 DRI-SEC cross connection:
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Enter One-way STS-3 or STS-1 Multi-drop Cross Connection
(FT-2000 OC-48)

Procedure

1. From the Network Element View, click the source slot of the cross connection.
While holding down the mouse button, drag the cursor to the destination slot of the

cross connection. The following screen appears when you release the mouse button:

NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

2. You can click Cancel if the AIDs shown in the screen are incorrect. Otherwise,
select the Multi-drop cross connection icon (right-hand side of toolbar). The

following screen appears:
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3. While holding down the Shift key or Control key, select the multiple low-speed
slots for the cross-connection destination. Click OK.

NOTE: Pressing Shift allows a contiguous range of slots to be selected with the mouse.
Pressing Control allows a noncontiguous range to be selected.

4. The Cross Connection Properties box redisplays. Select the Source TIDs from
the down-arrow list. Click OK and the following screen appears:

5. Click Yes if you want to create the multiple cross connections individually.
Click Yes to All if you want to establish all the cross connections in the multi-
drop. Click No if you do not want to establish this cross connection or Cancel if

you want to cancel the entire operation.

6. When created, the cross connection appears in the Network Element View as in
the following example:
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The following example represents a one-way STS-1 multi-drop cross connection created by
using the same procedure described earlier for a one-way STS-3 multi-drop cross connection:

Change LocA and LocZ Values for an Existing STS-3 or
STS-1 Cross Connection (FT-2000 OC-48)

Procedure

1. Double-click the cross-connection line whose LocA and/or LocZ are to be
changed.
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NOTE: When two-way or overlapping multiple cross connections exist, the following screen
appears first:

2. Select the desired cross connection by clicking on the appropriate box. Click
OK.

3. The following dialog box displays:

NOTE: When Audit On is chosen, an alarm is activated to notify the user of any signal
problem. When Redline On is chosen, the cross connection is tagged as “Redlined,” thus
prohibiting any modification until it is untagged. See the “Audit On and Redline On Options”

section earlier in this chapter.

To change either setting, double-click on the cross connection in the NE view to display the
Change Loca & Locz dialog box. Either feature can be toggled on/off from here by clicking

on its box to insert/remove the check mark prior to clicking on OK.

4. Depending on the cross-connection type, the dialog box displays one of the
following:

•  For a drop cross connection, meaning that the cross connection’s source AID
is in a tributary and the destination AID is in a slot, the dialog box appears
prompting changes to LocA. (The down-arrow list for Select New Destination
is grayed-out and not selectable.)

•  For an add cross connection, meaning that the cross connection’s source AID
is in a slot and the destination AID is in a tributary, the dialog box appears
prompting changes to LocZ. (The down-arrow list for Select New Source is
grayed-out and not selectable.)

•  For a pass-through or DRI cross connection, meaning that both the source and
destination AIDs are in tributaries, the dialog box appears prompting changes
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to LocA and/or LocZ. (Both Select New Source and Select New Destination
are available to make changes.)

5. Enter the new LocA and/or LocZ value and click OK. At any time during this
operation, you may click Cancel and none of your changes are executed.

Roll an Existing STS-3 or STS-1 Cross Connection to a
New Source (FT-2000 OC-48)

Procedure

1. Click the left mouse button on the line representing the cross connection for
which you want to roll the source. The line becomes highlighted.

2. Drag the cross-connection line to a new source and then release the mouse
button.

NOTE: When overlapping multiple cross connections exist, the following screen appears
first:

3. Select the desired cross connection by clicking on the appropriate box. Click
OK and the following screen appears:

4. You can change either the cross-connection type or the LocA/LocZ.

NOTE: If the cross connection is a “drop”, the user can change LocA. If the cross connection
is an “add”, then the user can change LocZ. Both can be changed for a through connection.
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Select the cross connection type from the down-arrow list. (The current
cross-connection type is shown as the default.)

Or

Select the LocA/LocZ from the down-arrow list. (The current LocA/LocZ is
shown as the default.)

5. If the information displayed in the dialog box is correct, click Roll and the new
cross connection is created. You may click Cancel at any time and no changes

are made to the cross connection.

Delete a Cross Connection

Procedure

1. From the Network Element View, click the cross-connection line you wish to
delete. Either press Delete on your keyboard or drag the cross-connection line to

the trash can icon located in the bottom right corner of the GUI.

2. The following screen appears asking you to confirm the cross-connection
deletion:

3. Click Yes and the following screen appears:

4. Click Yes to delete the cross connection.

NOTE: If the cross connection to be deleted is part of an end-to-end path, the following
dialog box displays:
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5. Click Yes to delete the entire end-to-end path. Click No to delete only the
selected cross connection or click Cancel if you do not want to delete anything.

NOTE: If the cross connection to be deleted is a two-way DRI-SEC cross connection, the
following screen appears:

NOTE: When overlapping multiple cross connections exist, the following screens appear

during the deletion process:

6. Click OK.

7. Click Yes to delete only the selected cross connection. Click Yes to All to delete
all overlapping multiple cross connections and the following screen appears:
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8. Click Yes to delete all overlapping multiple cross connections.

Delete a Range of VT1.5 Cross Connections
(DDM-2000 OC-3 and FiberReach)

Procedure

1. Select the source range by clicking on the first cross-connection line in the range
and then, while holding down the Shift key, click on the end cross-connection

line of the range.

2. Press Delete or drag the cross-connection lines to the trash can icon located in
the bottom right-hand corner of the GUI.

3. The following screen appears asking the user to confirm the cross-connection
deletion:

4. Click Yes to All if you want to delete all of the cross connections in the range.
Click Yes if you want to delete each cross connection in prompted mode. While
in prompted mode, click No if you do not want to delete one of the cross
connections in the range. Click Cancel if you want to cancel the entire

operation.

5. If you choose to delete multiple cross connections, the following screen appears:

6. Click Yes to delete the selected cross connections. Click No if you do not want
to delete the selected cross connections.
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The Provision Menu

Overview
Use the Provision Menu to display port-provisioning options for a given NE and to modify
these options as needed. All of the port-provisioning functions are provided as menu items and

may vary with NE.

The table below lists all the provisioning options that are available with each network element.

Network Elements

Provisioning

Options

DDM-2000

OC-3

DDM-2000

OC-12

FT-2000 OC-48 FiberReach

DS1/T1 Ports X X

DS3 Lines X X X X

EC1 Ports X X X

LS Ports X

NCT/2 Lines X

OC-1 Lines X X

OC-3 Lines X X X X

OC-12 Lines X X X

OC-48 Lines X

Set Date X X X X

Set OC-3 X X

Set OC-12 X X

Set NE X X X X

Set Security X X

Set Lan X

Set OC-48 X

Set Feat X X X

Set NPPA X

Set CID Secu X
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Update NE X X X X

OSI Stack X X X X

Note: You cannot specify parameter values by typing directly in the value field. To select
parameter values, click the down arrow to the right of the parameter for available options,
then select a value from the list of options.
In situations where Line States can be set, CPro-2000 sets the state to AUTO if the user selects

the IS parameter.

Provisioning OC-12 Line Options
(DDM-2000 OC-3, DDM-2000 OC-12, and FT-2000 OC-48)

Procedure

1. From the Provision pull-down menu, select OC-12 Lines. The following Line
Provisioning dialog box appears for DDM-2000 OC-12 and OC-3.

The DCC Mode parameter allows you to set the DCC to either distinct or
identical.

NOTE: To provision an OC-12 Line from OC-3 or FiberReach shelves, the main slots must
be equipped with 24G or 29G circuit packs.

The following Line Provisioning dialog box displays for FT-2000 OC-48:
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The EQPDEPRPT parameter value displayed in the EC1 Port Provisioning
dialog box corresponds to the value selected FT-2000 OC-48 NE Options dialog
box.  Refer to Provisioning Set NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and FiberReach) for

more information.

2. Choose a line address by clicking on the down arrow to the right of the line
address box. A list of all the OC-12 line addresses for the current node is

displayed. Choose one.

3. Once a line address is selected, you can click Get Value to see how the line is
currently provisioned. If you choose a line address that contains the value “all,”
then the Get Value button is not available because it applies to more than one set

of line-provisioning parameters.

4. To update the values, use the down-arrow list at each text box and select the
appropriate values for each parameter.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning OC-3 Line Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Procedure

1. From the Provision pull-down menu, select OC-3 Lines. The following OC-3
Provisioning dialog box displays for DDM-2000 OC-3 Release 15.0:

The following OC-3 provisioning dialog box displays for FiberReach Release
4.0:

NOTE: To provision an OC-3 Line from FiberReach shelf, the shelf must be equipped with a

28G circuit pack.

The following OC-3 provisioning dialog box displays for DDM-2000 OC-12,
ring releases only:
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The following OC-3 Provisioning dialog box displays for FT-2000:

NOTE: For more information on how to provision OC-3 Lines from an FT-2000, see the
Provisioning OC-48 Line Options

(FT-2000 OC-48) section of this chapter.

2. Choose a line address or AID by clicking on the down arrow to the right of the
line address or AID box. A list of all OC-3 line addresses or AIDs for the

current node is displayed. Choose one.

3. Once a line address is chosen, click Get Value to see how the line is currently
provisioned. If a line address or AID is chosen that contains the value “all,” then
the Get Value button is not available because it applies to more than one set of

line-provisioning parameters.
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4. To update values, use the down-arrow list at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning DS3 Port Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Procedure

1. From the Provision pull-down menu, select DS3 Ports. The following DS3
Provisioning dialog box appears for DDM-2000:

The following DS3 Provisioning dialog box appears for FT-2000:
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NOTE: The EQPDEPRPT parameter value displayed in the EC1 Port Provisioning dialog
box corresponds to the value selected in the FT-2000 OC-48 NE Options dialog box.  Refer to
Provisioning Set NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and FiberReach) for more

information.

2. Choose a port address or AID by clicking on the down arrow to the right of the
port address or AID box. A list of all DS3 port addresses or AIDs for the current

node is displayed. Choose one.

3. Once a port address or AID is chosen, you can click Get Value to see how the
port is currently provisioned. If a port address or AID is chosen that contains the
value “all,” then the Get Value button is not available because it applies to more

than one set of port-provisioning parameters.

4. To update values, use the down-arrow list at each text box and choose the

appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning EC1 Port Options
(DDM-2000 OC-3, DDM-2000 OC-12, and FT-2000 OC-48)

Procedure

1. From the Provision pull-down menu, select EC1 Ports. The following dialog
box displays for a DDM-2000 OC-3 or DDM-2000 OC-12 (provided that there

is at least one STS-1E circuit pack in the current node):
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The following dialog box appears for an FT-2000:

NOTE: The PDIPSW parameter dictates system reaction to a payload defect. If PDIPSW is
disabled, no switching occurs in the event of a payload defect. If PDISW is enabled,

switching occurs, with a minor alarm, when a payload defect is detected.

The EQPDEPRPT parameter value displayed in the DS3 Port Provisioning dialog box
corresponds to the value selected FT-2000 OC-48 NE Options dialog box.  Refer to
Provisioning Set NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and FiberReach) for more

information.

2. Choose a port address or AID by clicking on the down arrow to the right of the
port address or AID box. A list of all EC-1 port addresses or AIDs for the

current node is displayed. Choose one.

3. Once a port address or AID is chosen, click Get Value to see how the port is
currently provisioned. If a port address or AID is chosen that contains the value
“all,” then the Get Value button is not available because it applies to more than

one set of port-provisioning parameters.
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4. To update values, use the down-arrow list at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning Set Date Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Purpose

To display and/or modify the current date and time of the NE.

Procedure

1. From the Provision pull-down menu, select Set Date. The following dialog box
displays:

2. Click Get Value to see the current settings.

3. To modify the settings, type over them with the desired values and click
Set Value.

Provisioning Set NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Purpose

To set options for the current NE, depending on the NE type.

Procedure

1. From the Provision pull-down menu, select Set NE. One of the following

screens appears, depending on the NE type.

A screen similar to the following appears for DDM-2000 OC-3:
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NOTE: Alarm Group and AGNE are only available when RneStat is set to “enabled.”

A screen similar to the following appears for FiberReach:

NOTE: Alarm Group and AGNE are only available when RneStat is set to
“enabled.”
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A screen similar to the following appears for DDM-2000 OC-12:

A screen similar to the following appears for FT-2000:

NOTE: For FT-2000, you use the EQPDEPRPT parameter to set the Equipage Dependent
Report. Set this parameter to "enable" if you want a report on all pre-provisioning
information. Set EQPDEPRPT to "disable" for information based on equipage. CPro-2000
displays the selected status in the provision dialog boxes of: DS3 Port, EC1 Port, OC-3 Line,

and OC-12 Line.

2. On the screen that appears for your NE type, click Get Values to display how
the node is currently configured.

3. Using the down-arrow lists, select the options appropriate for the node you are
configuring.

4. Click Set Values to activate the new NE options.

CAUTION: Clicking on Set Values after changing the values of certain parameters will
cause the NE to reset. This temporarily halts the communication between CPro-2000 and the
NE. CPro-2000 displays a message box describing the situation. When the reset is complete,
click OK in the dialog box. CPro-2000 then attempts to establish communication with the

NE.

If you are logged off the node, try to reconnect to the node through the AUI. If
you are unable to reconnect through the AUI, close the subnetwork from the
GUI, select New Subnetwork from the Access Menu, then enter the UserID and

Password in the Login window.
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5. Click Close at any time to end the session. If you close the session before
clicking on Set Value, your changes will not be saved.

Provisioning Update NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Purpose

Updates the system database on the NE to reflect the existing hardware configuration and
incoming signals. This menu item is not available for all NEs.

Procedure

From the Provision pull-down menu, select Update NE and the system database
is updated.

Provisioning OSI Parameters
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and
FiberReach)

Procedure

1. From the Provision pull-down menu, select OSI Stack and then select Layer 3

or Layer 4.

CAUTION: Changing some Layer 3 parameters such as “L3Area” affects DCC connectivity.
If connectivity is interrupted, check the Software Release Description or the ReadMe file for

information on how to reestablish connection.

The following dialog box displays for Layer 3:
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The following dialog box displays for Layer 4:

2. Click Get Value to see the current settings.

3. To modify the settings, type over them with the desired values and click
Set Value.
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NOTE:

Some parameters are read-only and cannot be changed. See the appropriate Lucent

Technologies User/Service Manual for further details and acceptable values.

Provisioning OC-3 Line Options
(For FT-2000 OC-48 Only)

The FT-2000 Provision Menu

Procedure

1. From the Provision pull-down menu, select OC-3 Lines. The OC-3 Line
Provision dialog box appears.



CPro-2000 User Manual Release 11.0 The Provision Menu ••••  175

The EQPDEPRPT parameter value displayed in the OC-3 Line Provisioning
dialog box corresponds to the value selected in the FT-2000 OC-48 NE Options
dialog box.  Refer to Provisioning Set NE Options
(DDM-2000 OC-3, DDM-2000 OC-12, FT-2000 OC-48, and FiberReach) for

more information.

2. Choose a low speed slot by clicking on the down arrow to the right of the LINE

AID field. A list of all the OC-3 Line AIDs for the current node is displayed.

Choose one. Get Value is enabled.

3. Click the Sync Message down arrow for a listing of all available sync message
parameters.

NOTE: About S1 and K2 – although these two parameters are available for provisioning
OC-3 Lines from an FT-2000 OC-48, make sure that you are consistent with your selection
throughout the entire network. For example, if you select S1, S1 must be used throughout that

network.

4. Click Get Value to see how the line is currently provisioned. Note that choosing
the default Line AID – Is-all – disables the Get Value button, as it applies to

more than one set of line-provisioning parameters.
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Notice that the EQPDEPRT parameter is listed as disabled. This parameter enables or
disables the Equipage Dependent Reports and can be set using the Set NE command from the

Provision Menu.

5. To update the values, use the down-arrow list at each text box and select the
appropriate values for each parameter.

6. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning OC-48 Line Options
(FT-2000 OC-48)

Procedure

1. From the Provision pull-down menu, select OC-48 Lines. The following Line
Provisioning dialog box appears.
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2. Choose a Line AID by clicking on the down arrow to the right of the Line AID
box. A list of all the OC-48 line AIDs for the current node is displayed. Choose

one.

3. Once a line address is selected, you can click Get Value to see how the line is
currently provisioned. If a line address is chosen that contains the value “all,”
then the Get Value button is not available because it applies to more than one set

of line-provisioning parameters.

4. To update the values, use the down-arrow list at each text box and select the

appropriate values for each parameter.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning LS Port Options
(FT-2000 OC-48)

Procedure

1. From the Provision pull-down menu, select LS Ports. The following dialog box
displays (provided that there is at least one low-speed circuit pack in the current

node):
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2. Choose a port AID by clicking on the down arrow to the right of the port AID
box. A list of all port AIDs for the current node is displayed. Choose one.

3. Once a port AID is chosen, click Get Value to see how the port is currently
provisioned. If a port AID is chosen that contains the value “all,” then the Get
Value button is not available because it applies to more than one set of port-

provisioning parameters.

4. To update values, use the down-arrow list at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning Set NPPA Options
(FT-2000 OC-48)

Purpose

To display and/or modify the current value for NPPA. The NPPA can be applied to either
direction and will affect the whole ring.

Procedure

1. From the Provision pull-down menu, select Set NPPA. The following dialog
box displays:

NOTE: If an STS-3 AID is selected, the Get Value button is disabled. The Get Value button
is enabled only when an STS-1 address is selected.

2. Choose the AID by clicking on the down arrow to the right of the AID box. A
list of all the AIDs for the current node is displayed. Choose one.

3. Once an AID is selected, you can click Get Value to see how the AID is
currently provisioned. If a line address is chosen that contains the value “all,”
then the Get Value button is not available because it applies to more than one set

of line-provisioning parameters.

4. To update the value, use the down-arrow list and select the appropriate value.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning Set CID Secu Options
(FT-2000 OC-48)

Purpose

To display and/or modify the settings for the current port or to change the DTE port. Also to

change the protocol back to CIT.

CAUTION: Improper setting of this parameter will interrupt communications.

Procedure

1. From the Provision pull-down menu, select Set CID Secu and then select DCE

or DTE.

The following dialog box displays for DCE:

The following dialog box displays for DTE:

2. Click Get Value to see the current settings.

3. To update the value, use the down-arrow list and select the appropriate value.

4. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning Set Feat Options
(DDM-2000 OC-3 and DDM-2000 OC-12)

Purpose

To display and/or modify the current settings for OC-3 VTPM, OC-3 DS1PM, and OC-12

STS-3C parameters.

Procedure

1. From the Provision pull-down menu, select Set Feat. The following dialog box
displays for OC-3:

The following dialog box displays for OC-12 STS-3C:

2. Click Get Value to see the current settings.

3. To update the value, use the down-arrow list and select the appropriate value.

4. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning DS1 Ports
(DDM-2000 OC-3)

Procedure

1. From the Provision pull-down menu, select DS1 Ports. The following dialog
box displays:

2. Choose a port address by clicking on the down arrow to the right of the port
address box. A list of all DS1 port addresses for the current node is displayed.

Choose one.

3. Once a port address is chosen, click Get Value to see how the port is currently
provisioned. If a port address is chosen that contains the value “all,” then the Get
Value button is not available because it applies to more than one set of port-

provisioning parameters.
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For a DS1 circuit pack, the following screen appears:

For a DS1 circuit pack with performance monitoring or a T1EXT pack, the
following screen appears:
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For IMA LAN packs, the following screen appears:

4. To update values, use the down-arrow lists at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.

Provisioning NCT/2 Line Options
(DDM-2000 OC-3)

Procedure

1. From the Provision pull-down menu, select NCT/2 Lines. The following dialog
box displays:
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2. Choose a line address by clicking on the down arrow to the right of the line
address box. A list of all NCT/2 line addresses for the current node is displayed.

Choose one.

3. Once a line address is chosen, click Get Value to see how the line is currently
provisioned. If a line address is chosen that contains the value “all,” then the Get
Value button is not available because it applies to more than one set of line-

provisioning parameters.

4. To update values, use the down-arrow list at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning OC-1 Line Options
(DDM-2000 OC-3 and FiberReach)

Procedure

1. From the Provision pull-down menu, select OC-1 Lines. The following OC-1

Provisioning dialog box displays for DDM-2000:

The following OC-1 Line provisioning dialog box displays for FiberReach:

2. Choose a line address by clicking on the down-arrow to the right of the line
address box. A list of all OC-1 line addresses for the current node is displayed.

Choose one.

3. Once a line address is chosen, click Get Value to see how the line is currently
provisioned. If a line address is chosen that contains the value “all,” then the Get
Value button is not available because it applies to more than one set of line-

provisioning parameters.

4. To update values, use the down-arrow list at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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Provisioning Set Lan
(DDM-2000 OC-3 Release 15.0

Purpose

To provide LAN (Local Area Network) connectivity between networks in different locations.

Procedure

1. From the Provision pull-down menu, select Set LAN.

The following screen appears for DDM-2000 OC-3 Release 15.0:

2. Click Get Value to display how the node is currently configured.
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3. Use the down-arrow lists to select the options appropriate for the node you are
configuring.

NOTES:

•  The LAN Address “all” is not vailid in TL1 mode.

•  If cross connects are present in the network, values for Group ID and Length are not
changeable.

4. Click Set Value to activate the new security options.

5. Click Close at any time to end the session. If you close the session before
clicking on Set Value, your changes will not be saved.
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Provisioning Set Security
(DDM-2000 OC-3 Release 15.0 and
FiberReach Release 4.0)

Purpose

To conveniently provision port security and to configure the front and rear CIT from CIT
(MML) to TL1 and back again from within a CPro session. From this window, users can to
any of the following change the port configuration from MML mode to TL1 and back to TL1

without exiting a CPro-2000 session.

Procedure

1. From the Provision pull-down menu, select Set Security.

The following screen appears for DDM-2000 OC-3 Release 15.0 and
FiberReach Release 4.0:

NOTE: Although the Set Security screen for DDM-OC3 R15.0 and FiberReach R4.0 appear
identical, the Address options differ as shown below:

Address options for DDM-OC3 R15.0:

Address options for FiberReach R4.0:
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2. Click Get Value to display how the node is currently configured.

NOTES:

•  Available parameters depend on settings for Address and Port Type. For example,
The Baud Rate and Echo parameters are unavailable when the Port Type is set to CIT.

The Security parameter is also unavailable when the Port Type is set to TL1.

•  A Port Type of CIT indicates MML.

•  Only one port can be configured for TL1 at any given time.

•  For FiberReach Release 4.0, the Address value “dcc-all” is not a valid option for TL1.

3. Use the down-arrow lists to select the options appropriate for the node you are
configuring.

4. To change the interface language, click the Port Type down arrow then select
the desired mode.
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5. Click Set Value to activate the new security options.

CAUTION: Clicking on Set Values after changing the Port Type parameter causes the NE to
reset. This temporarily halts the communication between CPro-2000 and the NE. CPro-2000
displays a series of message boxes describing the situation. Carefully read and follow the
instructions in each message box. When the reset complete, click OK in the dialog box. CPro-

2000 will attempt to re-establish communication with the NE at this point.

If you are logged out of the node, reconnect to the node through the AUI. If you
are unable to reconnect through the AUI, close the subnetwork from the GUI,
select New Subnetwork from the Access Menu, then enter the UserID and

Password in the Login window.

6. Click Close at any time to end the session. If you close the session before
clicking on Set Value, your changes will not be saved.
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Provisioning T1 Ports
(FiberReach)

Procedure

1. From the Provision Pull-down menu, select T1 Ports. The following dialog box

displays

2. Choose a port address by clicking on the down arrow to the right of the port
address box. A list of all T1 port addresses for the current node is displayed.

Choose one.

3. Once a port address is chosen, click Get Value to see how the port is currently
provisioned. If a port address is chosen that contains the value “all,” then the Get
Value button is not available because it applies to more than one set of port-

provisioning parameters.

4. To update values, use the down-arrow lists at each text box and choose the
appropriate values for each option.

5. Click Set Value to activate the new provisioning options. You can click Close at
any time to end the provisioning session. If you close the session before clicking

on Set Value, no changes will be made.
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The Update Menu

Overview
From a Network Element View, you can update the following information in CPro-2000
using the Update Menu:

•  Inventory

•  X-Conn

•  Alarm

•  Active User

From the Subnetwork View, you can update the following information in CPro-2000 using
the Update Menu:

•  Update Map

•  Update Inventory

These menu items are detailed in the following procedures.

Inventory (NE View)

Purpose

To retrieve the NE equipage and update the Network Element View accordingly. CPro-2000
maintains all information relating to the Update Inventory command in a temporary data
location. When the Update Inventory command is completed successfully, the Network

Element View is redisplayed.

This menu item is only available from a Network Element View.

Procedure

1. From the Update pull-down menu, select Inventory. The current NE's inventory
is updated and the Network Element View is redisplayed.
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X-Conn (NE View)

Purpose

To retrieve the NE cross connections and update a Network Element View by displaying the
current cross connections. CPro-2000 maintains all information relating to the Update
X-Conn command in a temporary data location. When the Update X-Conn command is
completed successfully, the information is moved to the data cache and the Network Element

View is redisplayed.

This menu item is only available from a Network Element View.

Procedure

1. From the Update pull-down menu, select X-Conn. If cross connections exist in
the current NE, the NE View is updated to show the current cross connections.

Alarm (NE View only)

Purpose

To update and display the alarm state for the current NE.

Procedure

1. From the Update pull-down menu, select Alarm. The current NE's alarm state is
updated, thereby redisplaying the alarm status in the lower, left-hand corner of

the GUI window.

Active User

Purpose

To retrieve and display information about users who are logged into an NE.

Procedure

1. From the Update pull-down menu, select Active User. The following form

appears.

2. Click Refresh to update active user information. You can click Close at any
time to close the form.
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Map (Subnetwork View)

Purpose

To update the Subnetwork View by retrieving the topology from all the nodes in the selected
partition. This menu item is only available from the Subnetwork View.

Procedure

1. From the Update pull-down menu, select Update Map. The Subnetwork View
is updated with the topology of the current partition.

Inventory (Subnetwork View)

Purpose

To retrieve the equipage, cross connections, and partition topology from all the nodes in the
selected partition. When the Update Inventory command is completed successfully, the

Subnetwork View is redisplayed.

This menu item is only available from the Subnetwork View.

Procedure

1. From the Update pull-down menu, select Update Inventory. See the
“Partitioning” section in the CPro-2000 Startup chapter for specific details on a

Partition Inventory and its contents.
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The Window Menu

Overview
The Window Menu allows the user to have a more flexible environment in which to use
CPro-2000. This menu gives the user the capability of changing how the information is

presented on the screen. The Window Menu commands include the following features:

•  Cascade

•  Tile-Horizontal

•  Tile-Vertical

•  Arrange Icons

•  Window Toggle
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Cascade

Purpose

To display the open windows on the CPro-2000 GUI in a cascade format.

Procedure

1. From the Window pull-down menu, select Cascade. The open windows are
displayed as shown in the following screen:
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Tile-Horizontal

Purpose

To display the open windows on the CPro-2000 GUI in a horizontal format.

Procedure

1. From the Window pull-down menu, select Tile-Horizontal. The open windows
are displayed as shown in the following screen:
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Tile-Vertical

Purpose

To display the open windows on the CPro-2000 GUI in a vertical format.

Procedure

1. From the Window pull-down menu, select Tile-Vertical. The open windows are
displayed as shown in the following screen:
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Arrange Icons

Purpose

To arrange all iconified windows in an orderly fashion in the CPro-2000 GUI window.

Procedure

1. From the Window pull-down menu, select Arrange Icons. All iconified
windows, including both Network Element Views and the Subnetwork View,

are arranged in an orderly fashion as shown in the following screen:
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Window Toggle

Purpose

This feature allows the user to toggle easily between any open and iconified windows in the
CPro-2000 GUI.

Procedure

1. At the bottom of the Window pull-down menu, the names of any open or
iconified windows are displayed. Click on your selection. If the window is open,
it appears in front of any other windows. If the window is iconified, it is opened

and displayed in front of any other open windows.
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The End-to-End Path Menu

Overview
The End-to-End Path Menu is available when the cursor is pointing to an unexpanded
partition in a Subnetwork View and you press the right mouse button, or from the menu bar at

the top of the CPro-2000 GUI.

NOTE: End-to-end paths cannot be created in linear configurations or rings containing an
unsupported NE.

There are many different environments in which end-to-end paths are commonly created. In
the simplest situation, the traffic originates and terminates within a ring. Frequently, however,

traffic is routed over a complex multi-ring environment.

CPro-2000 can be used to create and validate several types of end-to-end paths, as well as
modify the LocA and/or LocZ values in an existing STS-3 or STS-1 path in an FT-2000 OC-48.

CPro-2000 supports the following path types:

•  two-endpoint end-to-end path, including ring transport service, across a single ring

•  video service at an STS-3C signal rate in a single ring (DDM-2000 OC-12 only)

•  locked path at a VT1.5 signal rate in a single ring (DDM-2000 OC-3 and FiberReach
only)

In creating end-to-end VT cross connects, CPro-2000 makes cross connects at every node in
the DDM-2000 ring. At the two add/drop nodes, CPro-2000 always makes a VT cross
connect. However, at the through nodes, CPro-2000 can make either an STS or VT through

cross connects depending on the types of optical packs in the main.

Equipping the main slots of a DDM-2000 OC-3 or a FiberReach shelf with 24G type OLIUs
allows the shelf to transmit at an OC-12 rate. Instead of VT cross connects, CPro-2000 makes
through cross connects as STS-1. Note, however, that the 24G type OLIU is restricted to
making VT cross connects in 3 of the 12 STS's, allowing the ring to use more of the limited

VT bandwidth for VT drops.

Equipping the main slots of a DDM-2000 OC-3 or a FiberReach shelf with 29G type OLIUs
allows the shelf transmit at an OC-12 rate. CPro-2000 supports full STS-3C, STS-1, and VT
cross connects with this shelf configuration. Note, however, that STS-3C cross connections
can be created only if the Function Unit C (fn-c) is equipped with a 22-type OLIU. Unlike
24G OLIUs, the NE equipped with 29G OLIUs can make through cross connections with VT

granularity.
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End-to-end paths can be established only after taking a Partition Inventory. However, with an
FT-2000 OC-48, the user may enter end-to-end paths between nodes that have open Network

Element Views and have had individual NE inventories from the Update Menu.

To create an end-to-end path within a subnetwork, you are prompted through a simple
sequence of on-line forms. Once the path addresses have been chosen, CPro-2000 creates the

cross connections in the NEs to form the end-to-end path.

Users creating end-to-end paths with CPro-2000 should be familiar with the procedures
outlined in the user service manuals for the NE equipment. The procedures in this manual are
not a substitute for the user's skill and understanding of the process involved with creating
paths in NEs. In fact, neither this manual nor CPro-2000 provide the test procedures necessary
to verify the proper functioning of a newly created path. You must implement the test

procedures from the appropriate user service manuals.

NOTE: No changes are made to any NE until the user has chosen OK. Therefore, the user
can cancel the operation or clear the current information at any time prior to clicking the OK

button.

Two-Endpoint End-to-End Path Across a Single Ring
Setting up a two-endpoint end-to-end path around a single ring using CPro-2000 is
accomplished by accessing the End-to-End Path Menu while in the Subnetwork View.

NOTE: The procedures in this section also apply to paths created in open rings, which may
only contain one endpoint.

A form appears prompting the selection of the signal rate and path type. The selection of these
two options dynamically changes the form to reflect the information needed to create that
specific type of path. CPro-2000 supports the following types of two-endpoint end-to-end

paths across a single ring:

•  VT1.5 Two-way/Ring Transport (DDM-2000 OC-12, OC-3, and OC-12/OC-3 mixed
ring when OC-3 is equipped with 24G-U or 29G-U OLIU, and FiberReach)

•  VT1.5/T1 Two-way (FiberReach)

•  STS-1 Two-way/Ring Transport (DDM-2000 OC-12, OC-3, and OC-12/OC-3 mixed
ring when OC-3 is equipped with 24G-U or 29G-U OLIU)

•  STS-3C Two-way (DDM-2000 OC-12 and OC-12/OC-3 mixed ring when
OC-3 is equipped with 24G-U or 29G-U OLIU)

•  STS-3 Two-way (FT-2000 OC-48)

•  STS-3 One-way (FT-2000 OC-48)

•  STS-1 Two-way (FT-2000 OC-48)

•  STS-1 One-way (FT-2000 OC-48)

The procedures following this section provide specific instructions on creating the various
types of two-endpoint end-to-end paths across a single ring. For each type of path, one sample
is provided. Please note that there may be some minor differences from the samples,

depending on the NE type.

NOTE: If the path being configured is a ring with linear extensions, the path around the ring
and the individual linear extension cross connections are created separately.

See the following figure for a generic illustration of a two-endpoint two-way end-to-end path
across a single ring in a subnetwork containing FT-2000 OC-48 NEs.
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Ring Transport Service
In Ring Transport Service, the NEs in one ring are used to provide service for NEs in another
ring. One ring is at a higher signal rate than the other ring. The function units in one or two of
the NEs in the ring with the higher signal rate connect to the mains of one or two NEs in the
ring with the lower signal rate. Since connectivity is established through the mains, the
connection is always optical. The ring at the higher signal rate is called the parent, and it is
this ring that provides the transport for the other ring (shown as Ring 1 in the following
illustration). The other ring, the child ring, is incomplete without the parent ring, because the
fibers in the child ring do not form a complete circle on their own. This is known as an open

ring. Ring Transport Service is applicable to the following configurations:

•  FT-2000 OC-48 can provide transport to a DDM-2000 OC-3 ring.

•  DDM-2000 OC-3 can provide transport to a FiberReach ring.

•  DDM-2000 OC-12 can provide dual- and single-homed transport to a DDM-2000
OC-3 ring.

The following sample illustration shows two NEs in the parent ring connected to two NEs in
the child ring. This is called dual-homing. Single-homing is when the function unit of one NE

in the parent ring is connected to two mains in the child ring.
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There are special cross connections for the parent ring of a DDM-2000 parent ring, called
dual and single 0x1 cross connections. These cross connections only exist in the parent ring,
never in the child ring. A single 0x1 cross connection puts the signal on one rotation in the

parent ring. A dual 0x1 cross connection puts the signal on both rotations of the parent ring.

NOTE: To create a Ring Transport Service path in a DDM-2000 OC-12 (as differentiated
from a regular two-endpoint path), the OC-3 line application parameter must be set to 0x1 in
all of the nodes in the parent ring. This parameter is set using the Provisioning Menu. There is
no special parameter setting in order to create a Ring Transport Service path in a DDM-2000

OC-3 or FT-2000 OC-48 parent ring.
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Enter a VT1.5 Two-way/Ring Transport Service
End-to-End Path (DDM-2000 OC-3, FiberReach, and
DDM-2000 OC-3/OC-12 mixed ring when OC-3 is
equipped with 24G-U or 29G OLIU circuit pack)

 

NOTE: The following restrictions must be met to create a VT1.5 Ring Transport Service path
(and not a regular two-way path):

•  Only the FiberReach ring can be the child ring.

•  A low-speed slot of the add/drop nodes must contain a 27-type OLIU circuit pack.

Procedure

1. From the Subnetwork View, select the End-to-End Path pull-down menu (or
click the right mouse button and select End-to-End from the pop-up menu) and
then select Enter. The following form appears. Only valid signal rates and path
types are available for selection. Click the tabs for VT1.5 signal rate and

Twoway/Ring Transport.

2. Near the bottom of the form in the dialog box, you are prompted to choose an
add/drop node. Double-click the desired node displayed within the form. The

following screen appears:
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3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:
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5. You are prompted to select the next add/drop node. Double-click the desired
node. The following screen appears:

6. Select the low-speed slot for this add/drop node. Click OK. The main end-to-
end path form appears:
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7. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.

8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The following screen shows a graphical representation of the newly created end-
to-end path.
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Enter a VT1.5/T1 Two-way End-to-End Path (FiberReach)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for VT1.5/T1 signal rate and Twoway path type.
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2. At the bottom of the form in the dialog box, you are prompted to choose the first
add/drop node. Double-click the desired node displayed within the form. The

following screen appears:

3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:
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5. You are prompted to choose a second add/drop node (for creating a multi-drop
path), or to create the end-to-end path. When ready to create the path, click OK.

The following screen appears:

6. Click No if you do not want to create the end-to-end path (none of your

selections will be implemented). If you want to proceed, click Yes.

7. When your path has been successfully completed, the following screen appears.
Click OK.
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8. The following screen shows a graphical representation of the newly created end-
to-end path.

Enter an STS-1 Two-way/Ring Transport Service
End-to-End Path (DDM-2000 OC-12, OC-3, and OC-12/OC-3
mixed ring when OC-3 is equipped with 24G-U or 29G
OLIU)

NOTE: To create a Ring Transport Service path (and not a regular two-way path), the
following restrictions must be met:

•  Only a DDM-2000 OC-3 ring can be the child ring (so the Ring Transport Service
path is being created in the DDM-2000 OC-12 ring).

•  A low-speed slot in the add/drop nodes of the parent ring must contain a 21-type
OLIU circuit pack.

•  The OC-3 line application parameter must be set to 0x1 for all nodes in the parent
ring. This is set in the Provision Menu.

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS1 signal rate and Twoway/Ring Transport.
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2. Near the bottom of the form in the dialog box, you are prompted to choose an
add/drop node. Double-click the desired node displayed within the form. The

following screen appears:

3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:



216 ••••  The End-to-End Path Menu CPro-2000 User Manual Release 11.0

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. You are prompted to select the next add/drop node. Double-click the desired

node. The following screen appears:
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6. Select the low-speed slot for this add/drop node. Click OK. The main end-to-

end path form appears:

7. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.
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8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The following screen shows a graphical representation of the newly created end-
to-end path.

Enter an STS-3C Two-way End-to-End Path
(DDM-2000 OC-12 and OC-12/OC-3 mixed ring when
OC-3 is equipped with 24G-U or 29G OLIU)
NOTE: For the STS-3C path type to be available, the following restrictions must be followed:

•  A low-speed slot in the add/drop nodes must contain a 21-type OLIU circuit pack.

•  The OC-3 line application parameter must be set to 1+1 for each add/drop node in the
ring. This is set in the Provision Menu.

•  For shelves equippped with 29G OLIUs the Function Slot C (fn-c) must be equipped
with a 22-type OLIU.

•  The STS3-C feature must be enabled for each node in the ring. (This feature is
enabled in MML using the SET-FEAT command (also available in the Provision
Menu) and in TL1 using the ENT-FEAT command. See your DDM-2000 OC-12

User/Service Manual for complete details.)
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On a DDM-2000 OC3 shelf equipped with the 29G OLIU, CPro-2000 R11.0
supports setting the OC-3 line application parameter to 0x1.

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS3C and Twoway path type.

2. At the bottom of the form in the dialog box, you are prompted to choose the first
add/drop node. Double-click the desired node displayed within the form. The

following screen appears:

3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
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cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. You are prompted to select the next add/drop node. Double-click the desired
node. The following screen appears:
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6. Select the low-speed slot for this add/drop node. Click OK. The main end-to-
end path form appears:

7. If the information you have selected is correct, click OK to create the end-to-end

path and the following screen appears.

8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.
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9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The screen below shows a graphical representation of the newly created end-to-
end path.

Enter an STS-3 Two-way End-to-End Path
(FT-2000 OC-48)

Procedure

1. From the Subnetwork View, select the End-to-End Path pull-down menu (or
click the right mouse button and select End-to-End from the pop-up menu) and
then select Enter. The following form appears. Only valid signal rates and path
types are available for selection. Click the tabs for STS3 signal rate and 2WAY

path type.
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2. At the bottom of the form in the dialog box, you are prompted to choose the first
add/drop node. Double-click the desired node displayed within the form. The

following screen appears:

3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:
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4. Select the tributary that the end-to-end path will follow around the ring. Only
valid tributary numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. You are prompted to choose a second add/drop node. Double-click the desired
node. The following screen appears:
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6. Select the low-speed slot for this add/drop node. Click OK. The main end-to-
end path form displays:

7. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.
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8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The screen below shows a graphical representation of the newly created end-to-
end path.

Enter an STS-3 One-way End-to-End Path
(FT-2000 OC-48)

Procedure

1. From the Subnetwork View, select the End-to-End Path pull-down menu (or
click the right mouse button and select End-to-End from the pop-up menu) and
then select Enter. The following form appears. Only valid signal rates and path
types are available for selection. Click the tabs for STS3 signal rate and 1WAY

path type.
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2. At the bottom of the form in the dialog box, you are prompted to choose an add
node. Double-click the desired node displayed within the form. The following

screen appears:

3. Select the low-speed slot to be used for this add node. Note that only valid slot
addresses are displayed. The Cancel button can be clicked at any time to cancel
the operation. If the slot you have chosen is correct, click OK. The following

screen appears:
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4. Select the tributary that the end-to-end path will follow around the ring. Only
valid tributary numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. You are prompted to choose the drop node. Double-click the desired node. The
following screen appears:
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6. Select the low-speed slot for this drop node. Click OK. The main end-to-end

path form displays:

7. You are prompted to choose another drop node (for creating a multi-drop path),
or to create the end-to-end path. When ready to create the path, click OK. The

following screen appears.
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8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The screen below shows a graphical representation of the newly created end-to-
end path:
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Enter an STS-1 Two-way End-to-End Path (FT-2000 OC-48)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS1 signal rate and 2WAY path type.

NOTE: When the Audit On box is checked, the alarm feature that notifies the user of any
signal problem is activated. To turn off this feature, click the box to remove the check mark.

2. At the bottom of the form in the dialog box, you are prompted to choose the first
add/drop node. Double-click on the desired node displayed within the form. The

following screen appears:
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3. Select the low-speed slot to be used for this add/drop node. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:

4. Select the tributary that the end-to-end path will follow around the ring. Only
valid tributary numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. You are prompted to choose a second add/drop node. Double-click the desired
node. The following screen appears:
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6. Select the low-speed slot for this add/drop node. Click OK. The main end-to-
end path form displays:

7. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears:
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8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The screen below shows a graphical representation of the newly created end-to-
end path.

Enter an STS-1 One-way End-to-End Path
(FT-2000 OC-48)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS1 signal rate and 1WAY path type.
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NOTE: When the Audit On box is checked, the alarm feature, which notifies the user of any
signal problem, is activated. To turn off this feature, click the box to remove the check mark.

2. At the bottom of the form in the dialog box, you are prompted to choose an add
node. Double-click the desired node displayed within the form. The following

screen appears:

3. Select the low-speed slot to be used for this add node. Note that only valid slot
addresses are displayed. The Cancel button can be clicked at any time to cancel
the operation. If the slot you have chosen is correct, click OK. The following

screen appears:
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4. Select the tributary that the end-to-end path will follow around the ring. Only
valid tributary numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:

5. At the bottom of the form, you are prompted to choose the drop node. Double-

click the desired node. The following screen appears:
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6. Select the low-speed slot for this drop node. Click OK. The main end-to-end
path form displays:

7. You are prompted to choose another drop node (for creating a multi-drop path),
or to create the end-to-end path. When ready to create the path, click OK. The

following screen appears:
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8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.

Click OK.

10. The screen below shows a graphical representation of the newly created end-to-

end path.
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Video Service End-to-End Paths

CPro-2000 offers the feature of Video Service Paths in DDM-2000 OC-12 NEs. Video paths
are created using STS-3C cross connections.

NOTE: You must purchase the DDM-2000 OC-12 STS-3C feature package to have this
capability. See your Lucent Technologies' account representative for details.

The STS-3C feature allows concatenation of three STS-1 signals into a single STS-3C signal
and cross connection at the STS-3C rate. Two cross-connection types support Video Service

paths: Video Source and Video Sink.

Video paths look like one-way paths, because they only use one rotation of the ring. They
always contain one source at the add location and a sink at the drop location.
There can be more than one sink (or drop) in a video path, as shown in the following
illustration. Because a video path only uses one rotation of the ring, a single time slot may

contain two video paths.

The following illustration shows two Video Service paths. The first path, denoted by the solid
line, shows the signal being added at Node A (the source) and put on Rotation 2, through
circuit pack mb1. It follows the ring dropping at Nodes G, E, C, and B. The second path,
denoted by the dashed line, is put on Rotation 1, through circuit pack mb2. It follows the ring

dropping at Nodes C, E, and F.

Node F

Node A
mb2mb1

mb1mb2
Node E

mb1mb2
Node D

mb1

mb2

Node G

mb1

mb2

Node B

Node C

mb2

mb1

mb2

mb1

DDM-2000 OC-12 Ring
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Enter an STS-3C Video Service End-to-End Path
(DDM-2000 OC-12 and OC-12/OC-3 mixed ring when
OC-3 is equipped with 24G-U OLIU)
NOTE: For the STS-3C path type to be available, the following restrictions must be followed:

•  A low-speed slot in the Video Source and Video Sink nodes must contain a 21-type
OLIU circuit pack.

•  The OC-3 Lines application parameter in the Provision menu must be set to Video for
each Video Source and Video Sink node in the ring.

•  The STS-3C feature must be enabled for each node in the ring. (This feature is
enabled in MML using the SET-FEAT command (also available in the Provision
Menu) and in TL1 using the ENT-FEAT command. See the DDM-2000 OC-12

User/Service Manual for complete details.)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS3C signal rate and Video Service.

2. At the bottom of the form in the dialog box, you are prompted to choose the
video source node. Double-click the desired node displayed within the form.

The following screen appears:
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3. Select the low-speed slot to be used for this video source node. Note that only
valid slot addresses are displayed. The Cancel button can be clicked at any time
to cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The main end-to-end path

form displays, updated with the information you have selected:
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5. You are prompted to choose the video sink node. Double-click the desired node.
The following screen appears:

6. Select the low-speed slot for this video sink node. Click OK. The main end-to-
end path form displays:
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7. You are prompted to choose another video sink node (for creating a multi-drop
path), or to create the end-to-end path. When ready to create the path, click OK.

The following screen appears.

8. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

9. When your path has been successfully completed, the following screen appears.
Click OK.

10. The screen below shows a graphical representation of the newly created end-to-
end path.
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Locked Arc End-to-End Paths
A Locked Arc path must be at the VT1.5 signal rate and is only applicable to DDM-2000
OC-3 and FiberReach NEs. A locked path provides a fixed path for signals that have rigid
timing requirements. A locked path contains locked cross connections, which only transmit a
signal to and receive a signal from one OLIU circuit pack in the mains. The signal uses both
rotations of the ring, but only a portion of the ring is being used for the path. Because a locked
path uses a set path for the signal, the amount of time it takes the signal to go from point A to

point B is always the same.

The following illustration shows a Locked Arc path in a single DDM-2000 OC-3 ring. The
add/drop cross connection at Node A is a locked cross connection and the signal is being
passed through the circuit pack in slot m2. At Node B, there is a two-way pass-through cross
connection. At Node C, there is another add/drop cross connection that is also locked. This
cross connection takes the signal through the circuit pack in m1 and drops it. It also takes

incoming signal.

Locked cross connections use the Ring ID to designate which main slot is to be used to
transmit and receive the signal. For this path, the Ring ID at Node A is m2 and the Ring ID at

Node C is m1.
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Enter a VT1.5 Locked End-to-End Path
(DDM-2000 OC-3, and FiberReach)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for VT1.5 signal rate and Locked Arc path type.
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2. Near the bottom of the form in the dialog box, you are prompted to choose a
locked add/drop node. Double-click the desired node displayed within the form.

The following screen appears:

3. Select the low-speed slot for this locked add/drop node. Note that only valid slot
addresses are displayed. The Cancel button can be clicked at any time to cancel
the operation. If the slot you have chosen is correct, click OK. The following

screen appears:

4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The following screen appears:
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5. Select the Ring ID. The Ring ID establishes which way the pass-through cross
connections, which are between the locked cross connections, should be created.
It also determines on which side the locked cross connections leave an NE.
Click OK. The main end-to-end path form displays, updated with the

information you have selected:

6. You are prompted to choose the next add/drop node. Double-click the desired
node. The following screen appears:
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7. Select the low-speed slot for this add/drop node. Click OK. The main end-to-
end path form appears:

8. You are prompted to choose another node (for creating a multi-drop path), or to
create the end-to-end path. When ready to create the path, click OK. The

following screen appears.
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9. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes.

10. When your path has been successfully completed, the following screen appears.
Click OK.

11. The screen below shows a graphical representation of the newly created end-to-
end path.

Enter a VT1.5/T1 Locked End-to-End Path (FiberReach)

Procedure

1. From the End-to-End Path Menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for VT1.5/T1 signal rate and Locked Arc path type.
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2. Near the bottom of the form in the dialog box, you are prompted to choose a
locked add/drop node. Double-click the desired node displayed within the form.

The following screen appears:

3. Select the low-speed slot for this locked add/drop node. Note that only valid slot
addresses are displayed. The Cancel button can be clicked at any time to cancel
the operation. If the slot you have chosen is correct, click OK. The following

screen appears:
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4. Select the time slot that the end-to-end path will follow around the ring. Only
valid time slot numbers are displayed. Click OK. The following screen appears:

5. Select the Ring ID. The Ring ID establishes which way the pass-through cross
connections, which are between the locked cross connections, should be created.
It also determines on which side the locked cross connections leave an NE.
Click OK. The main end-to-end path form displays, updated with the

information you have selected:
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6. You are prompted to choose another node (for creating a multi-drop path), or to
create the end-to-end path. When ready to create the path, click OK. The

following screen appears.

7. Click No if you do not want to create the end-to-end path (none of your

selections will be implemented). If you want to proceed, click Yes.

8. When your path has been successfully completed, the following screen appears.
Click OK.

9. The screen below shows a graphical representation of the newly created end-to-
end path.
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Three-Node Interworking End-to-End Paths
(Access Ring Application)

A form in the CPro-2000 End-to-End Path menu supports the creation of a three-node
interworking end-to-end path, which is often used for access ring applications. The path is
provisioned over an access ring that interconnects to another ring via two colocated pairs of

nodes. This type of arrangement allows the end-to-end path to survive multiple failures.

To create a three-node interworking end-to-end path, access the End-to-End Path menu while
in the Subnetwork View. A form appears prompting the selection of the signal rate and path
type. The selection of these two options dynamically changes the form to reflect the
information needed to create that specific type of path. There are two types of three-node

interworking end-to-end paths supported by CPro-2000:

•  STS-1 three-node interworking (DDM-2000)

•  VT1.5 three-node interworking (DDM-2000 OC-3 only)

NOTE: CPro-2000 R11.0 does not support three-node interworking end-to-end paths on an
FT-2000.

All low speed connections for DDM-2000 use the following packs:

•  OC-3 or STS-1E

The following procedures provide specific instructions on creating the four types of three-
node interworking end-to-end paths in an access ring application.

NOTE: If the path being configured is a ring with linear extensions, the path around the ring
and the individual linear extension cross connections are created separately.
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Enter an STS-1 Three-Node Interworking End-to-End
Path (DDM-2000 only)

Procedure

1. From the End-to-End Path menu, select Enter. The following form appears.
Only valid signal rates and path types are available to select. Click the STS1

and 3-Node Intwk. tabs.

2. At the bottom of the form, you are prompted to choose the Add/Drop Node.
Double-click the node you have selected. The following screen displays:

3. Select the low-speed slot for the Add/Drop Node from the scroll list. Only valid
slot numbers are displayed. Click OK. The following screen appears:
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4. Select the timeslot that the end-to-end path will follow around the ring. Only
valid timeslot numbers are displayed. Click OK. The main end-to-end path form

displays, updated with the Add/Drop Node information you have selected:

5. At the bottom of the form, you are prompted to choose the Primary Node.

Double-click the node you have selected. The following screen appears:
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6. Select the low-speed slot for the Primary Node from the scroll list. Only valid
slot numbers are displayed. Click OK. The main end-to-end path form displays,

updated with the Primary Node information you have selected:

7. At the bottom of the form, you are prompted to select the Secondary Node.

Double-click the node you have selected. The following screen appears:
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8. Select the low-speed slot for the Secondary Node. Click OK. The main end-to-

end path form displays:

9. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.
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10. You may click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes. The

following message box displays..

11. Click OK, then click Cancel in the End-to-End Path dialog box to complete the

process.

The screen below shows a graphical representation of the newly created end-to-
end path.
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Enter a VT1.5 Three-Node Interworking End-to-End Path
(DDM-2000 OC-3 and FiberReach only)

Procedure

1. From End-to-End Path menu, select Enter. The following form appears. Only
valid signal rates and path types are available to select. Click the VT1.5 and 3-

Node Intwk. tabs.

2. At the bottom of the form, you are prompted to choose the Add/Drop Node.
Double-click the node you have selected. The following screen displays:

3. Select the low-speed slot for the Add/Drop Node from the scroll list. Only valid
slot numbers are displayed. Click OK. The following screen appears:
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4. Select the timeslot that the end-to-end path will follow around the ring. Only

valid timeslot numbers are displayed. Click OK.

5. The main end-to-end path form displays, updated with the Add/Drop Node
information you have selected:

6. At the bottom of the form, you are prompted to choose the Primary Node.
Double-click the node you have selected. The following screen appears:
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7. Select the low-speed slot for the Primary Node from the scroll list. Only valid
slot numbers are displayed. Click OK. The main end-to-end path form displays,

updated with the Primary Node information you have selected:

8. At the bottom of the form, you are prompted to select the Secondary Node.

Double-click the node you have selected. The following screen appears:
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9. Select the low-speed slot for the Secondary Node. Click OK. The main end-to-

end path form displays:

10. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.
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11. You may click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes. The

following message box displays.

12. Click OK, then click Cancel in the End-to-End Path dialog box to complete the

process.

The following screen shows a graphical representation of the newly created end-
to-end path.

Enter an STS-3C Three-Node Interworking End-to-End
Path (DDM-2000 OC-12 only)

Procedure

1. From the End-to-End Path menu, select Enter. The following form appears.
Only valid signal rates and path types are available to select; unsupported signal
rates and path types for your current subnetwork are grayed-out. Click the

STS3C and 3-Node Intwk. tabs.

NOTE: In order for the STS-3C path type to be available, the following restrictions must be
followed:
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•  A low-speed slot in the Add/Drop, Primary, and Secondary nodes must contain a
21-type OLIU circuit pack.

•  The OC-3 Lines application parameter, in the Provision menu, must be set to 1+1 for
the Add/Drop, Primary, and Secondary nodes in the ring.

•  For shelves equippped with 29G OLIUs the Function Slot C (fn-c) must be equipped
with a 22-type OLIU.

•  The STS3-C feature must be enabled for each node in the ring. (This feature is
enabled in MML using the SET-FEAT command and in TL1 using the ENT-FEAT
command. See your DDM-2000 OC-12 User Service Manual for complete details.)

On a DDM-2000 OC3 shelf equipped with the 29G OLIU, CPro-2000 R11.0
supports setting the OC-3 line application parameter to 0x1.

2. At the bottom of the form, you are prompted to choose the Add/Drop Node.
Double-click the node you have selected. The following screen displays:
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3. Select the low-speed slot for the Add/Drop node from the scroll list. Only valid

slot numbers are displayed. Click OK. The following screen appears:

4. Select the timeslot that the end-to-end path will follow around the ring. Only
valid timeslot numbers are displayed. Click OK. The main end-to-end path form

displays, updated with the Add/Drop node information you have selected:
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5. At the bottom of the form, you are prompted to choose the Primary Node.
Double-click the node you have selected. The following screen appears:

6. Select the low-speed slot for the Primary Node from the scroll list. Only valid
slot numbers are displayed. Click OK. The main end-to-end path form displays,

updated with the Primary Node information you have selected:
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7. At the bottom of the form, you are prompted to select the Secondary Node.
Double-click the node you have selected. The following screen appears:

8. Select the low-speed slot for the Secondary Node. Click OK. The main end-to-
end path form displays:
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9. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.



CPro-2000 User Manual Release 11.0 The End-to-End Path Menu ••••  269

10. You may click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes. The

following message box displays.

11. Click OK, then click Cancel in the End-to-End Path dialog box to complete the

process.

The screen below shows a graphical representation of the newly created end-to-
end path.
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Four-Node Interworking End-to-End Paths
(Interoffice Ring Application)

A form in the CPro-2000 End-to-End Path menu supports the creation of a four-node
interworking end-to-end path, which is used for interoffice ring applications.

To create a four-node interworking end-to-end path, access the End-to-End Path menu while
in the Subnetwork View. A form appears prompting the selection of the signal rate and path
type. The selection of these two options dynamically changes the form to reflect the
information needed to create that specific type of path. There are two types of four-node end-

to-end paths supported by CPro-2000:

•  STS-1 four-node interworking (DDM-2000)

•  VT1.5 four-node interworking (DDM-2000 OC-3 Releases 7.2, 9.0, 11.0,
11.1, and 15.0 )

NOTES: CPro-2000 R11.0 does not support the following:

•  Four-node interworking end-to-end paths on an FT-2000.

•  The establishment of STS-1 or VT1.5 four-node interworking end-to-end paths when
an intervening node exists between either the primary and secondy nodes one ring

(Ring A) or between the primary and secondary nodes another ring (Ring B).

When constructing interoffice rings, it is necessary to have exact information on which TID
performs which function prior to creating the individual cross connections that make up a
four-node interworking ring. TIDs must be identified for the following four functions:
primary node ring A, primary node ring B, secondary node ring A, and secondary node ring
B. It is also critical that the direction in which the DRI cross connections are to be added is

identified in advance for successful subnetwork functionality.

All low speed connections for DDM-2000 use the following packs:

•  OC-3 or STS-1E

DDM-2000 Interoffice Rings
When the interoffice ring is a DDM-2000 OC-3 ring or DDM-2000 OC-12 ring, two drop-
and-continue nodes are used to connect to each of the two access rings or to a single access
ring and then off the network (for example, connecting to a point of presence [POP] to a long-

distance carrier) where traffic terminates.

Enter an STS-1 Four-Node Interworking End-to-End Path
(DDM-2000 only)

Procedure

1. From the End-to-End Path menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for STS1 signal rate and 4-Node Intwk. path type.
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2. At the bottom of the form in the dialog box, you are prompted to choose the
primary node for Ring A. Double-click the desired node displayed within the

form. The following screen appears:

3. Select the low-speed slot for the primary node for Ring A. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
cancel the operation. If the slot you have chosen is correct, click OK. The

following screen appears:



272 ••••  The End-to-End Path Menu CPro-2000 User Manual Release 11.0

4. Select the timeslot that the end-to-end path will follow around the ring. Only
valid timeslot numbers are displayed. Click OK. The main end-to-end path form

displays, updated with the information you have selected:
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5. You are prompted to choose the secondary node in Ring A. Double-click the
desired node. The following screen appears:

6. Select the low-speed slot for the secondary node in Ring A. Click OK. The main
end-to-end path form displays, updated with the information you have selected:
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7. You are prompted to choose the primary node for Ring B. Double-click the
desired node. The following screen appears:

8. Select the low-speed slot for the primary node in Ring B. Click OK. The main
end-to-end path form appears:
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9. You are prompted to select the secondary node for Ring B. Double-click the
desired node. The following screen appears:

10. Select the low-speed slot for the secondary node in Ring B. Click OK. The main
end-to-end path form appears:
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11. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.

12. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes. The

following message box displays.

13. Click OK, then click Cancel in the End-to-End Path dialog box to complete the

process.

The following screen shows a graphical representation of the newly created end-
to-end path.
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Enter a VT1.5 Four-Node Interworking End-to-End Path
(DDM-2000 OC-3 only)

Procedure

1. From the End-to-End Path menu, select Enter. The following form appears.
Only valid signal rates and path types are available for selection. Click the tabs

for VT1.5 signal rate and 4-Node Intwk. path type.

2. At the bottom of the form in the dialog box, you are prompted to choose the
primary node in Ring A. Double-click the desired node displayed within the

form. The following screen appears:

3. Select the low-speed slot for the primary node for Ring A. Note that only valid
slot addresses are displayed. The Cancel button can be clicked at any time to
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cancel the operation. If the slot you have chosen is correct, Click OK. The

following screen appears:

4. Select the timeslot that the end-to-end path will follow around the ring. Only
valid timeslot numbers are displayed. Click OK. The main end-to-end path form

displays, updated with the information you have selected:
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5. You are prompted to choose the secondary node in Ring A. Double-click the
desired node. The following screen appears:

6. Select the low-speed slot for the Secondary Node in Ring A. Click OK. The
main end-to-end path form displays, updated with the information you have

selected:
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7. You are prompted to select the primary node for Ring B. Double-click the
desired node. The following screen appears:

8. Select the low-speed slot for the primary node in Ring B. Click OK. The main
end-to-end path form appears:

9. You are prompted to select the secondary node for Ring B. Double-click the
desired node. The following screen appears:
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10. Select the low-speed slot for the secondary node in Ring B. Click OK. The main

end-to-end path form appears:

11. If the information you have selected is correct, click OK to create the end-to-end
path and the following screen appears.
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12. Click No if you do not want to create the end-to-end path (none of your
selections will be implemented). If you want to proceed, click Yes. The

following message box displays.

13. Click OK, then click Cancel in the End-to-End Path dialog box to complete the

process.

The following screen shows a graphical representation of the newly created end-
to-end path.
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Delete End-to-End Path

Purpose

To delete an end-to-end path, the Subnetwork View must be the current window so the
End-to-End Path menu is available.

NOTE: If you have created a locked arc end-to-end path containing two 0x1 cross
connections, CPro-2000 recognizes this as two separate paths. You must delete each path

individually.

Procedure

1. From the End-to-End Path menu, select Delete. The following screen appears:

2. Click the path name you want to delete. The path name is highlighted.

NOTE: For paths containing both active and standby cross connections (for example, DRI
and OC-3 1+1), only the active cross connections are listed in the path index list. Standby
cross connections are not displayed in the list, even though they are displayed in the Network

Element View and are also deleted.

3. Click Close if you do not want to delete a path and you want to end this
operation. Click Delete Path to delete the path and the following screen

appears:

4. Click No if you do not want to delete the selected end-to-end path and you want
to end this operation. Click Yes if you want to delete the selected end-to-end

path. The following screen appears:
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5. Click No if you want to abort the command and end this operation. Click Yes if
you want to delete the selected end-to-end path.

6. When your path has been successfully completed, the following screen appears:

7. Click OK.

Modify LocA/LocZ

Purpose

The End-to-End Path menu also enables you to correct the LocA and/or LocZ values of an
FT-2000 OC-48 STS-3 or STS-1 path. Use this command if you find LocA and/or LocZ
errors in your Path Provisioning Error report. When you use the Modify LocA/LocZ
command, CPro-2000 determines what the correct LocA and LocZ values should be and
adjusts the values accordingly. See the Lucent Technologies FT-2000 OC-48 User/Service

Manual for further details on path provisioning errors.

Procedure

1. From the End-to-End Path menu, choose Modify LocA/LocZ.

2. The following path listing displays:
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NOTE: When the Audit On box is checked, the alarm feature that notifies the user of any
signal problem is activated. To turn off this feature, click the box to remove the check mark.

3. Select the path you want to update from the List of Path Names field. Each path
name consists of the source TID and tributary of the path. The Path Information

box displays all the important information about the path.

4. Click Modify Path and the following dialog box appears indicating that the
modifications to LocA and LocZ are complete. If at any time you want to cancel

this operation, click Close.

5. Click OK.

Tag Red Line

Purpose

The End-to-End Path menu contains the Tag Red Line menu item. This enables the user to
protect against the accidental deletion of a path used for high-priority services. By selecting
this menu item, the user can tag an end-to-end path as “Redlined,” This status then applies to

all cross connections in the path.

When tagged as Redlined, the end-to-end path cannot be deleted without first being untagged.
If an attempt is made to delete a Redlined end-to-end path, a message informs the user that the

path is Redlined and cannot be deleted.

The Redline status of a cross connection can be seen in the GUI status bar when the cross
connection is highlighted (single-clicked). Redline status is also indicated in the reports that

can be generated for cross connections and end-to-end paths.

Procedure

1. From the End-to-End Path menu, select Tag Red Line. The following screen
appears:
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2. Click the path name to be red lined. The path name is highlighted.

3. Click Close if you want to end this operation without making any changes. To
red line the path, place a check mark in the box next to Red Line by clicking in

the box.

4. Next, click Modify Path and the following screen appears:

5. Click No if you do not want to red line the selected end-to-end path and the
operation is ended. Click Yes if you want to red line the selected end-to-end

path. The following screen appears:

NOTE: An end-to-end path can be untagged (Redline status removed) by clicking on Modify

Path when the Red Line box is unchecked.
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The Alarms Menu

Overview
The Alarms menu allows you to activate the auto alarm polling feature, set parameters for the
audible alarms and pager, test the pager set up, and set other network monitoring preferences.
Specific activities that you can perform with this feature include enabling, disabling, or
silencing the audible alarm, and configuring the audible alarm and pager. You can access the
alarm menu options from the GUI menu bar or by using shortcut key combinations. (See the

Task Mapping section for a listing of menu items and shortcut key commands.)

The Alarms menu commands are:

•  Auto Alarm Polling

•  Audible Alarms

•  Pager

•  Preferences
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The Alarm feature in CPro-2000 Release 11.0 supports two types of alarm reporting: local
and network.

For local alarm reporting, CPro-2000 Release 11.0 supports the following NE releases:

•  DDM-2000 OC-3 - Releases 13.0, 13.5, and 15.x

•  DDM-2000 OC-12 - Releases 7.0 and 7.1

•  DDM-2000 FiberReach - Releases 3.0, 3.1, and 4.0

•  FT-2000 OC-48 - Releases 8.1, 9.0, and 9.1

For network alarm reporting, CPro-2000 Release 11.0 supports the following NE releases:

•  DDM-2000 OC-3 - Releases 15.x

•  DDM-2000 FiberReach - Release 4.0 and above

In reporting network alarms, CPro-2000 reports the highest level of alarm in the polled
network. However, the following conditions must exist for CPro-2000 to report network

alarms:

•  The RNE must be enabled for each node to be monitored

•  The network must have at least one AGNE

•  The network must be in the same alarm group

NOTE:  The Audible Alarm and Pager features are only available when  Auto Alarm Polling
is enabled (turned on). Therefore, the Audible Alarm and Pager options are grayed out when

Auto Alarm Polling is disabled.

Auto Alarm Polling

Purpose

To enable or disable automatic updating of alarm status at specific time repeat intervals for
the selected network element.

The Auto Alarm Polling feature is enabled when it is shown with a check. If there is no check
mark against the Auto Alarm Polling command, then the feature is disabled. The default
setting for this feature is "disabled." You can change the auto alarm polling state from either

the Alarms menu or by using the INI File Editor from the Access menu.

When the feature is enabled, the polling interval defaults to the last saved setting.
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The Auto Alarm Polling feature updates the alarm status for the node in view. You must,
therefore, ensure that the NE view is displayed on your monitor when this feature is enabled.

The default auto alarm polling interval is three minutes. You can change this to a minimum of
one minute and up to a maximum of 90 minutes using the Preferences option in the Alarm
menu. Change this interval using the INI File Editor from the Access menu or follow the

instructions in the Preferences section of this chapter.

The interval in Auto Polling Minutes field overrides the corresponding values specified in the
CPRO.INI file.

The system writes and saves the values in the Auto Polling Minutes field into the CPRO.INI
file when you log out of CPro. CPro-2000 uses these previously-saved values when the

system is started for a new session.

Alarm polling is temporarily disabled  when any CPro- 2000 function such as a backup or a
restore is in progress.

NOTE: CPro-2000 displays the highest alarm level reported back by the NE in the bottom
left corner of the GUI window.

Procedure

1. From the GUI, click Alarms.

2. Select Auto Alarm Polling from the list of options.

Audible Alarms

Purpose

To alert the user to the alarm status of the network by sounding the appropriate audible alarm
when an alarm is detected in the network. The default repeat interval, the number of seconds
that pass from the start of one alarm sound to the start of the next alarm sound, is three
seconds. To change this repeat interval to a maximum of 30 seconds, use the Preferences
option in the Alarms menu. Refer to the Preferences section of this chapter for instructions

on how to change this repeat interval.

NOTES:

•  The Audible Alarms feature is only available when Auto Alarm Polling  is
enabled (turned on).
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•  A sound card must be installed in your PC for this feature to be available. If an
alarm is detected when a sound card is not installed, CPro-2000 displays a
message similar to the following :

•  The default setting for this feature is "off" or disabled.

•  CPro-2000 does not support alarm polling with the audible alarm or the alarm
pager when the local node is a DDM-2000 shelf using TL1 connections. In this
case, the audible alarms and alarm pager features are unavailable for selection.

•  For FT-2000s Remote Activity Reporting CPro-2000 automatically enables
the FT-2000 from which the alarm status is retrieved (the first node logged
into) for the network element alarm status to be reported when logged in via
TL1.

•  CPro-2000 R11.0 provides specific default sounds (WAV files ) for each alarm
severity levels - critical, major, and minor. These WAV files are referenced in
the CPRO.INI file. You can substitute your own WAV files by editing the
CPRO.INI file using the Notepad editor.

Procedure

1. To change the audible alarm status in a network, do one of the following:

•  From the Alarms menu, select Audible Alarms, or

•  Click the Audible Alarm button   located in the lower right corner of the
screen.

The feature is enabled if a check mark is visible against the Audible Alarms
option and if the Audible Alarms button is pushed in.

Acknowledging an Alarm
When an alarm condition is detected in the network, the system sounds the appropriate
audible alarm for that alarm level and displays the Network Alarm Detected on dialog box.
The title bar of this dialog box identifies the detected alarm level. For example, if a minor
alarm is detected in the network, the name of the dialog box is "MINOR Network Alarm

Detected on."  Network alarms are classified as minor, major, or critical.

To acknowledge an alarm

•  When an alarm is detected in the NE, a dialog box similar to the following appears:
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Title Bar – displays the level of the alarm detected.

TID - identifies the name of the network.

•  Click the Silence button or press the space bar to acknowledge the alarm and dismiss
the dialog box.

  Pager

Purpose

To alert users to network alarms by calling a pager number associated with the alarm level.

 NOTES:

•  Before you use the Pager feature, you must ensure that a modem is installed
according to the manufacturers recommendations.

•  The Pager features are only available if  Auto Alarm Polling  is enabled (on).
The default pager setting is "off".

•  The pager feature supports only alpha-numeric pagers with SkyTel®
subscriber service.

Procedure

1. Within the Alarm Preferences menu, select the comm port that corresponds to
your modem in the Modem Comm Port field of the Alarm page.

2. Activate the pager feature by doing one of the following:

•  From the Alarms menu, select Pager, or

•  Click the Pager button  located in the lower right corner of the GUI.

The feature is enabled if a check mark is visible against the Pager option and if
the Pager button is pushed in.

If the system does not recognize the comm port, for example, if the selected
comm port is connected to another device such as a mouse or CPro-2000 serial

communications link, the following message appears.
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Alarm Preferences

Introduction
The Alarm Preference option is central to the alarms feature in CPro-2000. The four tabs of
the Alarm Preferences dialog box are:

•  Alarm

•  Call List

•  Providers

•  Pager Test

The Alarm Preferences dialog box also provides two buttons: OK saves your settings, Close

dismisses the dialog box without saving your settings. The sections that follow describe the

functions on each of the tabbed pages in the Alarm Preferences dialog box.

i.  The Alarm Tab
Use this tab to adjust the repeat interval between alarm sounds, change auto alarm polling
repeat interval, set the communication port for your modem, specify a prefix to dial for an
outside line and to view or delete the pager log. The following sections explain the tasks you

can perform from the Alarm Tab of the Alarm Preferences dialog box.

Changing the alarm sounds repeat interval

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Change Audible Repeat Seconds to the desired repeat interval (from 3 to 30
seconds) using the up and down arrows. The repeat interval is the number of
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seconds that pass from the start of one alarm sound to the start of the next alarm

sound.

3. Click OK to save the current settings and dismiss the Alarm Preferences dialog
box or Close dismiss the dialog box without saving any settings.

NOTE: Subsequent CPro-2000 sessions open with the last value selected.

Adjusting the alarm polling repeat interval

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Change Auto Poll Minutes to the desired repeat interval (from 1 to 90 minutes)
using the up and down arrows. The default repeat interval is 3 minutes.

3. Click OK to save the current settings and dismiss the Alarm Preferences dialog

box or Close dismiss the dialog box without saving any settings.

NOTES:

•  The alarm polling repeat interval can also be changed using the INI File Editor from
the Access menu.

•  Subsequent CPro-2000 sessions open with the last value selected.

Selecting the modem communication port

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the down arrow next to the Modem Comm Port field to display a list of

available comm ports.

3. Select the comm port that corresponds to your modem.

4. Click OK to save the current settings and dismiss the Alarm Preferences dialog
box or Close dismiss the dialog box without saving any settings.

NOTE: Subsequent CPro-2000 sessions open with the last selected port number.

Specifying a number prefix for an outside line

In some settings, a prefix might be required in order to access an outside phone line. The To

access an Outside Line, first dial field is where you specify a prefix the system must dial to

access an outside phone line. To specify a number prefix:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Type the prefix in the To access an Outside Line, first dial field.

3. Click OK to save the current settings and dismiss the Alarm Preferences dialog
box or Close dismiss the dialog box without saving any settings.

NOTE: Subsequent CPro-2000 sessions open with the last value selected.

Viewing the Pager Log File

The Pager Log File tracks the activities of the pager. To view the log file:



294 ••••  The Alarms Menu CPro-2000 User Manual Rele

ase 11.0

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Select View from the Pager Log File section.

If no Pager Log File exists, the follow message appears.

If a Pager Log File exists, a text file similar to the following appears.

•  Pager Enabled - Date and time pager feature was enabled.

If an alarm is detected in the networks while pager is enabled, the following
information is also displayed:

- Message sent: Alarm type and TID

- Pager number(s): Pager number called, and date and time of alarm
notification.

•  Pager Disabled - Date and time pager feature was disabled.

3. Close this window from the File menu or by using the Close button.

Deleting a pager log file

To delete a log file:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click Delete in the Pager Log File.

If no Pager Log File exists, the follow message appears.
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If a Pager Log File exists, the following confirmation message appears.

3. Click OK to proceed, or Cancel to withdraw the command.

NOTE: The system permits deletions of Pager Log Files only after the pager service is
disabled.

ii.  The Call List Tab

From the Call List tabbed page, you can:

•  specify a pager number

•  type in a name to associate with that pager number

•  select the pager type, and

•  specify alarm levels to be associated with that pager number.

In addition, you can add, edit, or delete the names and phone numbers from the call
list.



296 ••••  The Alarms Menu CPro-2000 User Manual Rele

ase 11.0

Defining the call list parameters

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Call List tab. The following page appears.

3. Click Add to activate the fields. The new window should look like this:
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4. In the Name field, type a name associated with the pager number.

NOTE: It is recommended that you type a name in the Name field if one pager number is
associated with one person. However, you can leave the Name field blank if more than one

person is responsible for monitoring the pager.

The following message box appears if you do not enter a name in the Name
field.

5. To proceed without an entry, click OK.

6. In the Phone (PIN) field, type the pager number using the format (dashes are
optional):

000-0000

PIN = Pager Identification Number

This is a required field; the system will not permit you to proceed until you type
a phone number in this field.

7. If you attempt to proceed without entering a phone/PIN number in this field, the
following warning appears .
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8. In the Address Type section, select the appropriate pager type. Click 1-way for
a one-way pager and 2-way for a two-way pager.

9. In the Alarm Level section, select the desired alarm level to be associated with
the pager number. The option are: Critical, Major, Minor, or None. Selecting
None excludes an entry from search list. The number is not called if a network

alarm is detected, but the entry remains in the Call List.

Important:  It is recommended that you specify a pager number for every alarm level. This
ensures that for every network alarm, the appropriate call list number is paged.

NOTE: You can associate the same pager user name and pager number with one or more
alarms. For example, a pager user John Doe with a pager number 222-2222 can be associated
with both major and critical alarms. To do so, enter John Doe's name and number twice,
associating the first entry with major alarms and the second entry with critical alarms. The

system calls John Doe's pager number only if either a major or a critical alarm is detected.

10. Click OK from within the Call List page to save your entries.

Viewing the Call List

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Call List tab to display the call list.

3. Click the Up or Down arrows   to view the names in the call list.

4. To edit the Call List, press Edit. To add more entries to the list, click Add. To
delete the entry, click Delete. For detailed information on how to perform each

of these tasks, see the appropriate sections of this chapter.

Editing call list entries

To change any of the parameters associated with a pager user name:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Call List tab to display the call list page.

3. Click Edit to activate the fields in this window.

4. Change parameters as follows:
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To change …….. Click …….

A user name the Name field. Type the new name in the
selected field.

A phone or PIN number the Phone (PIN) field, select the existing
information, then type the replacement.

The alarm level a different alarm option in the Alarm
Level section.

An pager type the correct pager type in the Address
Type section

5. From within the Call List page click OK  to save the current settings and exit the
Alarm Preferences dialog box or click Close exit the dialog box without saving

any settings, .

Deleting call list entries

To delete call list entries:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Call List tab to display the call list page.

3. Select an entry you want removed from the list.

NOTE:  Choosing either a name or phone number removes all data associated with that entry
from the list.

4. Click Delete. The following confirmation message box appears.

5. Click OK to delete the entry or click Cancel to withdraw the command.

6. Click OK save the current settings and dismiss the Alarm Preferences dialog
box or Close dismiss the dialog box without saving any settings.

iii.  The Providers Tab

This is a read-only tab that displays the name and phone number of the pager service
provider. To view this information:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Providers tab. The following window appears:
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NOTES:

•  The Providers tabbed page is read-only and cannot be edited.

•  The name and telephone number for the pager service provider as shown in the above
window.

•  The Add, Edit, and Delete buttons are grayed out and unavailable in CPro-2000
Release 11.0.

•  Clicking either OK or Close exists the Alarm Preferences dialog box.

iv.  The Pager Test Tab

The Pager Test tab allows you to test your new pager setup. Use this tab to send a
test message to a new pager setup and to view the results. To test a new pager setup:

1. From the Alarms menu, select Preferences. The Alarm Preferences dialog box
appears with the Alarm tab displayed.

2. Click the Pager Test tab. The following window appears:
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3. In the Subscriber Pager Number field, type the PIN number of the pager to
which you would like the test message sent.

4. In the Message Text section, type the test message. Note that the test message
should not exceed 240 characters.

5. In the Address Type section, select the appropriate pager type. Click 1-way for a

one-way pager and 2-way for a two-way pager.

6. Click Send to start to send the text message to the specified pager number. You
should hear a dial tone and the sound of the modem dialing as it attempts to

make a connection, or

Click Clear to remove any entries from both the Subscriber Pager Number and
the Message Text fields.

If you clicked Send, the following message appears:

If you click Send again while transmission is in progress, the following message
appears:

7. Click OK to return to the Pager Test page.  Notice that the Message Test field
title has changed to reflect the current status of the transmission.

8. Click OK to save the current settings and dismiss the Alarm Preferences dialog
box or Close dismiss the dialog box without saving any settings.
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The Help Menu

Overview
The Help Menu contains on-line help topics based on the contents of this user manual.
The on-line help consists of the following topics:

•  About This Manual

•  Introduction

•  Installation

•  CPro-2000 Startup

•  The User Interfaces

•  Task Mapping

•  The Access Menu

•  The Edit Menu

•  The View Menu

•  The Report Menu

•  Cross Connections

•  The Provision Menu

•  The Update Menu

•  The Window Menu

•  The End-to-End Path Menu

•  The Alarms Menu

•  The Help Menu

The Help Menu also contains About CPro-2000, which provides information about the
current release.
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CPro-2000 Help

Purpose

To provide an on-line version of the User Manual.

Procedure

1. From the Help pull-down menu, select CPro-2000 Help. A help window
displays a sublevel of topics. Select the underlined topic for which you need

help information.

NOTE: Also included in the help window are standard Microsoft Windows help tools, such
as File, Edit, Bookmark, Help, Contents, Search, Back, and History. See your Microsoft
Windows documentation for a detailed explanation of these standard features. A glossary of

terms is also available from the help window.

About CPro-2000

Purpose

To display the version number and NE applicability of CPro-2000.

Procedure

1. From the Help menu, select About CPro-2000. A banner appears containing the

title, version number, and NEs supported in the current release.
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Appendix A.
DDM-2000 OC-3 Commands

DDM-2000 OC-3 User Service Manual Command Set

Purpose
The purpose of this section is to provide a cross-reference between the Commands and
Reports section of the Lucent Technologies DDM-2000 OC-3 User/Service Manual and the

menu items of CPro-2000.

Commands Cross-Reference Table
DDM-2000 OC-3 commands/reports that do not have an entry in the CPro-2000 Menu
column are not supported in CPro-2000. However, please keep in mind that since CPro-2000
allows concurrent access to both the GUI and AUI, you can always enter the commands that

are not supported on the CPro-2000 menus from the AUI window.

CIT Command Description CPro-2000

Menu Item

CNVT-CRS Convert Cross-Connection

CPY-PROG Copy Program

DLT-ASNE Delete Alarm Services NE

DLT-CRS-STS1 Delete Cross-Connection STS-1 X-Conn/
Network
Element/ Delete

DLT-CRS-VT1 Delete Cross-Connection VT1.5 X-Conn/
Network
Element/ Delete

DLT-TADRMAP Delete TID Address MAP

ENT-CRS-STS1 Enter Cross-Connection STS-1 X-Conn/
Network
Element/Enter
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CIT Command Description CPro-2000

Menu Item

ENT-CRS-VT1 Enter Cross-Connection VT1.5 X-Conn/
Network
Element/Enter

ENT-ULSDCC Enter Upper Layer Section DCC

? Help Help

INIT-PM Initialize Performance Monitoring

INIT-SYS Initialize System

INS-PROG Install Program

LOGOUT Logout Access/Logout

OPR-ACO Operate Alarm Cutoff

OPR-LPBK-EC1 Operate Loopback EC1

OPR-LPBK-T1 Operate Loopback T1

OPR-LPBK-T3 Operate Loopback T3

RESET Reset

RLGN Remote Login Access/Login

RLS-LPBK-EC1 Release Loopback EC1

RLS-LPBK-T1 Release Loopback T1

RLS-LPBK-T3 Release Loopback T3

RTRV-ALM Retrieve Alarm and Status Conditions Reports/Alarms

RTRV-ATTR-ALM Retrieve Attribute Alarm

RTRV-ATTR-CONT Retrieve Attribute Control

RTRV-ATTR-ENV Retrieve Attribute Environment

RTRV-CRS-STS1 Retrieve Cross-Connection STS-1 Update/Cross
Connections

RTRV-CRS-VT1 Retrieve Cross-Connection VT1.5 Update/Cross
Connections

RTRV-EC1 Retrieve EC-1 Reports/EC1

RTRV-EQPT Retrieve Equipment Update/
Network
Element
Inventory

RTRV-FEAT Retrieve Feature

RTRV-FECOM Retrieve Far-End Communications

RTRV-HSTY Retrieve History Reports/History

RTRV-LGN Retrieve Login

RTRV-LINK Retrieve Link

RTRV-NE Retrieve Network Element

RTRV-NMAP Retrieve Network Map

RTRV-OC3 Retrieve OC-3 Reports/OC-3

RTRV-PASSWD Retrieve Password

RTRV-PM-LINE Retrieve Performance-Monitoring Line

RTRV-PM-SECT Retrieve Performance-Monitoring Section

RTRV-PM-STS1 Retrieve Performance-Monitoring STS-1 Reports/PM
Data/STS1PM

RTRV-PM-T1 Retrieve Performance-Monitoring T1 Reports/PM
Data/DS1

RTRV-PM-T3 Retrieve Performance-Monitoring T3 Reports/PM
Data/DS3PM

RTRV-PM-TCA Retrieve Performance-Monitoring TCA
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CIT Command Description CPro-2000

Menu Item

RTRV-PM-VT1 Retrieve Performance-Monitoring VT1.5 Reports/PM
Data/VT1PM

RTRV-PMTHRES-LINE Retrieve Performance-Monitoring
Threshold Line

RTRV-PMTHRES-SECT Retrieve Performance-Monitoring
Threshold Section

RTRV-PMTHRES-STS1 Retrieve Performance-Monitoring
Threshold STS-1

RTRV-PMTHRES-T1 Retrieve Performance-Monitoring
Threshold T1

RTRV-PMTHRES-T3 Retrieve Performance-Monitoring
Threshold T3

RTRV-PMTHRES-VT1 Retrieve Performance-Monitoring
Threshold VT1.5

RTRV-SECU Retrieve Security

RTRV-STATE Retrieve State

RTRV-STATE-EQPT Retrieve State Equipment

RTRV-STATE-PATH Retrieve State Path

RTRV-STATE-STS1 Retrieve State STS-1

RTRV-STATE-VT1 Retrieve State VT1.5

RTRV-STS1 Retrieve STS-1

RTRV-SYNC Retrieve Synchronization

RTRV-T1 Retrieve T1 Reports/DS1

RTRV-T3 Retrieve T3 Reports/DS3

RTRV-ULSDCC Retrieve Upper Layer Section DCC

RTRV-VT1 Retrieve VT1.5

SET-ATTR-ALM Set Attribute Alarm

SET-ATTR-CONT Set Attribute Control

SET-ATTR-ENT Set Attribute Environment

SET-DATE Set Date

SET-EC1 Set EC-1 Provision/EC1

SET-FEAT Set Feature

SET-FECOM Set Far-End Communications

SET-LGN Set Login

SET-LINK Set Link

SET-NE Set Network Element Provision/Set
NE

SET-OC3 Set OC-3 Provision/OC-3

SET-PASSWD Set Password

SET-PMTHRES-LINE Set Performance-Monitoring Threshold
Line

SET-PMTHRES-SECT Set Performance-Monitoring Threshold
Section

SET-PMTHRES-STS1 Set Performance-Monitoring Threshold
STS-1

SET-PMTHRES-T1 Set Performance-Monitoring Threshold
T1

SET-PMTHRES-T3 Set Performance-Monitoring Threshold
T3
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CIT Command Description CPro-2000

Menu Item

SET-PMTHRES-VT1 Set Performance-Monitoring Threshold
VT1.5

SET-STATE-EC1 Set State EC1

SET-STATE-STS1 Set State STS-1

SET-STATE-T1 Set State T1

SET-STATE-T3 Set State T3

SET-STS1 Set STS-1

SET-SYNC Set Synchronization

SET-T1 Set T1 Provision/DS1

SET-T3 Set T3 Provision/DS3

SET-VT1 Set VT1.5

SWITCH-FN Protection Switch Function Unit

SWITCH-LINE Protection Switch Line

SWITCH-LS Protection Switch Low Speed

SWITCH-PATH-STS1 Switch Path STS-1

SWITCH-PATH-VT1 Switch Path VT1.5

SWITCH-SYNC Protection Switch Synchronization

TEST-ALM Test Office Alarm

TEST-AUTO Test Auto Turnup

TEST-LED Test LED Indicators

TEST-SYSCTL Test System Controllers

TEST-TLM-PAR Test Telemetry Parallel

TEST-TLM-SER Test Telemetry Serial

TEST-TRMSN-T1 Test Transmission T1

TEST-TRMSN-T3 Test Transmission T3

TOGGLE (Ctl-T) Toggle

UPD Update

DDM-2000 OC-3 User Service Manual Task-Oriented
Procedures

Purpose
The purpose of this section is to provide a cross-reference between the Task-Oriented
Procedures (TOPs) section of the Lucent Technologies DDM-2000 OC-3

User/Service Manual and the menu items of CPro-2000.

Cross-Reference Table for Tasks Supported in CPro-2000
The following table provides a cross-reference between the CPro-2000 capabilities and the
DDM-2000 OC-3 TOPs. Not every step in every one of the identified TOPs may be
supported in CPro-2000. The following table only means that significant steps of the TOPs
identified in the following table will be helped by the use of CPro-2000. Wherever the TOP
calls for use of a particular craft interface terminal (CIT) command that is not supported in
the CPro-2000 menu, it is assumed that the user will enter such commands directly from the

AUI window.
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TOP Number

Supported by

CPro-2000

Description

NTP-002 Establish DDM-2000 OC-3c (STS-3c) Service

NTP-004 Establish Initial End-to-End DS1 Service (Group Equipped
But Not In Service)

NTP-005 Establish Initial End-to-End DS3 Service (Group Equipped
But Not In Service)

NTP-006 Add New DS1 Service (Group Already In Service)

NTP-007 Add New DS3 Group for DS3 Service (System In Service)

NTP-008 Add New MXRVO Group for DS1 Service (System In
Service)

NTP-009 Convert DS1 Group Service to DS3 Group Service

NTP-010 Convert DS3 Group Service to DS1 MXRVO Group Service

NTP-011 Discontinue End-to-End DS1 Service

NTP-012 Discontinue End-to-End DS3 Service

NTP-026 Add New DDM-2000 OC-3 Node (Shelf) To DDM-2000
OC-3 Path-Switched Ring

NTP-027 Discontinue DDM-2000 OC-3 Node (Shelf) From DDM-2000
OC-3 Path-Switched Ring Network

NTP-034 Establish Initial EC-1 Service (Group Equipped With STS1E
But Not In Service)

NTP-035 Add New STS1E Low-Speed Group for EC-1 Interface
(System In Service)

NTP-036 Discontinue EC-1 Interface

NTP-038 Convert DS1 Group Service to EC-1 Group Service

DLP-531 Retrieve Generic Software Version ID

DLP-545 Make VT1.5 (DS1) or STS1 (DS3) Cross Connections Using
CIT Linear or Add/Drop Configuration

DLP-546 Make VT1.5 (DS1) or STS1 (DS3) Cross Connections Using
CIT Single-Ring Configuration

DLP-550 Make VT1.5 (DS1) or STS1 (DS3) Cross Connections Using
CIT Dual-Ring Interworking Configuration (Release 7)



310 ••••  Appendix A. DDM-2000 OC-3 Commands CPro-2000 User Manual Release 11.0



CPro-2000 User Manual Release 11.0 Appendix B. DDM-2000 OC-12 Commands ••••  311

Appendix B.
DDM-2000 OC-12 Commands

DDM-2000 OC-12 User Service Manual Command Set

Purpose
The purpose of this section is to provide a cross-reference between the Commands and
Reports section of the Lucent Technologies DDM-2000 OC-12 User/Service Manual and the

menu items of CPro-2000.

Cross-Reference Table
DDM-2000 OC-12 commands/reports that do not have an entry in the CPro-2000 Menu
column are not supported in CPro-2000. However, since CPro-2000 allows concurrent access
to both the GUI and AUI, you can always enter the commands that are not supported on the

CPro-2000 menus from the AUI window.

OC-12 CIT Command Description CPro-2000

Menu Item

CPY-PROG Copy Program

DLT-CRS-STS1 Delete Cross-Connection STS-1 X-Conn/Network
Element/Delete

DLT-TADRMAP Delete TID Address MAP

ENT-CRS-STS1 Enter Cross-Connection STS-1 X-Conn/
Network
Element/Enter

ENT-ULSDCC Enter Upper Layer Section DCC

? Help Help

INIT-PM Initialize Performance Monitoring

INIT-SYS Initialize System

INS-PROG Install Program

LOGOUT Logout Access/Logout

OPR-ACO Operate Alarm Cutoff
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OC-12 CIT Command Description CPro-2000

Menu Item

OPR-LPBK-EC1 Operate Loopback EC1

OPR-LPBK-T3 Operate Loopback T3

RESET Reset

RLGN Remote Login Access/Login

RLS-LPBK-EC1 Release Loopback EC1

RLS-LPBK-T3 Release Loopback T3

RTRV-ALM Retrieve Alarm and Status Conditions Reports/Alarms

RTRV-ATTR-ALM Retrieve Attribute Alarm

RTRV-ATTR-CONT Retrieve Attribute Control

RTRV-ATTR-ENV Retrieve Attribute Environment

RTRV-CRS-STS1 Retrieve Cross-Connection STS-1 Update/Cross
Connections

RTRV-EC1 Retrieve EC-1 Provision/EC1

RTRV-EQPT Retrieve Equipment Update/Network
Element
Inventory

RTRV-FEAT Retrieve Feature

RTRV-FECOM Retrieve Far-End Communications

RTRV-HSTY Retrieve History Reports/History

RTRV-LGN Retrieve Login

RTRV-LINK Retrieve Link

RTRV-NE Retrieve Network Element Update/Network
Element
Inventory

RTRV-NMAP Retrieve Network Map

RTRV-OC12 Retrieve OC-12 Provision/OC-12

RTRV-OC3 Retrieve OC-3 Provision/OC-3

RTRV-PM-LINE Retrieve Performance-Monitoring Line

RTRV-PM-SECT Retrieve Performance-Monitoring Section

RTRV-PM-STS1 Retrieve Performance-Monitoring STS-1 Reports/PM
Data/STS1PM

RTRV-PM-T3 Retrieve Performance-Monitoring T3 Reports/PM
Data/DS3PM

RTRV-PM-TCA Retrieve Performance-Monitoring TCA

RTRV-PMTHRES-LINE Retrieve Performance-Monitoring
Threshold Line

RTRV-PMTHRES-SECT Retrieve Performance-Monitoring
Threshold Section

RTRV-PMTHRES-STS1 Retrieve Performance-Monitoring
Threshold STS-1

RTRV-PMTHRES-T3 Retrieve Performance-Monitoring
Threshold T3

RTRV-SECU Retrieve Security

RTRV-STATE Retrieve State

RTRV-STATE-EQPT Retrieve State Equipment

RTRV-STATE-PATH Retrieve State Path

RTRV-STATE-STS1 Retrieve State STS-1

RTRV-STS1 Retrieve STS-1 Reports/STS1

RTRV-SYNC Retrieve Synchronization
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OC-12 CIT Command Description CPro-2000

Menu Item

RTRV-T3 Retrieve T3 Reports/DS3

RTRV-ULSDCC Retrieve Upper Layer Section DCC

SET-ATTR-ALM Set Attribute Alarm

SET-ATTR-CONT Set Attribute Control

SET-ATTR-ENV Set Attribute Environment

SET-DATE Set Date

SET-EC1 Set EC-1 Provision/EC1

SET-FEAT Set Feature

SET-FECOM Set Far-End Communications

SET-LGN Set Login

SET-LINK Set Link

SET-NE Set Network Element Provision/Set NE

SET-OC12 Set OC-12 Provision/OC-12

SET-OC3 Set OC-3 Provision/OC-3

SET-PASSWD Set Password Edit/Change
Password

SET-PMTHRES-LINE Set Performance-Monitoring Threshold
Line

SET-PMTHRES-SECT Set Performance-Monitoring Threshold
Section

SET-PMTHRES-STS1 Set Performance-Monitoring Threshold
STS-1

SET-PMTHRES-T3 Set Performance-Monitoring Threshold
T3

SET-SECU Set Security

SET-STATE-EC1 Set State EC1

SET-STATE-T3 Set State T3

SET-STS1 Set STS-1 Reports/STS1

SET-SYNC Set Synchronization

SET-T3 Set T3 Provision/ DS3

SWITCH-FN Protection Switch Function Unit

SWITCH-LINE Protection Switch Line

SWITCH-PATH-STS1 Switch Path STS-1

SWITCH-SYNC Protection Switch Synchronization

SWITCH-TSI Protection Switch Time Slot Interchange

TEST-ALM Test Office Alarm

TEST-AUTO Test Auto Turnup

TEST-LED Test LED Indicators

TEST-SYSCTL Test System Controllers

TEST-TLM-PAR Test Telemetry Parallel

TEST-TLM-SER Test Telemetry Serial

TEST-TRMSN-T3 Test Transmission T3

TOGGLE (Ctl-T) Toggle

UPD Update
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DDM-2000 OC-12 User Service Manual Task-Oriented
Procedures

Purpose
The purpose of this section is to provide a cross-reference between the TOPs section of the
Lucent Technologies DDM-2000 OC-12 User/Service Manual and the menu items of

CPro-2000.

Cross-Reference Table for Tasks Supported in CPro-2000
The following table provides a cross-reference between the CPro-2000 capabilities and the
DDM-2000 OC-12 TOPs. Not every step in every one of the identified TOPs may be
supported in CPro-2000. The following table only means that significant steps of the TOPs
identified in the following table will be helped by the use of CPro-2000. Wherever the TOP
calls for use of a particular CIT command that is not supported in the CPro-2000 menu, it is

assumed that the user will enter such commands directly from the AUI window.

TOP Number

Supported by

CPro-2000

Description

NTP-004 Establish Initial End-to-End DS3 Service (Group Equipped But
Not In Service)

NTP-005 Add New DS3 Group for DS3 Service (System In Service)

NTP-006 Discontinue End-to-End DS3 Service

NTP-021 Add New DDM-2000 OC-12 Node (Shelf) To DDM-2000
OC-12 Path-Switched Ring

NTP-022 Discontinue DDM-2000 OC-12 Node (Shelf) From DDM-2000
OC-12 Path-Switched Ring Network

NTP-023 Establish Initial EC-1 Service

NTP-024 Add New STS1E Low-Speed Group for EC-1 Interface (System
In Service)

NTP-025 Discontinue EC-1 Interface

NTP-026 Convert DS3 Group Service to EC-1 Group Service

DLP-541 Edit, Delete, or Enter a User's Login

DLP-546 STS1 (DS3) Cross Connections Using CIT Switched-Ring
Configuration

DLP-549 Make STS1 (DS3) Cross Connections Using CIT Dual-Ring
Interworking Configuration
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Appendix C.
FT-2000 OC-48 TL1 Commands

FT-2000 OC-48 User Service Manual Command Set

Purpose
The purpose of this section is to provide a cross-reference between the Commands and
Reports section of the Lucent Technologies FT-2000 OC-48 User/Service Manual and the

menu items of CPro-2000.

Cross-Reference Table
FT-2000 OC-48 TL1 commands/reports that do not have an entry in the CPro-2000 Menu
column are not supported in CPro-2000. However, please keep in mind that since CPro-2000
allows concurrent access to both GUI and AUI, you can always enter the TL1 commands that

are not supported on the CPro-2000 menus from the AUI window.

TL1 Command Description CPro-2000 Menu

Item

ACT-USER Activate User Access/Login

ALW-MSG Allow Message

CANC-USER Cancel User Access/Logout

CPY-PRGM Copy Program

DLT-CRS-STS3 Delete Cross-Connection STS-3 X-Conn/ Network
Element/ Delete

DLT-TADRMAP Delete TID Address Map

DLT-USER-SECU Delete User Security

ED-DAT Edit Date

ED-PID Edit Password Edit/Change
Password

ED-USER-SECU Edit User Security

TL1 Command Description CPro-2000 Menu

Item

ENT-CRS-STS3 Enter Cross-Connection STS-3 X-Conn/ Network
Element/Enter
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ENT-PROT-rr Enter Protection rr

ENT-PROTN-LINE Enter Protection Line

ENT-PROTN-LS Enter Protection Low Speed

ENT-ROLL-STS3 Enter Roll STS-3

ENT-rr Enter rr

ENT-STS1 Enter STS-1 Provision/Port
Options

ENT-SYS Enter System Edit/Change TID
Provision/Set NE

ENT-ULSDCC Enter Upper Layer Section DCC

ENT-USER-SECU Enter User Security

INH-MSG Inhibit Message

INIT-REG Initialize Register

INIT-SYS Initialize System

OPR-ACO Operate Alarm Cutoff

OPR-EXT-CONT Operate External Control

OPR-LPBK-EC1 Operate Loopback EC1

OPR-LPBK-OC3 Operate Loopback OC-3

OPR-LPBK-T3 Operate Loopback T3

OPR-PROTNSW-OC12 Operate Protection Switch OC-12

OPR-PROTNSW-OC3 Operate Protection Switch OC-3

OPR-PROTNSW-OC48 Operate Protection Switch OC-48

OPR-PROTNSW-STS3 Operate Protection Switch STS-3 Edit/Set DRI

OPR-PROTNSW-SWFBR Operate Protection Switch on Switch
Fabric

OPR-SYNCSW Operate Synchronization Switch

RLS-EXT-CONT Release External Control

RLS-LPBK-EC1 Release Loopback EC1

RLS-LPBK-OC3 Release Loopback OC-3

RLS-LPBK-T3 Release Loopback T3

RLS-PROTNSW-OC12 Release Protection Switch OC-12

RLS-PROTNSW-OC3 Release Protection Switch OC-3

RLS-PROTNSW-OC48 Release Protection Switch OC-48

RLS-PROTNSW-STS3 Release Protection Switch STS-3 Edit/Set DRI

RLS-PROTNSW-SWFBR Release Protection Switch on Switch
Fabric

RLS-SYNCSW Release Synchronization Switch

RTRV-AO Retrieve Autonomous Output

RTRV-ALM Retrieve Alarm and Status Conditions

RTRV-ALM-ENV Retrieve Alarm Environment

RTRV-ATTR-ALM Retrieve Attribute Alarm

RTRV-ATTR-CONT Retrieve Attribute Control

RTRV-rr Retrieve rr

RTRV-ATTR-rr Retrieve Attribute

RTRV-CKT-rr Retrieve Circuit rr
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TL1 Command Description CPro-2000

Menu Item

RTRV-COND Retrieve Condition Update/Alarms

RTRV-CRS-STS3 Retrieve Cross-Connection STS-3 Update/Cross
Connections

RTRV-EQPT Retrieve Equipment Update/
Network
Element
Inventory

RTRV-HDR Retrieve Header

RTRV-MAP Retrieve Map Ring

RTRV-MAP-NEIGHBOR Retrieve Map Neighbor

RTRV-MAP-NETWORK Retrieve Map Network

RTRV-MAP-RING Retrieve Map Ring Update/
SubNetwork
Map

RTRV-PM Retrieve Performance Monitoring Reports/PM
Data

RTRV-PROT-rr Retrieve Protection rr

RTRV-PROTN-LINE Retrieve Protection Line

RTRV-PROTN-LS Retrieve Protection Low Speed

RTRV-PTHTRC-rr Retrieve Path Trace rr

RTRV-rr Retrieve rr Provision/Port
Options

RTRV-SYS Retrieve System

RTRV-TH Retrieve PM Thresholds

RTRV-TMSLT-rr Retrieve Timeslot rr

RTRV-ULSDCC Retrieve Upper Layer Section DCC

RTRV-USER-SECU Retrieve User Security

SET-ATTR-rr Set Attribute rr

SET-ATTR-ALM Set Attribute Alarm

SET-ATTR-CONT Set Attribute Control

SET-ATTR-ENV Set Attribute Environment

SET-SID Set Site ID

SWITCH-TOPROTN Switch to Protection

SWITCH-TOWKG Switch to Working

UPDATE-SYS Update System
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FT-2000 OC-48 User Service Manual Task-Oriented
Procedures

Purpose
The purpose of this section is to provide a cross-reference between the TOPs section of
the Lucent Technologies FT-2000 OC-48 User/Service Manual and the menu

items of CPro-2000.

Cross-Reference Table for Tasks Supported in CPro-2000
The following table provides a cross-reference between the CPro-2000 capabilities and the
FT-2000 OC-48 TOPs. Not every step in every one of the identified TOPs may be supported
in CPro-2000. The following table only means that significant steps of the TOPs identified in
the following table will be helped by the use of CPro-2000. Wherever the TOP calls for use of
a particular TL1 command that is not supported in the CPro-2000 menu, it is assumed that the

user will enter such commands directly from the AUI window.

TOP Number

Supported by

CPro-2000

Description

Circuit Order:

NTP-002 Add DS3 and/or EC1 Low-Speed Port(s)

NTP-003 Delete DS3 and/or EC1 Low-Speed Port(s)

NTP-010 Add OC3 Low-Speed Slot(s)

NTP-011 Delete OC3 Low-Speed Slot(s)

Operation:

NTP-003 Establish Dual-Ring Interworking (DRI) Connections

NTP-004 Disconnect Dual-Ring Interworking (DRI) Connections

Detailed Level:

DLP-517 Provision Low-Speed Slot and Port Parameters

DLP-522 Change a User's Login

DLP-536 Enter/Delete/Edit STS-3 Cross Connections at Network
Element for 2-Fiber Ring Network
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Appendix D.
Script and Batch Files

Overview
CPro-2000 supports user-created files. These files, known in CPro-2000 as script and batch
files, are created using the same set of command statements. These are described in the
following section, “Supported Statements.” Although script and batch files are essentially

similar, CPro-2000 differentiates between them as follows:

•  Script files may be used effectively with CPro-2000 for the initial connection to the
subnetwork.

•  Batch files are used to execute a series of commands without the need for user input.

Script and batch files may be run from the AUI under the Run/Script menu, or from the GUI
under the Access/Run Batch Commands menu.

See the “Script Files” and “Batch Files” sections later in this chapter for a description of how
these two types of user-created files can be used effectively with CPro-2000.

 NOTE: The following rules apply to script and batch files:

•  Commands are NOT case-sensitive.

•  Indentations are permitted.

•  There are no special naming conventions for a script or batch file, although it is
recommended that you append a .scr extension to your script file names.

•  Special characters, such as \r (which equals a carriage return), can be included in the
file.
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Supported Statements

TRANSMITT string
Outputs string at the COM port, where string is any string of text enclosed between double
quotations. If transmitting a TL1 command, a WAITFOR statement must follow the

TRANSMITT string.

Examples:

TRANSMITT "ho/port1"

transmitt "rtrv-eqpt:all\r"

waitfor "\0;\0"

DIALNUMBER string
Connects to the COM port and dials the given telephone number with pulse or tone mode,
where string is enclosed between double quotations and consists of two parts. The first part is
either P for Pulse or T for Tone mode. The second part is the phone number, which may

contain dashes or spaces.

If an error occurs, this command raises the DIALNUMBER-FAIL flag.

Examples:

DIALNUMBER "P 1-908-555-1212"

dialnumber "T 1 908 555 1212"

 NOTE: This command connects to the COM port, so do not attempt to connect to the COM
port before running this command.

WAITFOR string
Waits for any of a list of tokens from the COM port, where string is enclosed between double
quotations and contains up to 20 tokens separated by \0.

If an error occurs, this command raises the WAITFOR-FAIL flag.

Examples:

WAITFOR "DESTINATION:\0login<\0"

waitfor "<\0"

PAUSE nWaitTime
Waits for specified milliseconds, where nWaitTime is a specified wait time in milliseconds
with a maximum of 2,147,483,647.

Example:

PAUSE 1000

DIALCANCEL
Disconnects the phone connection established through DIALNUMBER.
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IF condition
The IF statement allows statements under "IF" to be included between { and }. On condition
false, it goes to an ELSE statement or to the next statement. Condition can be one of the

following: WAITFOR-FAIL, DIALNUMBER-FAIL, or CONNECT-FAIL.

Examples:

IF WAITFOR-FAIL

{

user-msg "Token not received"

transmitt "\r"

}

if connect-fail

{

error-msg "Unable to connect the COM port:exiting"

exit

}

ELSE
This is a "C" like ELSE statement that allows statements under ELSE to be included between

{ and }. On condition false, the execution goes to the ELSE statement.

Examples:

IF WAITFOR-FAIL

{

user-msg "Token not received"

transmitt "\r"

WAITFOR "DESTINATION: \0"

}

ELSE

{

user-msg "Logging into the system"

transmitt "\r"

pause 500

}

if connect-fail

{

error-msg "Unable to connect the COM port: exiting"

exit

}

else

user-msg "Connected to the COM port"

USER-MSG string
Puts message box on screen containing the string, where string is any string of text enclosed
between double quotations.



322 ••••  Appendix D. Script and Batch Files CPro-2000 User Manual Rele

ase 11.0

Example:

USER-MSG "Command completed successfully"

ERROR-MSG string
Puts error message box on screen containing the string, where string is any string of text
enclosed between double quotations.

Example:

ERROR-MSG "Cannot log into the system"

EXIT
Terminates script execution with error.

END
Terminates script execution normally.

TEMP_EXIT
Provides a recallable exit point from the script file and stops the script execution temporarily.
CPro-2000 keeps a marker (LAST_EXIT_POINT) where the execution is halted. When you
execute the same script again, it optionally allows you to run it from the point where it halted

previously. This statement should be used with STEP_label, where label is any word.

NOTE: The TEMP_EXIT statement syntax is similar to the GOTO statement and can be used
the same way.

Example:

#STEP_START

; If this step fails: quit, fix error, and execute this
; step again from its beginning

TEMP_EXIT

NOTE: The label must be specified in the script file; it should be preceded by a "#" and
appended by a colon (for example "advice:").

GOTO label
This is a "C" like GOTO statement that starts execution from the next line label, where label

is any word.

Examples:

GOTO CONNECT-ERROR

goto advice

NOTE: The label must be specified in the script file; it should be preceded by a "#" and

appended by a colon (for example "#advice:").
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CONNECT
Connects to the COM port.

NOTE: COM port settings are specified with the SETTINGS command. The default settings
are "COM2:9600,e,7,1,none."

SETTINGS string
Sets the COM port to given settings, where string is enclosed between double quotations and
contains the following, in sequence:

1. COM port name (for example, COM1 or COM2) (This setting may be excluded.)

2. colon (This is excluded if the COM port name is not specified.)

3. baud rate (for example, 9600 or 4800)

4. comma

5. parity (for example, e, o, or n)

6. comma

7. data bits (for example, 7 or 8)

8. comma

9. stop bits (for example, 1 or 2)

10. comma

11. handshaking

This command can be used before or after connecting to a COM port.

Examples:

SETTINGS "COM1:9600,e,7,1,none"

settings "4800,8,2"

DISCONNECT
Disconnects from the COM port.

{
The open bracket symbol used in an IF or ELSE statement.

}
The close bracket symbol used in an IF or ELSE statement.

;string
A semicolon symbol used at the beginning of a statement that indicates that this line contains
a comment, where string is the comment.
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Example:

;This is a comment

Functions
The use of functions is supported in CPro-2000 script and batch files. Functions can be used
to do repetitive blocks of commands.

The following conditions apply to using functions in a CPro-2000 script or batch file:

•  Function definitions should be kept at the very end of a script or batch file, following
END or EXIT statements.

•  A maximum of 10 parameters are permitted in a function.

•  Do not use a GOTO statement inside of a function, unless it is within a compound
statement like IF.

•  A GOTO statement cannot be used to go to a label outside the function definition.

•  You can nest other functions calls within a function.

•  If a TEMP_EXIT is called from inside a function, it searches for the exit label that
appears before the start of the function call, not from before its definition.

•  If you use < or > as part of your parameter, you must precede them with a backslash
(\).

Function Syntax
A function definition appears as shown below.

FUNCTION function_name (no_of_parameters)

{

; executable function script lines

; the parameters are referenced by their order

; the nth parameter is referenced as % (n)

; a function does not return any value

}

A function calling appears as shown below.

CALL "function_name<parameter list,each enclosed in two< >s >"

Function Example
Shown below is an example of how a function can be used in a script or batch file. A function
can be used in all situations where a WAITFOR statement is going to be used. In this

example, the function is handling the time spent waiting for a response from an NE.
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FUNCTION WAITING (2)

{

waitfor "%(1)'

ifwaitfor-fail

{

user-msg "%(2)"

exit

}

}

The call to this sample function might look something like the following:

CALL "WAITING<DESTINATION:><Destination prompt not found.>"

Macros
Macros provide the ability to put a variable into the body of a script file, supply a prompt
string for the variable, and supply a default value for the variable. When the script is run, the
user is prompted (using the prompt string provided) for a value of the variable, or the default

value is entered by CPro-2000. So whenever user input is desired, you can use a macro.

Macros should be used like mini-functions. For example, macros can be used if the user needs
to enter a login ID and password. The macro definitions would look like the following:

LOGIN_ID=Enter your login ID here:,

PASSWORD=Enter your password here:,

Since these macro definitions have no default value and no range of valid values, they contain
a colon (:) at the end of them. The following is an example of how to use the sample macro

definitions listed above:

transmitt "$(LOGIN_ID)\r"

transmitt "$(PASSWORD)\r"

These commands cause the login ID and a carriage return to be sent to the NE. Then the
password and another carriage return are sent to the NE.

Macros may also be used inside commands that are used to modify parameter values on an
NE. The following example macro definition asks the user to enter the value for a parameter:

PARAMETER=Enter User Side/Network Side Value:,us

This macro definition has no range of values, but it contains the default us. The following is
an example of how this macro definition might be used:

transmitt "no(PARAMETER);"

The following conditions apply to using macros in a script or batch file:

•  Any number of macros can be used in one script line.

•  A macro can be used anywhere in a script, any number of times; however, there can
only be one definition for each macro.

•  The input range shown in the dialog box (see "Macro Example") does not apply any
validation for the value typed in by the user.

•  There is no data type associated with the input value. It is treated as a character string.
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Macro Syntax
To define a macro, place a macro definition statement at the end of the script file. When
CPro-2000 is r

unning a script and finds a macro, the macro definition statement supplies the

necessary information to prompt the user for a value or to supply a default value.

A macro is called into a script using the following syntax

any_script_statement  "....$(MACRO_NAME)..."

where the macro name is enclosed by parentheses and preceded by a $ sign. MACRO_NAME
gets a value returned from the macro definition and uses that value to execute the script

statement.

Macro definition statement syntax is shown below

MACRO_NAME=Prompt line:Range of valid values, [Default value]

where the syntax contains the following elements:

•  macro name followed by "="

•  prompt line terminated by a ":"

•  string containing a range of values followed by a ","

•  default value (optional)

Macro Example
First the macro call appears in the script file, as shown in the following sample:

  transmitt "set-attr-alm:almdel=$(ALARM_DELAY);"

The macro definition appears at the end of the script file, as shown in the following sample:

  ALARM_DELAY=Enter the alarm holdoff delay (in seconds):0-32,2

This macro example causes a dialog box to display (if you are in Expert mode) with the
message prompt "Enter the alarm holdoff delay (in seconds)" and an input range of values of
0-30. A text input field for typing in the value also appears in the dialog box. Press Return to

accept the value.

Using Functions and Macros Together
Macros can be used to allow the user to supply values to a function during its execution. In
the following example, when the function is called, the user is asked for the value of the
DSNE parameter, the value of the AGNE parameter, and to enter three additional parameters
and values. (If the user does not have three additional parameters to enter, they can send

carriage returns for each prompt.)
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The function definition:

  FUNCTION MY_SET_NE(5)

 {

   transmitt "set-ne:dsne=%(1),agne=%(2),%(3),%(4),%(5);"

   CALL "WAITING <Execute?><The set-ne command had problems.>

   transmitt "y\r"

   CALL "WAITING<<><The set-ne command failed.>"

 }

The function call:

   CALL "MY_SET_NE<$(DSNE_Vlaue)><$(AGNE_Value)><$(ANY_PARA)>

   <$(ANY_PARA)><$(ANY_PARA)>

The macro calls:

   DSNE_Value=Enter DSNE Value (Yes/No):.No

   AGNE_Value=Enter AGNE Value (Yes/No):,No

   ANY_PARA=Enter the parameter and its value, like this --
TID=newtid;,

CAPTURE Command
The CAPTURE command provides the ability to capture terminal output to a file.

The syntax of the CAPTURE command is shown below

CAPTURE "filename "

where filename  is any valid file path name. If the file name is OFF, then the current
capturing, if ON, is stopped.

An example is shown below.

CAPTURE "myrep.log"

NOTE: If the specified file name already exists, the user is asked whether the file should be
overwritten.

Script Files
CPro-2000 script files may contain data communications parameters, such as PC settings,
dial-up commands, and information for connecting to the local node. The script file should
not include any commands that actually log the user into CPro-2000. The script file should

only get the user to the point where the CPro-2000 GUI starts the login process.

A simple data communications script is provided with CPro-2000, called DEFAULT.SCR.
(For aExample Data Communications Script File, see the sample at the end of this appendix.)

CPro-2000 uses this script unless a different script file name is specified.
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The DEFAULT.SCR file contains the following lines:

settings “ com1:9600,e,7,1,none”

connect

if connect-fail

{

user-msg “ Could not connect to COM1.”

exit

}

end

This simple script file allows the user to access the communications port on the PC and then
stops. Listed below is a detailed explanation of each line in the script file.

•  settings “com1:9600,e,7,1,none”

This line is usually the first line of any script file. It indicates which line communicates
with the subnetwork.

- com1  is the communications port on the PC that is used to connect the NE.

- 9600  indicates that the communications are at 9.6 Kbps.

- e  indicates that the parity is even.

- 7  indicates that there are 7 data bits.

- 1  indicates that there is 1 stop bit.

- none indicates that there is no handshaking.

•  connect

This line causes the AUI to access the communications port identified in the settings
command, using the speed, parity, data, and stop bit information provided.

•  if connect-fail

This line allows the user to define what happens if the AUI is unable to connect to
the communications port on the PC.

•  {

 user-msg “Could not connect to COM1.”

 exit

 }

 The open ({ ) and close (} ) brackets are used with any command that begins
with if . The brackets always stand alone on a line as shown above. In this case,
the brackets indicate that execution of the commands between the brackets is
optional. The commands between the brackets are executed only if no
connection is made. If the connection attempt is successful, the next command

following the brackets is executed (in this example, the end  command).

 The command user-msg  prints a message to the screen indicating to the user
that the connection attempt was unsuccessful. The text in quotation marks
following this command is displayed on the GUI window until the user clicks on

the OK button in the message box.
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 The exit  command causes the script file to stop.

•  end

This line indicates to CPro-2000 that there are no more lines in the script file to be

executed and that the login process can now begin.

Batch Files
Batch files are similar to script files. The same commands used in a script file are often found
in a batch file, but are used in different ways. Examples of how batch files are used include

the following:

•  installation commands necessary for a technician to do a rapid turnup of a network
element, including any initialization tasks

•  a group of commands that may or may not be supported by CPro-2000

The batch file allows a user to do many commands by executing one file, such as polling the
subnetwork twice a day and displaying an NE alarm report at each node.

Troubleshooting Script and Batch Files
The following paragraphs contain useful information for creating and using script or batch
files.

General Problems
Although timing problems are the most common, users should be aware of other types of
script or batch file problems:

•  incorrect port settings, login IDs, and passwords

•  syntax problems, such as missing brackets around optional command groups and the
correct use of the TRANSMITT command (For a DDM-2000, if certain commands
being sent with the transmitt command end with a semicolon, they should not be
followed by a carriage return (\r). However, this is not true for all DDM-2000

commands or for any FT-2000 commands.)

Timing Problems
The most difficult aspect of creating a script or batch file is to ensure that there are
appropriate PAUSE and WAITFOR commands in the file, as described in the following
paragraphs. The best way to verify that the timing is effective is to set up the file and test it.

Continue to test and make modifications to the timing until the file is correctly established.
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Command Output

If a user is sending a command to an NE and wants to see the NE’s response to the command
in the AUI, a WAITFOR command must follow the TRANSMITT command in the script or

batch file.

Typically, for an FT-2000 OC-48 NE, the WAITFOR statement contains a semicolon (;) and
for a DDM-2000, the WAITFOR statement contains a greater than sign (>). The semicolon

and > are the prompts used by an NE to indicate that it is ready for further user input.

The Pause Command

The pause command, used in the format PAUSE ####, can be used to tell CPro-2000 not to
send anything to an NE for a defined period of time. The number that follows pause is a
quantity of microseconds. For example, PAUSE 1000 means wait for one second and PAUSE
40000 means wait for 40 seconds. The pause quantity should be modified to meet your

specific needs.

The most common use of the PAUSE command is for a WAITFOR “XXX” statement, where
XXX is an action that may not work correctly. For example, after logging into a DDM-2000,
but before the user prompt appears, the system requests the user to supply a carriage return.

Instead of using WAITFOR “carriage return to continue,” the script can simply PAUSE 1000.

Example Data Communications Script File
The text shown below is a sample data communications script file.

;-----------------start of script--

---------------------

settings "com2:9600,n,8,1,none"

connect

pause 500

transmitt "\r"

pause 500

if connect-fail

{

user-msg "The connection attempt to the comport failed."

exit

}

transmitt "\r"

pause 1000

transmitt "\r"

pause 1000

transmitt "\r"

pause 1000



CPro-2000 User Manual Release 11.0 Appendix D. Script and Batch Files••••  331

waitfor "DESTINATION: \0"

if waitfor-fail

{

error-msg "No DESTINATION: prompt was found."

goto DISCONNECT

}

pause 500

; In the following line, you can replace the macro call
$(CONNECT_STRING)

; with an actual connection string.

; Alternatively enter a default value in the macro definition below

transmitt "$(CONNECT_STRING)\r"

pause 500

transmitt "\r"

pause 500

transmitt "\r"

pause 500

transmitt "\r"

pause 1000

end

#DISCONNECT:

disconnect

exit

;You can create a default for this macro by entering a value
;following the last  ,

CONNECT_STRING=Enter the connect string:{a-z...},

;---------------------end of script

---------------------------------
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Example Modem Script File
This sample modem script file works with Hayes-compatible fax/data modems. This script,
called modem.scr, is included with your CPro-2000 software and can be modified to work

with other modem types.

settings “ com1: 9600, e, 7, 1, none”

connect

; At the following line, replace phone_number with actual phone
;number

transmitt “ atdtphone_number\r”

WAITFOR “ login<\0”

if waitfor-fail

{

WAITFOR “ login<\0”

if waitfor-fail

{

WAITFOR “ login<\0”

if waitfor-fail

{

error-msg “ No login< prompt was found...”

disconnect

exit

}

}

}

user-msg “ End of script”

end
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Appendix E.
Backup/Restore Parameters

Backup/Restore Overview
The CPro-2000 Backup command is used to create backup files of the current
equipage, cross connections, and provisionable parameters of a network element
node. The files created during a backup can then be used by the CPro-2000 Restore
command for restoration of this data at a later date. (See the Edit Menu chapter for
information on how to backup and restore files.)

Cross-Reference Tables for CPro-2000 Backup/Restore
Commands

The following tables provide a cross-reference between the CPro-2000
Backup/Restore command parameters and the supported network element releases.
For more information on the commands used in backup and restore, see the Lucent
Technologies User Service Manual for the appropriate network element release.
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Backup/Restore Commands, Parameters and Release Relation Table

for

FiberReach with TL1

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

System ent-sys rtrv-sys new_tid

rnestat

almgrp

agne

co/rt
idle

x

x
x

x

x
x

x

x

x

x

x
x

System ent-cid-secu rtrv-cid-secu state
tmout

porttype

echo

baudrate

x
x

x
x

x
x

x

x

x

System rtrv-user-secu uid
uap

x
x

x
x

x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
msgtype

x
x

x
x

x
x

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

x
x
x
x

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Comm ent-ulsdcc-l4 rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Comm ent-ulsdcc-l4

rtrv-ulsdcc-l4

l4ajnsap

l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

Manual Adjacency x

x
x
x
x
x

x

x
x
x
x
x

x

x
x
x
x
x

Comm ent-ulsdcc-l4

rtrv-ulsdcc-l4

l4tdctid
l4tdcnsap

l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys

TARP Data Cache x
x

x
x
x
x
x
x
x

x
x

x
x
x
x
x
x
x

x
x

x
x
x
x
x
x
x

Comm ent-fecom rtrv-fecom communications
side

Only for the local NE x
x

x
x

x
x

Feature ent-feat rtrv-feat vtpm
ds1pm

x
x

x
x

x
x

Sync ent-syncn rtrv-syncn syncnmode
syncfunction
sync auto config

x
x

x
x
x

x
x
x

Alarm set-attr-alm rtrv-attr-alm almdel
clrdel
pmn

x
x
x

x
x
x

x
x
x

Alarm set-attr-env rtrv-attr-env ntfcnde
almmsg
almtype

RT only x
x
x

x
x
x

x
x
x

Alarm set-attr-cont rtrv-attr-cont conttype RT only x x x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Port & Line ent-t1 rtrv-t1 linecde
ntfcncde
bpv
ais
sfthr
pmmd
fmt
pst

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

Port & Line ent-t3 rtrv-t3 ntfcncde
ais
sfthr
vmr mode
fmt
pmmd
frame
linecode
pbit
xbit
pst

With DS3 in fn slots x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

Port & Line ent-oc12 rtrv-oc12 sfthr

syncmsg

aisnc

dccmode

If main slots are
equipped with 29G

x

x

x

x

Port & Line ent-oc3 rtrv-oc3 sfthr
syncmsg
aisnc

dccmode

If main slots are
equipped with 28G

x
x
x

x
x
x

x

Port & Line ent-oc1 rtrv-oc1 aisnc
sfthr
pst

x
x

x
x

x
x

Channel ent-crs-vt1 rtrv-crs-vt1 x x x

Channel ent-crs-sts1 rtrv-crs-sts1 x x x

Channel ent-vt1 rtrv-vt1 sfthr
aisncsa
alsnc
pst

x
x
x
x

x
x
x
x

x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Channel ent-sts1 rtrv-sts1 sfthr
sfail
aisncsa
aisnc
pst
lop 22 type OLIU in fn slot

x
x
x
x

x
x
x
x
x

x
x
x
x
x

Perf rtrv-th-all x x x

Perf set-th-sts1 b3 cv p
b3 es p
b3 esa -p
b3 esb -p
b3 ses p
b3 uas p

see SpecCond-630 x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-vt1

v5 es p
v5 ses p
v5 uas p

ENT-FEAT VT1pm
     enabled
See SpecCond-630

x
x
x

x
x
x

x
x
x

Perf set-th-t1

cvp
cvp
esp
sesp
uasp
cvpfe
espfe
sespfe
uaspfe

ENT-FEAT DS1pm
     enabled
See SpecCond-630
modifier = SF
modifier = ESF

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Perf set-th-t3 rtrv-th-t3 cv l
es l
esa –l
esb –l
ses l
uas l
oof

When DS3 in function
slot

x
x
x
x
x
x
x

x
x
x
x
x
x
x

Perf set-th-oc1
cv l
es l
esa -l
esb -l
ses l
uas l
oof

See SpecCond-630
x
x
x
x
x
x
x

x
x
x
x
x
x
x

x
x
x
x
x
x
x

Perf set-th-oc3 cv l
es l
esa –l
esb –l
ses l
uas l
oof

Equipped with 28G-U
only

x
x
x
x
x

x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

FiberReach with MML

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

System set-ne rtrv-ne tid
co/rt

rnestat

almgrp

agne

idle channel signal

x
x

x

x
x

x

x
x

x

x

x

x

Security set-secu rtrv-secu security
timeout

porttype

echo

baudrate

x
x

x
x

x
x

x

x

x

Security rstr-psswrd rtrv-psswrd login
user type

x
x

x
x

x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
message type
action

x
x
x

x
x
x

x
x
x

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

x
x
x
x

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Comm ent-ulsdcc-l4 rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Comm ent-ulsdcc-l4
rtrv-ulsdcc-l4

l4ajnsap

l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

Manual Adjacency x

x
x
x
x
x

x

x
x
x
x
x

x

x
x
x
x
x

Comm ent-ulsdcc-l4

rtrv-ulsdcc-l4

l4tdctid
l4tdcnsap

l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys
l4tdcsel

Not required to handle
TARP Date Cache

Comm set-fecom rtrv-fecom communication
dcc ns/us

Only for the local NE x
x

x
x

x
x

Feature set-feat rtrv-feat feature option
action

x
x

x
x

x
x

Sync set-sync rtrv-sync mode switching
syn source
autoconfiguration

x
x

x
x
x

x
x
x

Alarm set-attr-alm rtrv-attr-alm alarm delay
clear delay
pmn

x
x
x

x
x
x

x
x
x

Alarm set-attr-env rtrv-attr-env alarm
alarm type

RT only x
x

x
x

x
x

Alarm set-attr-cont rtrv-attr-cont description RT only x x x

Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with MML (continued)
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Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Port & Line set-t1 rtrv-t1 line code
alarm level
ais
failure thrshld
dlcbpv  to los
state
pm mode
format

Need DS1 PM pack

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

Port & Line ent-t3 rtrv-t3 ntfcncde
ais
sfthr
vmr mode
fmt
pmmd
frame
linecode
pbit
xbit
pst

With DS3 in fn slots x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

Port & Line set-oc12 rtrv-oc12 nsa ais

sig degrade thres

syncmsg

dccmode

Main slots equipped with
29G-U

x

x

x

x

Port & Line set-oc3 rtrv-oc3 nsa ais
sig degrade thres
syncmsg

dccmode

Main slots equipped with
28G-U

x
x
x

x
x
x

x

Port & Line set-oc1 rtrv-oc1 nsa ais
sig degrade thres

x
x

x
x

x
x

Port & Line set-state-t1 rtrv-t1 primary state x x x

Port & Line set-state-t3 rtrv-t3 primary state x x

Port & Line ent-crs-vt1 rtrv-crs-vt1 x x x

Port & Line ent-crs-sts1 rtrv-crs-sts1 x x x

Channel set-vt1 rtrv-vt1 signaldegradethres
sa ais
nsa ais

x
x
x

x
x
x

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Channel set-sts1 rtrv-sts1 signaldegradethres
signal failure
sa ais
nsa ais

x

x
x

x

x
x

x

x
x

Channel set-state-vt1 rtrv-vt1 primary state x

Channel set-state-vt1 rtrv-state-vt1 primary state x x

Channel setstate-sts1 rtrv-state-sts1 primary state x x

Channel set-state-stst1 rtrv-sts1 primary state x

Perf set-pmthres-sect rtrv-pmthres-sect ses See SpecCond-630 x x x

Perf set-pmthres-line rtrv-pmthres-line
b2 cv (oc3)
b2 cv (oc1)
b2 es
b2 esa
b2 esb
b2 ses
uas

See SpecCond-630
OC3 for 28G-U only x

x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-pmthres-sts1 rtrv-pmthres-sts1
b3 cv
b3 es
b3 esa
b3 esb
b3 ses
b3 uas

See SpecCond-630
x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-pmthres-vt1 rtrv-pmthres-vt1
v5 es
v5 ses
v5 uas

See SpecCond-630
x
x
x

x
x
x

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FiberReach with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 3.0 3.1 4.0

Perf set-pmthres-t1 rtrv-pmthres-t1
es l
cv p sf
cv p esf
esp
sesp
uasp
cvpfe
espfe
sespfe
uaspfe

See SpecCond-630
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

Perf set-pmthres-t3 rtrv-pmthres-t3 cvl
es l
sesl
sefs
pcv
fmcv
cp
esp
sesp
uasp
sefsfe
cpfe
espfe
sespfe
uaspfe

For DS3 in fn slots x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

DDM OC-3 with TL1

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Switch rtrv-sys product id x x x

Switch rtrv-ow orderwire mode Need BBG10 x x x

System ent-sys rtrv-sys new_tid

rnestat

almgrp

agne

shelf
cort
idle
x25ps

x

x
x
x
x

x

x
x
x
x

x

x

x

x

x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

System ent-cid-secu rtrv-cid-secu state
tmout

porttype

echo

baudrate

x
x

x
x

x
x

x

x

x

System rtrv-user-secu uid
uap

x
x

x
x

x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
msgtype

x
x

x
x

x
x

Comm ent-osacmap rtrv-osacmap vc
snpa
acid

x
x
x

x
x
x

x
x
x

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

x
x
x
x

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Comm ent-ulsdcc-l4 tdc x x x



346 ••••Appendix E. Backup/Restore Parameters CPro-2000 User Manual Release 11.0

Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Comm rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajnsap
l4tdctid
l4tdcnsap

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

Comm ent-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

Comm set-fecom rtrv-fecom communications
side

Local restoration only x
x

x
x

x
x

Feature ent-feat rtrv-feat sts3
vtpm
ds1pm

x
x

x
x

x
x

Sync ent-syncn rtrv-syncn syncnmode
syncfunction
aisthres
mdsw
src main1 or main2

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Switch rtrv-syncn provisioned mode x x x

Alarm ent-attr-alm rtrv-attr-alm almdel
clrdel
pmn

x
x
x

x
x
x

x
x
x



CPro-2000 User Manual Release 11.0 Appendix E. Backup/Restore Parameters ••••  347

Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Alarm ent-attr-env rtrv-attr-env ntfcnde
almmsg
almtype

RT only x
x
x

x
x
x

x
x
x

Alarm ent-attr-cont rtrv-attr-cont conttype RT only x x x

Port & Line ent-lan rtrv-lan grpid

aal5

vpi

vci

frm_lgth

scrambler

polynom

fcs

almlvl

pmmd

x

x

x

x

x

x

x

x

x

x

Port & Line ent-nct rtrv-nct ctsenabled
cts
tcts
mode

x
x
x
x

x
x
x
x

x
x
x
x

Port & Line ent-oc3 rtrv-oc3 syncmsg
aisnc
sfthr
concat
radio

application

dccmode

not applicable OC-3
MegaStar only

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

x

x

Port & Line ent-oc12 rtrv-oc12 syncmsg
aisnc
sfthr

dccmode

Only if equipped with
24G or 29G OLIU

x
x
x

x
x
x

x
x
x

x

Port & Line ent-t1 rtrv-t1 linecde
ntfcncde
bpv
ais
sfthr
pmmd
fmt

HW, with override

only DS1 PM

x
x
x
x
x
x
x

x
x
x
x
x
x
x

x
x
x
x
x
x
x



348 ••••Appendix E. Backup/Restore Parameters CPro-2000 User Manual Release 11.0

Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Port & Line ent-t3 rtrv-t3 ntfcncde
ais
sfthr
vmr mode
fmt
pmmd
frame
linecode
pbit
xbit
aisalm

DS3-out from BBG20
for BBG20

x
x
x

x
x
x
x
x
x
x

x
x
x

x
x
x
x
x
x
x

x
x
x

x
x
x
x
x
x
x

Port & Line ent-ec1 rtrv-ec1 sfthr
ntfcncde

x
x

x
x

x
x

Port & Line ent-oc1 rtrv-oc1 aisnc
sfthr

x
x

x
x

x
x

Port & Line ent-t1 rtrv-t1 pst x x x

Port & Line ent-t3 rtrv-t3 pst x x x

Port & Line ent-ec1 rtrv-ec1 pst x x x

Port & Line ent-oc1 rtrv-oc1 pst x x x

X-conn ent-crs-sts3C rtrv-crs-sts3c Only with 24G or 29G x x x

X-conn ent-crs-sts1 rtrv-crs-sts1 x x x

X-conn ent-crs-vt1 rtrv-crs-vt1 x x x

Channel ent-vt1 rtrv-vt1 sfthr
aisncsa
alsnc
pst

x
x
x
x

x
x
x
x

x
x
x
x

Channel ent-sts1 rtrv-sts1 sfthr
sfail
aisncsa
aisnc

x
x
x

x
x
x

x
x
x

Channel ent-sts1 rtrv-sts1 pst x x x

Perf rtrv-th-all See SpecCond-630 x x x

Perf set-th-oc3 pwr
bias

x
x

x
x

x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Perf set-th-oc3 oof
b2 cv l
b2 es l
b2 esa -l
b2-esb -l
b2 ses l
b2 uas l
psc-l

See SpecCond-630
x
x
x
x
x
x
x

x
x
x
x
x
x
x

x
x
x
x
x
x
x

Perf set-th-sts1
cv p
es p
esa -p
esb -p
ses p
uas p

See SpecCond-630
x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-t3 p-bit ec
sefs

Perf set-th-t3
oof (fend)
cvp (fend)
esp (fend)
sesp (fend)
uasp (fend)
sesf

See SpecCond-630
x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Perf set-th-t3
cvl (nend)
esl (nend)
sesl(nend)
oof (nend)
cvp (nend)
esp (nend)
sesp (nend)
uasp (nend)

See SpecCond-630
x
x
x

x
x
x

x
x
x

Perf set-th-vt1
v5 es p
v5 ses p
v5 uas p

See SpecCond-630
x
x
x

x
x
x

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Perf set-th-t1
day esl (nend)
day cvp (nend)
day esp (nend)
day sesp (nend)
day uasp (nend)
day cvp (fend)
day esp (fend)
day sesp (fend)
day uasp (fend)

See SpecCond-630
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

Perf set-th-t1
qh esl (nend)
qh cvp (nend)
qh esp (nend)
qh sesp (nend)
qh uasp (nend)
qh cvp (fend)
qh esp (fend)
qh sesp (fend)
qh uasp (fend)

See SpecCond-630
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

DDM OC-3 with MML

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Switch rtrv-ne Product ID x x x

Switch rtrv-ow Orderwire mode BBG10 OHCTL needed x x x

System set-ne rtrv-ne tid
co/rt
idle channel signal
shelf

rnestat

agne

almgrp

x
x
x
x

x
x
x
x

x
x
x
x

x

x

x

System set-x25 rtrv-x25 PKT (size) x x x

Security set-secu rtrv-secu security
timeout

porttype

echo

baudrate

x
x

x
x

x
x

x

x

x

Security set-lgn rtrv-lgn login
User Type

x
x

x
x

x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
msgtype
action

x
x
x

x
x
x

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Comm ent-osacmap rtrv-osacmap vc type
snpa address
acid

x
x
x

x
x
x

x
x
x

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

x
x
x
x

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Comm ent-ulsdcc-l4 tdc_rpt

Comm rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajnsap
l4tdctid
l4tdcnsap

Not required to handle
TDC

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Comm ent-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

CPro parser issue
resolved in R8.0

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

Comm ent-ulsdcc-l4 l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys
l4tdcsel

Not required to handle
TDC

Comm set-fecom rtrv-fecom communication
DCC NS/US

Local restore only x
x

x
x

x
x

Feature set-feat rtrv-feat vtpm
ds1pm

x
x

x
x

x
x

Sync set-sync rtrv-sync mode switching
syn src
syn auto reconfig
omd

aisthres

BBF2B, line-timed,
and src set to fn-c
BBF2B, line-timed,
sync out

x
x
x
x

x

x
x
x
x

x

x
x
x
x

x

Switch rtrv-sync provisioned mode x x x

Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)
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Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Alarm set-attr-alm rtrv-attr-alm alarm delay
clear delay
pmn

x
x
x

x
x
x

x
x
x

Alarm set-attr-env rtrv-attr-env alarm
almtype
desc

RT only x
x
x

x
x
x

x
x
x

Alarm set-attr-cont rtrv-attr-cont desc RT only x x x

Port & Line set-t1 rtrv-t1 line coding
alarm level
dlc bpv tolos
ais
failure threshold
pm mode
format

only in PM pack
only in PM pack

x
x
x
x
x
x
x

x
x
x
x
x
x
x

x
x
x
x
x
x
x

Port & Line set-t3 rtrv-t3 alarm level
ais
failure threshold
mode
format
pm mode
frame
xbit
aisalm

DS3-out from BBG20
for BBG20

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

Port & Line set-ec1 rtrv-ec1 alarm level
signal degrade

x
x

x
x

x
x

Port & Line set-lan rtrv-lan grpid

aal5

vpi

vci

length

scrambler

polynom

fcs

alm

pmmd

x

x

x

x

x

x

x

x

x

x

Port & Line set-nct rtrv-nct ctsenabled
cts
tcts
mode

x
x
x
x

x
x
x
x

Port & Line set-oc1 rtrv-oc1 nsa ais
signal degrade thr

x
x

x
x

x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Port & Line set-oc3 rtrv-oc3 syncmsg (or type)
signal degrade thr
nsa ais

application

dcc mode

x
x
x

x
x
x

x
x
x

x

x

Port & Line set-oc12 rtrv-oc12 syncmsg (or type)
signal degrade thr
nsa ais

dcc mode

Only if equipped with 24G
or 29G OLIU

x
x
x

x
x
x

x
x
x

x

Port & Line set-state-t1 rtrv-t1 primary state x x x

Port & Line set-state-t3 rtrv-t3 primary state x x x

Port & Line set-state-ec1 rtrv-ec1 primary state fails if x-conn exist x x x

Port & Line set-state-oc1 rtrv-state-oc1 primary state x x x

Port & Line set-state-vt1 rtrv-state-vt1 primary state x x x

X-conn rtrv-crs x-connection type
ring id

X-conn ent-crs-sts3C Only with 24G or 29G x x x

X-conn ent-crs-sts1 x x x

X-conn ent-crs-vt1 x x x

Channel set-vt1 rtrv-vt1 signaldegrade thr
sa ais
nsa ais

x
x
x

x
x
x

x
x
x

Channel set-sts1 rtrv-sts1 signal degrade thr
signal failure
sa ais
nsa ais

x
x
x
x

x
x
x
x

x
x
x
x

Channel set state-sts1 rtrv-state-sts1 primary state x x x

Perf set-pmthres-sect rtrv-pmthres-sect
xmtr pwr 1db
xmtr pwr 2db
laser bias
sefs

See SpecCond-630
x
x
x
x

x
x
x
x

x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Perf set-pmthres-line rtrv-pmthres-line
b2 cv oc3
b2 cv oc1
b2 cv ec1
b2 es
b2 esa
b2 esb
b2 ses
b2 uas
psc-l

See SpecCond-630
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

Perf set-pmthres-sts1 rtrv-pmthres-sts1
b3 cv
b3 es
b3 esa
b3 esb
b3 ses
b3 uas

See SpecCond-630
x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-pmthres-t3 rtrv-pmthres-t3
cv-l
es-l
ses-l
sefs
pbit cv-p
cv-p
fmbit cv p
cbit cv p
es-p
ses-p
uas-p
sesfe
cbit cv p fe
es p fe
ses p fe
uas p fe

See SpecCond-630
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-3 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 13.0 13.5 15.0

Perf set-pmthres-vt1 rtrv-pmthres-vt1
v5 es
v5 ses
v5 uas

See SpecCond-630
x
x
x

x
x
x

x
x
x

Perf set-pmthres-t1 rtrv-pmthres-t1
day es-l
day cvpsf
day cvpesf
day esp
day sesp
day uasp
day cvpfe
day espfe
day sespfe
day uaspfe

See SpecCond-630
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

Perf set-pmthres-t1 rtrv-pmthres-t1
qh es-l
qh cvpsf
qh cvpesf
qh esp
qh sesp
qh uasp
qh cvpfe
qh espfe
qh sespfe
qh uaspfe

See SpecCond-630
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

DDM OC-12 with TL1

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Switch rtrv-sys product id x

System ent-sys rtrv-sys new_tid
cort
idle
shelf
x25ps

x
x
x
x
x

System ent-cid-secu rtrv-cid-secu state
tmout

x
x

System rtrv-user-secu uid
uap

x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
msgtype

x
x

Comm ent-osacmap rtrv-osacmap vc
snpa
acid

x
x
x

Comm ent-ulsdcc rtrv-ulsdcc l3org
l3res
l3rou
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

Comm ent-ulsdcc-l4 tdc x

Comm rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajnsap
l4tdctid
l4tdcnsap

x
x
x
x
x
x
x
x
x

Comm ent-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

x
x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Comm ent-ulsdcc-l4 l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys
l4tdcsel

Not required to handle
TDC

x
x
x
x
x
x
x
x

Comm rtrv-fecom communications side Local restore only x

Sync ent-syncn rtrv-syncn syncnmode
syncfunction
aisthres
mdsw
src
omd
track

with BBS2B cct pac

x
x
x
x
x
x
x

Switch rtrv-syncn provisioned mode x

Alarm set-attr-alm rtrv-attr-alm almdel
clrdel
pmn

x
x
x

Alarm set-attr-env rtrv-attr-env ntfcnde
almmsg
almtype

Only RT x
x
x

Alarm set-attr-cont rtrv-attr-cont conttype Only RT x

Alarm ent-asne

Port & Line ent-t3 rtrv-t3 pbit
ntfcncde
ais
sfthr
pst
fmt
pmmd
linecde

Enter separately

x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Port & Line ent-ec1 rtrv-ec1 pbit
ntfcncde
ais
sfthr
pst
fmt
pmmd

Enter separately

x
x

x
x
x
x

Port & Line ent-oc3 rtrv-oc3 kbyte
syncmsg (type)
sfthr
concat
pst
int applications
aisnc

Only for linear rel
Enter separately

x
x

x
x
x

Port & Line ent-oc12 rtrv-oc12 kbyte
syncmsg (type)
sfthr
aisnc

x
x
x

Port & Line ent-t3 rtrv-t3 pst x

Port & Line ent-ec1 rtrv-ec1 pst x

Port & Line ent-oc3 rtrv-oc3 pst x

Feature ent-feat rtrv-feat sts3c CONCAT enabled x

X-conn ent-crs-sts3c rtrv-crs-sts3c x

X-conn ent-crs-sts1 rtrv-crs-sts1 x

Channel ent-sts1 rtrv-sts1
sfthr
aisncsa
aisnc

x-conn must exist
AID must be “all” x

x
x

Channel ent-sts3c rtrv-sts3c

sfthr
aisncsa
aisnc

x-conn must exist
feat sts3c enabled
AID must be “all” x

x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Channel ent-sts1 rtrv-sts1 pst x

Channel ent-sts3c rtrv-sts3c pst x

Perf set-th-oc12 rtrv-th-oc12
oof
cv l
es l
esa -l
esb -l
ses l
uas l
psc-l

See SpecCond-630
"all" can be used to
retrieve all these
parameters-s

Starts from R8.0

x
x
x
x
x
x
x

Perf set-th-oc3 rtrv-th-oc3
oof
cv l
es l
esa -l
esb -l
ses l
uas l
psc-l

See SpecCond-630
"all" can be used to
retrieve all these
parameters-s

x
x
x
x
x
x
x
x

Perf set-th-sts1 rtrv-th-sts1
cv p
es p
esa -p
esb -p
ses p
uas p

See SpecCond-630
"all" can be used to
retrieve all these
parameters-s

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Perf set-th-t3 rtrv-th-t3
cvl (nend)
esl (nend)
sesl (nend)
oof (nend)
cvp (nend)
esp (nend)
sesp (nend)
uasp (nend)
oof (fend)
cvp (fend)
esp (fend)
sesp (fend)
uasp (fend)

See SpecCond-630
"all" can be used to
retrieve all these
parameters-s

x
x
x
x
x
x
x
x
x
x
x
x
x

Perf set-th-ec1 rtrv-th-ec1
cvl (nend)
esl (nend)
sesl (nend)
oof (nend)
cvp (nend)
esp (nend)
sesp (nend)
uasp (nend)
oof (fend)
cvp (fend)
esp (fend)
sesp (fend)
uasp (fend)

See SpecCond-630
"all" can be used to
retrieve all these
parameters-s

x
x
x
x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

DDM OC12 with MML

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Switch rtrv-ne product id x

Switch rtrv-ne co/rt selector

System set-ne rtrv-ne tid
co/rt
idle channel sig
shelf

x
x
x
x

System set-secu rtrv-secu security
timeout

x
x

Comm set-fecom rtrv-fecom communication
dcc ns/us

Local restore only x
x

Comm ent-tl1msgmap rtrv-tl1msgmap acid
tl1maintenance
tl1memoryadministration
tl1test
tl1peercom
tl1other1
tl1other2

x
x
x
x
x
x
x

Comm ent-osacmap rtrv-osacmap vc type
snpa address
acid

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Comm ent-ulsdcc rtrv-ulsdcc l3org
l3res
l3rou

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

Comm ent-ulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

Comm ent-ulsdcc-l4 tdc_rpt

Comm rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajnsap
l4tdctid
l4tdcnsap

Not required to handle
TDC

x
x
x
x
x
x
x

Comm ent-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

Parser issue resolved in
CPro R8.0

x
x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Comm ent-ulsdcc-l4 l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys
l4tdcsel

Not required to handle
TDC

System set-x25 rtrv-x25 pkt x

Sync set-sync rtrv-sync mode switch
syn source
syn auto reconfig

x
x

Switch rtrv-sync provisioned mode x

Feature set-feat rtrv-feat sts3c CONCAT enabled x

Alarm set-attr-alm rtrv-attr-alm alarm delay
clear delay
pmn

x
x
x

Alarm set-attr-env rtrv-attr-env alarm
almtype
desc

RT only x

Alarm set-attr-cont rtrv-attr-cont desc RT only x

Alarm ent-asne

Port & Line set-t3 rtrv-t3 mode
ais
alarm level
failure thrshld
state
fmt format
pm mode
frame
format

x

x
x

x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Port & Line set-state-t3 rtrv-t3 primary state x

Port & Line set-ec1 rtrv-ec1 alarm level
signal degrade thr

x
x

Port & Line set-state-ec1 rtrv-ec1 primary state x

Port & Line set-oc3 rtrv-oc3 kbyte message
syncmsg (or type)
signal degrade thr
concat mode
application (os3 i)
nsa ais

x
x

x
x

Port & Line set-state-oc3 rtrv-oc3 primary state x

Port & Line set-oc12 rtrv-oc12 kbyte message
syncmsg (or type)
signal degrade
nsa ais

x
x
x

Channel set-sts1 rtrv-sts1 signal degrade
sa ais
nsa ais

xconn must exist
AID must be "all"

x
x
x

Channel set-state-sts1 rtrv-sts1 primary state x

Channel set-sts3c rtrv-sts3c signal degrade
sa ais
nsa ais

xconn must exist &
feat sts3c enabled.
AID must be "all"

x
x
x

Channel set-state-sts3c rtrv-sts3c primary state x

X-conn set-crs rtrv-crs x connection type
ring id

x
x

X-conn set-crs-sts3c rtrv-crs-sts3c x

X-conn set-crs-sts1 rtrv-crs-sts1 x

Perf set-pmthres-sect rtrv-pmthres-sect
txpwr1db
txpwr2db
laser bias
sefs qhour
sefs day

See SpecCond-630
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for DDM OC-12 with MML (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 7.0

Perf set-pmthres-line rtrv-pmthres-line
b2 cv oc12
b2 cv oc3
b2 cv ec1
b2 es
b2 esa
b2 esb
b2 ses
b2 uas
psc-l

See SpecCond-630
x
x
x
x
x
x
x
x
x

Perf set-pmthres-sts1 rtrv-pmthres-sts1
b3 cv
b3 es
b3 esa
b3 esb
b3 ses
b3 uas

See SpecCond-630
x
x
x
x
x
x

Perf set-pmthres-t3 rtrv-pmthres-t3
cvl
esl
sesl
sefs
pcv
cv-p
fmcv
cp
esp
sesp
uas-p
sefsfe
cbit cv pfe
espfe
sespfe
uaspfe

See SpecCond-630
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table

for

FT-2000 with TL1

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

System rtrv-sys tid
agne_address
dsne_address
tsagran
sadd
dce
dte
baud_tl1-dce
baud_tl1-dte

tl1 or cit
tl1 or cit

x

x
x

x

x
x

x

x
x

System ent-sys new_tid use value of tid

System ent-sys rtrv-sys nid
dsne
gne
agne
almgrp
x25ps
protocol

Kills remote logins if
changed

0 to 255
256 or 128 x x x

Security ent-ne-secu rtrv-ne-secu alw_uid
page
uout

x
x
x

x
x
x

x
x
x

Security rtrv-cid-secu portstat
gnetid
uid

Not all parameters apply
to dte, dce, dcc, and x25.
Backup those reported

x
x
x

x
x
x

x
x
x

Security ent-cid-secu rtrv-cid-secu tmout
porttype
baudrate
chan
ostype
calladdr

Only restore backup
parameters

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Security ent-cid-secu portacc Only for dte and vc0 of
dcc.

x x x

Security rtrv-user-secu uid
uap
type
expdat

x
x
x
x

x
x
x
x

x
x
x
x

Comm ent-asgnmt-dcc rtrv-asgnmt-dcc dcc_chan
ortn

drops remote links x
x

x
x

x
x

Comm ent-fecom rtrv-fecom rar
roa

local restore only

Comm rtrv-ulsdcc-l3 l3idp
l3dfi
l3sys
l3sel

x
x
x
x

x
x
x
x

x
x
x
x

Comm entulsdcc-l3 rtrv-ulsdcc-l3 l3org
l3res
l3rd
l3area
l3lv2is

x
x
x
x
x

x
x
x
x
x

x
x
x
x
x

Comm ent-ulsdcc-l4 tdc x x x

Comm rtrv-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajnsap
l4tdctid
l4tdcnsap

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Comm ent-ulsdcc-l4 l4tlif
l4t1tm
l4t2tm
l4t3tm
l4t4tm
l4lftm
l4ajorg
l4ajres
l4ajrd
l4ajarea
l4ajsys

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x

Comm ent-ulsdcc-l4 l4etdc
l4tdctid
l4tdcorg
l4tdcres
l4tdcrd
l4tdcarea
l4tdcsys
l4tdcsel

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

Sync rtrv-sync
input_msg
output_msg
oper_e
oper_w
tg1_clk_sts
tg2_clk_sts

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Sync ent-syncn rtrv-syncn syncnmod
src
pds1_iof
sds1_iof
pds1_ilc
sds1_ilc
ds11_equ
ds12_equ

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Alarm set-attr-alm rtrv-attr-alm almdel
clrdel
tribrep

x
x
x

x
x
x

x
x
x

Alarm set-attr-env rtrv-attr-env ntfcncde
almmsg

x
x

x
x

x
x

Alarm set-attr-cont rtrv-attr-cont conttype x x x

Alarm rtrv-attr-all aidtype
locn
dirn
ntfcncde

speccond-640
always=nend
always=rcv

x
x
x
x

x
x
x
x

x
x
x
x

Alarm set-attr-t3 ntfcncde x x x

Alarm set-attr-oc3 ntfcncde x x x

Alarm set-attr-ec1 ntfcncde x x x

Alarm set-attr-oc12 ntfcncde x x x

X-conn ent-crs-sts1 rtrv-crs-sts1 cct
loca
locz
extra
oc3st
pst
sst
audit
redline

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

X-conn ent-crs-sts3 rtrv-crs-sts3 cct
loca
loca-nid
locz
locz-nid
extra
oc3st
pst
sst
audit
redline

x
x

x

x
x
x
x
x
x

x
x

x

x
x
x
x
x
x

x
x

x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Prov ent-oc3 rtrv-oc3 au4map
ntfcncde
syncmsg
oc3frmlgx
oc3tolgx
sdthr
sst

x
x
x
x
x
x
x

x
x
x
x
x
x
x

x
x
x
x
x
x
x

Prov ent-oc12 rtrv-oc12 au4map
ntfcncde
syncmsg
oc12frmlgx
oc12tolgx
oc12tdir
sdthr
sst

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x

Prov ent-oc48 rtrv-oc48 sdthr
syncmsg

fbyteproc

x
x

x
x

x
x

x

Prov ent-prot-sts1 rtrv-prot-sts1 protacc no STS3 NE in ring x x x

Prov ent-prot-sts3 rtrv-prot-sts1 protacc at least one STS3 NE in
ring

x x x

Prov ent-prot-line rtrv-prot-line wtr x x x

Prov ent-prot-ls rtrv-prot-ls wtr x x x

Prov rtrv-state sw_state
actswprty

use rtrv-state only to
restore nppa (removed
by cpro970966)

Prov rtrv-pthtrc-sts1 status
label
inctrc

x
x
x

x
x
x

x
x
x

Prov ent-sts1 rtrv-pthtrc-sts1
exptrc
trc
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Prov rtrv-all level
optlinecde
wavlnth
pyldfrmlgx
pyldtolgx
opoc3frmlgx
opoc3tolgx
proc3frmlgx
proc3tolgx
opoc12frmlgx
opoc12tolgx
proc12frmlgx
proc12tolgx
swprty
actswprty
gueswprty

speccond-640

for oc3frmlgx
for oc3tolgx

for oc12frmlgx
for oc12tolgx

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x
x
x
x
x
x
x
x

Prov ent-ec1 rtrv-ec1 ntfcncde
sdthr
pst
sst

x
x
x
x

x
x
x
x

x
x
x
x

Prov ent-t3 rtrv-t3 fmt=async
linecde
ntfcncde
omode
pbit
sdthr
pmmode
pst
sst

p/fm
is=provision as auto

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

x
x
x
x
x
x
x
x
x

Prov ent-ls rtrv-ls prty x x x

Perf rtrv-th-all speccond-640 x x x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Perf set-th-ec1 rtrv-th-ec1 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-oc3 rtrv-th-oc3 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-oc12 rtrv-th-oc12 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-oc48 rtrv-th-oc48 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-th-sts1 rtrv-th-sts1 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x
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Backup/Restore Commands, Parameters and Release Relation Table for FT-2000 with TL1 (continued)

Area Restore Cmd Backup Cmd Parameter Special Conditions 8.1 9.0 9.1

Perf set-th-t3 rtrv-th-t3 montype
thlev
locn
dirn
tmper
tcarpt

x
x
x
x
x
x

x
x
x
x
x
x

x
x
x
x
x
x

Perf set-pm-stime rtrv-pm-stime start_hour x x x
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Special Conditions

SpecCond-110

1. For DDM OC-3 NEs,  the backup procedure shall ignore the “missing circuit pack - BBF5"message under the following conditions: Shelf #3 is
used, AND

2. 27 type OLIU is NOT installed.

Note: Since BBF5 is detected through a 27 type OLIU, any installed BBF5 will not be detected without the 27 type OLIU even if it is installed.  Under this
condition, the error message should be suppressed to avoid confusion.

SpecCond-120

For DDM OC-3 that may be equipped for the MegaStar configuration, MegaStar is denoted by the following conditions:
1. RTRV-SYS returns product = MegaStar 2000; and
2. BBG8 SYSCTL circut pack has S1-1 OFF, S1-2 OFF, S1-3 OFF; and
3. RTRV-OC3 returns RADIO = yes.

SpecCond-338

Restore commands (ENT-xxx) shall not be issued to unequiped resources for DDM-2000 OC-3, OC-12 and FiberReach.
Restore commands can be issued to unequiped resources in FT because it supports pre-provisioning.

SpecCond-510

When the value to be restored exceded the valid range, the default value shall be used instead. Both the default value and the range are provided in the Parameter
Values Tables.

SpecCond-520

Security restoration shall be conducted only in the MML mode for both FT and DDM network elements. Passwords are always encripted, and cannot be restored.
.
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SpecCond-530

Cross connection restoration shall be checked for the followings:
1. connection type
2. all the end-points of the connection type
3. low speed end-points
4. protection mode
5. if the conflicting cross-connection in existance is part of a path.

Note that when a cross-connection to be restored consists of low-speed end-point(s), and not all the end-points match with existing cross-connections, it is in
conflict with two cross-connections.

SpecCond-540

For DDM network elements, Channel States shall be set only cross-connected and conform to the following cases:
1. VT1.5 channels to DS-1, OC-3 or EC-1 interfaces,
2. STS1 channels to DS3 (D&C, 0x1, ADR) or DS1,
3. STS3C channels from main to OC-3C interface units.

SpecCond-550

OC-1 line states are applicable only to OC-1 lines terminating on 27-type or 26G2-U OLIUs in OC-3 systems.

SpecCond-560

EC-1 port states are only applicable to OC-3 or OC-12 equiped with STS1E circuit packs set to LOW SPEED with hardware switch.  The STS1Es must be cross-
connected to main with no VT cross-connections.

SpecCond-570

If the user specified that the target NE is to be treated as RT, and the backup is from a CO NE, then, default values shall be used for the SET-ATTR-ENV and
SET-ATTR-CONT commands.

If the user specified that the target NE is to be treated as CO, and the backup is from a RT NE, then, the SET-ATTR-ENV and SET-ATTR-CONT commands are
not needed.

SpecCond-580

Optical Transmitter Power applies to 21G OLIU only, and not other types of OLIU.
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SpecCond-590

If the current value of the ENT-T1 Line Coding parameter in the target NE is different from the value in the backup file, the backup value shall be used, and a
warning message shall be displayed.

SpecCond-600

For DDM Nes, the switch settable parameters of STS1E pack shall be compared with that on the backup file. If they don’t agree, the restoration shall not
proceed.

SpecCond-610

The following values of the port state parameter are equivalent:
OOS-MA-AS (in TL1) = AUTO (in MML)
OOS  (in TL1)  =  NMON (in MML)

SpecCond-620

Far end communication must be enabled for TL1 messages.  If the current value and the backup value are different, Cpro shall display a warning message and set
it “enabled.”

SpecCond-630

The DDM convention of representing numbers with scientific notation is that the “1E” part of the notation in the retrieved value field has to be dropped for the
entry value field.  That is, for the retrieve command, the value returned will has the full scientific notation, including “1E.”  However, when entering the value
with the “set” or “ent” commands, the “1E” MUST be dropped.

Currently, CPro is required to observe this convention for the pmthrormance management threshold values.

SpecCond-640

For FT-2000 network elements, the command “RTRV-xx-ALL” can be used to retrieve a variety of parameters.  These parameters can then be restored with the
appropriate modifier that follows.  There will not be a corresponding restore command for “RTRV-xx-ALL.”  That is why the restore command column is blank.
For CPro, the use of the “RTRV-xx-ALL” command is optional. If “RTRV-xx-ALL” is not used, the parameters can be retrieved using the “RTRV-xx-modifier”
commands.
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Appendix F.
Table of NE releases per CPro
releases

Table of NE releases per CPro releases
CPro Release

R4.0 R5.0 R6.0 R6.1 R6.1.2
& R6.2

R7.0 R8.0 R9.0 R10.0 R11.0

FiberReach
1.0 x
2.0 x x
2.1 x x x x
2.2 x x
3.0 x x x x x
3.1 x x x x
4.0 x x

DDM OC-3
6.2 x x x
7.1 x x x
7.2 x x x x x
8.0 x x x x x
8.1 x x x x
9.0 x x x x x
9.1 x x x x

11.0 x x x
11.1 x x
13.0 x x x x x
13.5 x x x x
15.0 x x
15.x x

DDM OC-12
5.0 x x x x
5.1 x x x
5.2 x x
7.0 x x x x x
7.x x
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Table of NE releases per CPro releases (continued)

                    CPro Release

R4.0 R5.0 R6.0 R6.1 R6.1.2
& R6.2

R7.0 R8.0 R9.0 R10.0 R11.0

FT OC-48
6.0 x x x x x
7.0 x x x x x
7.1 x x x x
7.2 x x x
8.1 x x x x x
9.0 x x x
9.1 x x
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Glossary of Terms

AID

Access Identifier (FT-2000). Also applies to Equipment Address (DDM-2000).

American Standard Code for Information Interchange

A standard established by American National Standards Institute (ANSI) that
represents characters, numbers, punctuation marks, or signals and uses seven on-off
bits plus a parity bit to achieve compatibility among data services.

ASCII

See American Standard Code for Information Interchange.

ASCII User Interface

The CPro-2000 ASCII user interface provides access to the CIT port of an NE in the
same way that an ASCII terminal provides access. The user can type commands into
the ASCII user interface (AUI) and receive an immediate response from the NE.

AUI

See ASCII User Interface.

Baud Rate

The number of times per second that the state in a channel is switched (or reversed)
during data transmission. Each state change may represent two or three bits;
therefore, a baud rate of 300 may equal 900 bits per second.

Channel

A transmission path or link.

CIT

See Craft Interface Terminal.
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Craft Interface Terminal

The user interface terminal that is part of an NE and is used by craft personnel to
operate the NE.

DACS III-2000

The Lucent Technologies’ digital access and cross-connect system that provides
clear-channel switching at either the DS3 or the STS-1 rates.

DACS IV-2000

The Lucent Technologies’ digital access carrier and cross-connect system that
provides electronic DS3/STS-1 or DS1/VT1.5 cross-connect capability.

Data Communications Equipment

Data communications equipment (DCE) is the functional equipment that establishes,
maintains, and ends a connection, the signal conversion, and the coding required for
communications with a data circuit.

Data Terminal Equipment

Data terminal equipment (DTE) includes control logic, buffer store, and one or more
input/output devices (for example, terminals, printers, or computers).

Datakit II VCS

Lucent Technologies’ data switch with low delay that provides high-speed data
communication between different networks and various computer equipment.

DCE

See Data Communications Equipment.

DDM-2000

A Lucent Technologies network multiplexer that multiplexes DS1, DS3, or STS-1
inputs into STS-1, OC-3, or OC-12 outputs.

DRI

See Dual-Ring Interworking.

DS1

Digital Signal Level 1 is an ANSI-defined signal or service level at 1.544 Mbps
(equivalent to T1).
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DS3

Digital Signal Level 3 is an ANSI-defined signal or service level at 44.736 Mbps
(equivalent to 28 T1 channels or T3).

DTE

See Data Terminal Equipment.

Dual-Ring Interworking

Dual-ring interworking (DRI) is when two ring networks interconnect at two
common nodes.

EC-1

Electrical Carrier 1 is an STS-1 carried electrically.

FT-2000

Lucent Technologies' SONET OC-48 Lightwave system.

Gateway Network Element

A gateway network element (GNE) is an NE that provides a means of
communication between an OS and remote NEs, over the SONET data
communications channel (DCC).

GNE

See Gateway Network Element.

Graphical User Interface

The CPro-2000 graphical user interface (GUI) consists of a multiple document
interface (MDI), which can accommodate a SubNetwork Map and several NE Views.

GUI

See Graphical User Interface.

MML

Human-machine language defined by Consultative Committee for International
Telegraph and Telephone (CCITT).

NE

See Network Element.
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Network Element

A network element (NE) is a piece of equipment or service that is part of a data
communications network.

Non-Preemptible Protection Access

A feature which allows the protection tributaries to serve as unprotected service
tributaries while the corresponding service tributaries become unprotected.

NPPA

See Non-Preemptible Protection Access

Object Linking and Embedding (OLE)

This Windows feature is used to transfer and share information between Windows-
based applications and accessories. For CPro-2000, the OLE Object Packager tool
registers the application in a database and subsequently creates a CPro-2000 program
group and associated icons.

OC-12

Optical Carrier 12 is a SONET signal capable of carrying 12 STS-1 signals
(or the equivalent).

OC-3

Optical Carrier 3 is a SONET signal capable of carrying three STS-1 signals
(or the equivalent).

OC-48

Optical Carrier 48 is a SONET signal capable of carrying 48 STS-1 signals
(or the equivalent).

OLE

See Object Linking and Embedding.

Operations System

An operations system (OS) is a system providing support for telephone company
operations (for example, network surveillance and provisioning).

OS

See Operations System.
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Packet Assembler/Disassembler

An interface between a device and an X.25 packet-switched network. The packet
assembler/disassembler (PAD) converts the protocol used by the device and the X.25
protocol used by the network, allowing terminals to exchange data with other packet-
mode terminals and hosts.

PAD

See Packet Assembler/Disassembler.

Partition

A partition is a logical grouping of network elements of similar types, all running
compatible releases of software. A ring, hub, and chain are considered to be
partitions.

Performance-Monitoring (PM) Data

Data that measures the quality of service and identifies degrading or marginally
operating systems (before an alarm is generated).

SLC-2000

The Lucent Technologies’ digital loop carrier system with a built-in OC-3 SONET
multiplexer.

SONET

See Synchronous Optical Network.

STS-1

The basic, building-block logical signal in the SONET standard with a rate of 51.840
Mbps.

STS-3

The basic, building-block logical signal with a rate of 155.52 Mbps.

Subnetwork

A group of interconnecting and inter-related NEs. The most common connotation is
a SONET subnetwork, in which the NEs have DCC connectivity.

Synchronous Optical Network

The North American standard for the rates and formats defining optical signals and
their constituents.
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Target Identifier

A target identifier (TID) allows an NE to be addressed.

TCP/IP

A networking protocol used to provide communications between networks.

TID

See Target Identifier.

TL1

See Transaction Language One.

Transaction Language One

A syntax used in OS/NE communications.

VT1.5

A SONET virtual tributary logical signal with a bit rate of 1.728 Mbps, capable of
DS1 payload.

X.25 port

The DTE-to-DCE interface between a synchronous host and a packet-switched data
network.
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